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We are proud to announce the release of Wordfast Pro Version 5.13.0. This version is a minor release that
introduces improvements and addresses critical issues.

e Added new FrameMaker (*.MIF) filter with support for latest version FrameMaker files
¢ Implemented option in Translation menu to set all segments as Needs Translated

¢ Implemented option for auto-propagated segments to set as State Translated

e Added Live Preview option to Zoom on the preview content

¢ Implemented Notes dialog with slightly bigger font for Source and Description text

¢ Added new configurable JSON filter

¢ Implemented location selection for Split and Merged files in Quick Tools

e Added option to Translate text with content control in MS Word Filters

e Added Locked segment filter to TXLF editor table filter

¢ Fixed issue with PowerPoint files freezing while opening and save translation

¢ Fixed issue with performance of opening Live Preview for PowerPoint files

e Fixed issue with autosuggestion in segment cause cursor to shift to different position

¢ Fixed issue with drag and drop text to TM Lookup does not initiate the lookup search

¢ Fixed issue with source formatting not getting applied to target correctly

¢ Fixed issue with segment resizing after switching to Stacked View

e Fixed issue where SDLXLIFF files are not opened in Wordfast when file contains 101% match segments
¢ Fixed issue with Live Preview cannot be opened after closing undocked preview

¢ Fixed shortcut for closing all files to Ctrl+Alt+W

e Fixed issue with Undo action to remove pasted text in segments

¢ Fixed issues with Transcheck report not showing the summary of Transcheck warnings
¢ Fixed issue with Adaptive Transcheck not showing correct color for MT Segments

¢ Fixed issue where chained fails in editor does not update progress bar

¢ Fixed issue with application blinking after opening a segment

¢ macOS: Crashing on close of application

e macOS: Issue with open for some version of Operating system and needs several double clicks to open
¢ macOS: Issue with Catalina complaining keystroke logging during opening of application

e TXLF Editor columns get hidden when windows display settings are set to 125%

e TXLF Editor scrolling issues on touchscreen devices



1. About this Guide

Conventions

CONVENTIONS
Typographical

The following table explains the typographical conventions used in this guide.

Bold Indicates user interface controls, commands, and keywords in body text.

italic Represents an input field where user input is expected.

<...> Indicates generic parameters that must be replaced by specific code or text, usually through user
input.

CONVENTIONS

lcons

The following table explains the icon conventions used in this guide.

Note:
@ This icon designates a note, helpful suggestion, or reference relating to the surrounding text.
Best Practice:
v This icon designates a suggestion for best practice relating to the surrounding text.
Alert:
A This icon designates a warning or alert relating to the surrounding text. In this situation, the user

should exercise caution to avoid an undesirable result.



Wordfast Pro is the latest standalone, multi-platform TM tool designed to address the needs of translators,
language service providers, and multi-national companies. It offers a complete translation environment that stores
your translated content for reuse on future projects, thereby maximizing efficiency, increasing overall consistency
and reducing translation costs.

¢ Cross-platform compatibility — Browser-based tool runs natively on Windows, Mac, and Linux.

e Target-only Live Preview — After translation, provides a preview to proofread a target-only version with
layout and formatting.

e Segment filtering — Filters segments based on terms, regular expressions, match scores, notes, and
other attributes.

¢ Configure multi-lingual translation projects — Supports translation into multiple target languages and
can send as a single package or separate packages based on language pairs.

e Export and import translation packages — Allows configuration and export of translation packages for
fast, seamless translation management.

¢ Format flexibility — Supports virtually any file format, including MS Office, Adobe InDesign, FrameMaker,
PDF, HTML, XML, SDL Trados Xliff, MemoQ Xliff, and more.

¢ Chain files — Allows combination of multiple files into a single file to improve the consistency of repeated
segments and facilitate file management.

¢ Unlimited TM and glossary access — Accesses an unlimited number of TMs and glossaries
simultaneously and prioritizes as primary or secondary.



This section provides basic information to get started with Wordfast Pro, a stand-alone desktop application you
install on and access with your local computer.

Supported Operating Systems Microsoft Windows 7+ 64-bit, Mac OS X 10.11+ 64-bit, and Linux 64-
bit
Java Runtime Environment If not present, Wordfast Pro automatically installs Java Runtime

Environment during the application installation process

License and Registration Activation of the full Wordfast Pro installation requires a license and
registration

Minimum System Memory 4 GB RAM

Minimum Screen Resolution 1366 x 768 pixels

Activation of Wordfast Pro requires a license and online or offline registration.

f An unlicensed version of Wordfast Pro working in Demo mode is limited.

e You can only create bilingual projects.

¢ You can only store up to 500 translation units (TUs) in a Translation Memory (TM). To remove
this restriction, purchase a license and activate the licensed application.

To install Wordfast Pro:

1. Download the Wordfast Pro Windows Installer Package from www.wordfast.com, based on your operating
system.

2. In your Downloads folder, double-click the .MSI, .DMG, or .TGZ file to open the Wordfast Pro Setup Wizard.
3. Complete all steps to align with your configuration, then click Finish.

Wordfast Pro opens in Demo mode. It still requires manual or online activation. Refer to Activation.

You can activate Wordfast Pro either manually or online. Both methods require an activation key. When you
purchase a Wordfast license, you can generate an activation key at www.wordfast.net by logging in with your
login email and password. Copy and save the activation key.

To activate Wordfast Pro:

1. Open Wordfast Pro.


http://www.wordfast.com/
http://www.wordfast.net

2. On the Sidebar, click to open the Wordfast Pro 5 application dialog.

3. Click Online Registration or Manual Registration, then follow the activation instructions.

About W Please enter your activation key and follow the instructions

Online Registration

License Type: Full

Manual Registration
Activation Key:”

Update Wordast Pro License will expire in 324 days

-

Close
Option Description
Online Registration Enter the Activation Key, then click Activate.
Manual Registration 1. Enter the Activation Key, then click Generate.

2. Copy the generated text into an email and send
it to the email address provided on the screen.

3. Save the license file from the return email.

4. Click Browse to the license file.

5. Select the license file, then click Activate.

After you activate the software, you can click either registration option to view the number of days
remaining on your license.

4. Restart Wordfast Pro.

The Wordfast Pro activation process is complete.

W=
To resolve any license issues, click j then click Feedback.

Licensure

You can view license information after you have activated Wordfast Pro.

On the Sidebar, click to view product information, your current license information, Wordfast Pro update
info, and to provide application feedback.



Wordfast Pro automatically monitors for updates. If an update is available, you receive notification
after you open the application.

Wordfast Pro 5 x

About

Online Registration

W About Wordfast Pro 5

Product Mame: Wordfast Pro
Manual Registration
Version: 513.0.RC2
Update Wordfast Pro
Build 1D: 20200124-1654
Feedback
JYM infio: 11.0.5 (amd&d)
WIN 10.0
Copyright (c) Wordfast Pro, 2020. All righis reserved.
Privacy Policy
Close
Option Description
About Use to review product information, including your current version number.

Online Registration

Use to activate your Wordfast Pro license online.

Manual Registration

Use to manually activate your Wordfast Pro license through e-mail.

Update Wordfast Pro

Use to check for updates to the application and to add languages for the
application's Hunspell spelling dictionary.

Feedback

Use to send feedback about software issues. Be as specific as possible, providing
the exact steps you took when the issue occurred.
Please do not submit software usage questions to Feedback.

For software usage questions, click to review the online help. If you still
have questions after reviewing the online help, log in to your user account at
www.wordfast.net and submit a Hotline request.

Start Wordfast Pro

After you install and activate Wordfast Pro, it is ready to use.

To start Wordfast Pro:

1. Double-click the Wordfast Pro icon on the desktop or click Wordfast Pro from the Windows Start menu.
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Wordfast Pro opens to the Project List view.

2. (Optional) Select another view if you have created a project and are ready to begin translation or review.

Explore the User Interface

Wordfast Pro allows users to coordinate and automate the translation and review process through an intuitive,
stand-alone user interface.

Wordfast Pro uses a Sidebar to navigate among views. Click the icons to change from one view to another.

The default view is the Project List view. ﬁ

When you begin working on a project from the project list, the result is the Current Project view. .

Each view is explained in more detail in the subsequent sections.

Item Action
Click to open the General view.
E The General view includes general product information, as well as a form to

provide product Feedback.
In Wordfast Pro, you will also find product registration and software update
information here. See Activation or Licensure for more information.

ﬁ Click to open the Project List view.




Item Action

. Click to open the Current Project view.

n’ Click to open the TXLF Editor view.

% Click to open the Quick Tools view.

_I—I- Click to open the Preferences view.

=

<< Click to collapse the Sidebar. This action hides the icons and increases the
workspace.

Click # to expand the Sidebar.

EXPLORE THE USER INTERFACE

Project List View

The Project List view displays a list of your active projects.
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Item

Action

Sidebar

Click icons to switch among user views. User views include General application
information, Project List, Current Project, TXLF Editor, Quick Tools, and

Preferences.

Action Button Perform a specific task.

Action Bar Access all action buttons associated with a specific user view and tab.

Project List View all files associated with a specific project.

EXPLORE THE USER INTERFACE

Current Project View

The Current Project view displays a list of the TXLF files that are included in a selected project. Double-click a

file from the list of TXLF files to open the TXLF Editor.

Collapsed
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Item Action

Sidebar

Click icons to switch among user views.




Item

Action

Menu Tab

Access the various tools of the application. Each user view contains different
tabs.

Action Button

Perform a specific task.

Action Bar

Access all action buttons associated with a specific tab.

Collapsed Items

Access any remaining tools that do not fit in the window.

File Filter

Create filter criteria to refine the file list.

Language Pair

Access the file list associated with a specific source and target language pair.

File List

Access a specific file within the language pair.

Project Progress Bar

View the percentage of work completed on a project.

File Progress Bar

View the percentage of work completed on a file.

You can view file information, filter criteria, and sort files using the provided search options.

Files Word Count || TXLF File Location Creation Date Last Saved Complete

Item Action

Files Lists the files available in the current project. Type a file name in the box to
locate a file in the project list.

Word Count Displays the total word count of each file in the project.

TXLF File Location

Displays the directory path to the stored file location. Type a path name in the
box to locate a file or to group files in a particular path.

Creation Date

Displays the date and time the file was created based on the user's system
settings.

Last Saved Displays the date and time of the most recently saved the file.

Complete Displays the file progress bar with completion percentage.
Clears filter criteria.

i Sorts filter criteria in ascending or descending order.

Changes the sort order.

EXPLORE THE USER INTERFACE

The TXLF Editor view is your default translation and review workspace.

You can choose from two layouts for your TXLF Editor workspace.

¢ Table view—This layout displays the source segment to the left and the target segment to the right.

o Stacked view—This layout displays the source segment row directly above the target segment in a

spanned row.



You can select either layout view by clicking the drop-down menu for the Switch Editor Layout action on the File

tab.
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Item Action
Sidebar Click the icons to switch among user views.

File Name Tab

View an open or chained file.

Action Button

Perform a task.

Menu Tab

Access a specific function and its Action Buttons.

Filter Bar

Filter how segments are sorted and displayed.

Action Bar

Access all Action Buttons associated with a specific tab.

Table Filter

Create filter criteria for searching in the open file.

Collapsed Iltems

Access any remaining tools that do not fit in the window.

Preview Pane

View the translated content in its original format for MS Word .DOC
and .DOCX files or MS PowerPoint .PPT and .PPTX files.




Item

Action

Editor Pane

Access editor tab content or interact with it using menus and sub-menus.

Source Column

View numbered text segments that will be translated in the Target Column.

Target Column

Use as primary work area for translation entry with or without leveraging a
translation memory (TM).

Terminology Pane

Search the source or target glossaries, or add terms to terminology
glossaries, if enabled.

Segment Score Column

View the TM match score represented as a percentage.

Status Column

View the status of a segment by its status icon.

Segment State Column

View the state of the translated segment. Toggle between Needs
Translation and Translated.

Progress Bar

View the progress of the total translation based on the number of
translated segments. If you have chained files, the percentage includes all
the segments in the chained file.

When the Preview, Editor, or Terminology panes are resized, Wordfast will remember the settings the

next time it is run.

TXLF EDITOR VIEW

Use filter criteria to narrow your search for segment content.

Source or Target Match Case Regex

Option

Filter: Sort: | Decument

Function

Source or Target

Select from drop-down menu to search source or target segments.

Match Case Make your search case-sensitive.
Regex Select from drop-down menu to search on regular expression or wild card
characters.
Filter Select from drop-down menu to constrain search even further.
Activate the filter action.
Clear the cumulative filter action.
Reset the toolbar filter fields.
Sort Select from drop-down menu to order the remaining search list.

Configure the maximum word count for the segment filter.




TXLF EDITOR VIEW

You can quickly identify the status of a segment in the TXLF Editor view by its status icon.

Status Icon Segment Status

1] A non-linguistic error occurred in the segment during a Transcheck test.

] The segment is locked, so you cannot edit it.

% The segment is do not write to TM, so you cannot commit it to the translation memory.
5| The segment repeats more than once in the current file.

® There is segment information available.

0O The segment has a note associated with it.

]

/! The content of the source segment was edited.

TXLF EDITOR VIEW

The Segment State allows you to view, set, or change the state of a translation segment in the TXLF Editor view.
Untranslated Target segments are automatically set to Needs Translation. Once a translation is committed to the
translation memory, the application considers the translation to be complete and changes the state to Translated.
Changes to the Segment State will also change the total translation completed percentage on the Progress Bar.

Segment  Segment State Description
State Icon

Needs Translation — This state means that the segment is not finished and is therefore not
included in the calculated progress shown on the Progress Bar.

¢ All untranslated target segments are set to Needs Translation, or select Mark All Needs
.\\///' Translation to change all segments to Need Translation. After translating the segment,
click this icon to change the state to Translated.

e |f you commit a segment to the translation memory, or select Mark All Translated, this
state will automatically change to Translated.

e Translated — This state means that the segment is finished, and therefore included in the
Progress Bar. Click this icon, or make a change in the translated segment, to change the
state back to Needs Translation.
vf e Segments that are leveraged with Exact and Context matches are set to Translated by
default and are included in the Progress Bar percentage.*
¢ As you translate, when you commit segments to the TM by clicking Next Segment or its
shortcut key (ALT + DOWN), the segment state will change to Translated.**




* You can change this default setting on a project-by-project basis in Preferences. Click Translation
Memory in the Current Project Preferences section. Clear or check the preferred check boxes in
the Segment state section.

Set segments to Translated with leveraged Context Matches

Set segments to Translated with leveraged 1003 Matches

Set segments to Translated for Auto-propagated segments

** You can change the Next Segment action so that the segment state does not change to
Translated. In Preferences, click Segment in the General Preferences section. Clear the check box
for Commit changes the segment state to Translated in the Segment actions section.

Mext/Previous Segment action leverages next/previous segment

Commit changes the segment state to Translated

TXLF EDITOR VIEW

The TXLF Editor view displays translation information and status in the Progress Bar at the bottom of the

window.
Segmenis: 24733 | Segment (Src/Tgt/Max): 11/28/- = Paragraph (Src/Tgt/Max): 29/28/- 69% Translated (57 words | sft}
Item Description

Source and Target

View the source and the target languages in the open translation file.

Languages

Segments View the number of segments completed versus the total number of segments in
the open translation file.

Segment (Src/Tgt/Max) View the character breakdown in a segment. This breakdown includes the

number of characters in the source and the target segments, and the maximum
number of characters allowed in the target. Hover over this portion of the toolbar
to view the progress in a larger display window.

Note: The Max segment value turns red when it exceeds the maximum allowed.

Paragraph (Src/Tgt/Max)

View the character breakdown in a paragraph. This breakdown includes the
number of characters in the source and target paragraphs, and the maximum
number of characters allowed in the target paragraph. Hover over this portion of
the toolbar to view the progress in a larger display window.

Note: The Max segment value turns red when it exceeds the maximum allowed.




Item Description

Percent Translated View the total progress of the translation in a file or in a group of chained files. If
you have chained files, the percentage complete will be the total for all the files as
if they were one.

EXPLORE THE USER INTERFACE
Quick Tools View

Use the Quick Tools view to work with files outside of your projects. Typically, Project Managers use Quick
Tools actions to perform regular functions on files before sending them to linguists, such as analysis or cleanup.

Source Files

Sidebar Pane T Pane Action Button Action Bar
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| Gema. Engl Ger local C:\Us..
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~*| Ignore translated exact segments from repart

Set segments fo “Translated” with leveragad 100% Maiches
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Item Action

Sidebar Click icons to switch between user views.

Source Files Pane Select from the available source files list.

TM Pane Select and create TXLF files of the translation memory or configure reports.
Action Button Perform a specific task.

Action Bar Access all action buttons associated with a specific tab.




EXPLORE THE USER INTERFACE

Help and Feedback

HELP AND FEEDBACK

Help

Click to access the online help for answers about how to use the software. If you still have questions after
reviewing the online help, log in to your user account at wordfast.net and submit a Hotline request.

HELP AND FEEDBACK

Feedback

w-
To send feedback about a software issue, click , then click Feedback. Be as specific as possible, providing

the exact steps you took when the issue occurred. Please do not submit questions related to software usage to
Feedback. Instead, log in to your user account at wordfast.net and submit a Hotline request.
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4. Manage Projects

When Wordfast Pro opens, the default view is the Project List view. This view displays all your active translation
projects, and is where you manage the translation process for each project. On the Projects tab you can perform
many project operations, including creating projects, opening and closing projects, adding and removing projects,
and importing translation packages. After you create a project, you can keep a project on the projects list for

as long as it takes to complete it. A project stays in the projects list until you remove it. You can filter the list

of projects to display them by a variety of criteria including name, location, source or target language, and
completion percentage.

@ You can add a project to the projects list again, even after you remove it. Wordfast does not erase
removed projects, so you can retrieve them from the project folder on your computer using the Add
Project action.

@ To bypass the typical project creation process, create a Quick Project with the Open TXLF action.
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Files Folders Filz Files Fil= Project Oroject Broject Expart Report Bepart
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- EN-> DE
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Open a TXLF File

A TXLF file contains text segments in a source language and a target language. In Wordfast Pro, to translate
the content in a TXLF file, you must create a project. A project may contain one TXLF file or multiple TXLF files.
This section describes how to create a Quick Project by opening existing TXLF files. To set up a new project and
prepare new TXLF files for translation, refer to Create a Project.

To open a TXLF file:

1. Choose one of the following actions:

e Click ﬁ on the Sidebar to open the Project List view. Click Open TXLF, then browse to select a file.



2.

Projects e ~
RE B RERRBERER B B B X

Open Create Open Close Add MMadify Remave Recalculate Import Import SOL Export
TXLF Project Project Project Project Project Project Progress Package Package Package

e Drag-and-drop one or more TXLF files to the project list.

If you used drag-and-drop, determine if you want to remember your choice on the Quick Open TXLF dialog,
then choose one of three possible actions.

How would you like to open your TXLF files?
Mote: Quick Projects will not remain in the project list once closed.

Remember this choice

Open in New Project Open in Quick Project Cancel

a) (Optional) Select Remember this choice to use your selected option each time you choose the Quick
Open TXLF action without displaying the dialog again. Use General Preferences > General to show this
dialog again, after you choose to Remember this choice.

b) Click Open in New Project to use the standard Project Creation dialog.
c) Click Open in Quick Project to open the TXLF file in TXLF Editor as a temporary Quick Project.

d) Click Cancel to disregard the TXLF file open action and close the dialog.

If you chose to open the Quick Project, make your edits in the TXLF Editor, then save your changes and click
Close.

Click Save Project to retain the project in the project list.

In the Save Project dialog, modify the project details.

W Use this dialog to change the project name and set the location where the

project will be saved.

Project Name:" Quick Project

Save Project To:* Cllsers'Documents'WFP\Resources Browse...

Save Cancel

Required fields are marked with a red asterisk.

a) Enter the Project Name.

b) Browse and select the file location in the Save Project To field.



c) Click Save.

Create a Project

In Wordfast Pro, every translation begins with a project. Projects act as repositories for all related content, along
with associated translation memories (TMs) and glossaries.

A You must create a project before you begin translation, unless you use the Open TXLF action.

A project also requires file format filters to convert the source content into segments prior to beginning
the translation process.

To create a project:

1. Click ﬁ on the Sidebar to open the Project List view.
2. Click Create Project.
priocs
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Open Create Open Close Add Modify Remave: Recalculate Impaort Import SOL Export
TXLF Project Project Project Project Project Project Progress Packags Package Package

3. On the Project Creation dialog, enter a project name.

Required fields are marked with a red asterisk.

Project Creation x

Project Mame:® Wordfast1 Source Files Reference Files

Reuse Project: None - | & Add File E'} Add Folder S Create Filter

Save Project To:" C\Users\Documents'WFP Browse... Name Type Path
Source Language:” English v

Target Languags(s):" Geman (Gemany) X

Translation Memory Glossary Blacklist
[} [} o

. Create s Add  ~ were Import
=3 L0) =t "

Name Priority Read O... Type Path

Options

~" Run analysis report on documents

Pre-translate TXLF files

Create Project Cancel

4. (Optional) If you want to reuse the profile of a previously created local project, select it from the Reuse Project
drop-down list.



10.

Project reuse removes all existing translation memories, glossaries, and blacklists from the new
project. On the Reuse Project Warning dialog, click Yes to agree to reuse the project.

Enter the Save Project To location or click Browse... to select the location for your project.

. Select Source Language and Target Language(s) from the drop-down lists.

| You can refine the source language and target language drop-down list results by starting to type a
language name.

. On the Editor pane, click the Translation Memory tab, if it is not already active.

Glossary Blacklist
[ =] =] (=]
Create w  Add wr.. Import
: :{:" h L] P

Name Priority Read ... | Type Path

(Optional) Click Create to add a new local TM for your project.
a) On the Create TM dialog, enter a unique name for the TM.
b) Select a target language to create a language pair, then select the location for the TM on your local disk.

c) Select either primary or secondary priority from the drop-down list to determine the TM you leverage first.

You can select only one TM as the primary. The primary status dictates that the content of that TM
overrides any content in secondary TMs.

d) (Optional) To prevent any edits to the TM, select Read-only.
e) Click OK.

(Optional) To add an existing TM to your project, click Add, then select a local, remote, or a project-specific
TM from the drop-down menu.

\/ To use a free online tool for work and production that integrates with Wordfast Pro, use Wordfast
Anywhere (WFA) as your remote, unlimited, and private TM.

a) Add Local — Select a location on your local disk.

b) Add Remote — Enter the TM Server, WF Server, or WFA Server details on the Connect to Remote TM
dialog. Refer to Connect to a Remote TM.

¢) Add Project TMs — Enter the details on the Add Project TMs dialog by selecting the project.

The source language, target languages, and list of TMs auto-populate, based on the project you
select. Remove the target languages or TMs that you do not want to import from the target languages
and list of TM fields.

(Optional) To import an existing TM to your project, click Import.

a) On the Import Translation Memory dialog, select the import File Type: TMX or WF TXT TM format from
the File Type drop-down list.



b) Click Browse to locate and select the project file that contains the TM that you want to import.

c) Select either the Create a new TM or Import into existing TM option. Refer to Import a Local TM.

d) If the TU already exists, select an overwrite option from the drop-down list.
e) Select Delete all TUs from existing TM if you want the import to overwrite and create a clean TM.
f) Click OK.
11. (Optional) To edit an existing TM in your project, click Modify.
a) On the Modify Local Translation Memory dialog, modify the name of the TM or its priority.

b) Select whether you want to protect the TM as read-only.

12. (Optional) On the Editor pane, click the Glossary tab.

Translation Memory Blacklist
| ] l Create D-I Add EI-I Import
o P
Name Read Only | Type Path

13. (Optional) Click Create to add a new local glossary for your project.
a) On the Create Glossary dialog, enter a unique name for the glossary.
b) Select a target language from the drop-down list, then select the location for the glossary on your local disk.
¢) If you want to prevent any edits to the glossary, select Read-only.
d) Click OK.

14. (Optional) To add an existing glossary to your project, click Add, then select a local, remote, or a project-
specific glossary from the drop-down list.
a) Add Local — Select a location on your local disk.

b) Add Remote — Enter the TMGR Server, WF Server, or WFA Server details on the Connect to Remote
Glossary dialog. Refer to Connect to a Remote Glossary.

c) Add Project Glossary — Enter the details on the Add Project Glossary dialog by selecting the project.

15. (Optional) To import an existing glossary to your project, click Import.
a) On the Import Glossary dialog, select the import File Type from the drop-down list: TBX or Tab delimited.
b) Click Browse to locate and select the project file that contains the glossaries that you want to import.

¢) To configure a glossary creation option, select either Create a new glossary or Import into existing
glossary. Refer to Import a Local Glossary.

d) Select an overwrite option for preexisting terms.

e) Select Delete all terms from existing glossary if you want to ensure the import overwrites a clean
glossary.

f) Click OK.

16. (Optional) On the Editor pane, click the Blacklist tab.



17.

18.

19.

20.

Translation Memory Glossary
[‘55"‘ Create [ﬁ% Add [ﬁ"‘ Import

Name Read Only | Type Path

(Optional) Click Create to create a new local blacklist for your project.

a) On the Create Blacklist dialog, enter a unique name for the blacklist.

b) Select a target language for the blacklist, then select the location for the blacklist on your local disk.

c) If you want to prevent any edits to the blacklist, select Read-only.

d) Click OK.

(Optional) To add an existing blacklist to your project, click Add, then select a local or remote blacklist from the
drop-down list.

a) Add Local — Select a location on your local disk.

b) Add Remote — Enter the details on the Connect to Remote Blacklist dialog. Refer to Connect to a
Remote Blacklist.

(Optional) To import an existing blacklist to your project, click Import.
a) On the Import Blacklist dialog, select the import File Type: TXT.
b) Click Browse to locate and select the project file that contains the blacklist that you want to import.

c) Select the blacklist creation option: Create a new blacklist or Import into existing blacklist. Refer to
Import a Local Blacklist

d) Select an overwrite option for preexisting terms.

e) Select Delete all terms from existing Blacklist if you want to ensure the import overwrites a clean
blacklist.

f) Click OK.

On the Source Files tab, choose a method to add project source files.

Reference Files

Eﬂ?ﬁ Add File E; Add Folder ? Create Filter

Name Type Path

You can drag-and-drop files from a folder to the Files panel.

To copy source files into the Source File folder within the Project folder on your computer, select
Copy Source or TXLF Files into Project Folder Structure in your General Preferences.

a) (Optional) Add File — Click to browse to the source file.
b) (Optional) Add Folder — Click to browse to the folder location for source files.

c) (Optional) Create Filter — Click to create a conversion filter the source files. You can create multiple filters.



21. (Optional) On the Reference Files tab, choose a method to add supporting documentation.

Source Files Reference Files

I i Remove Files
!ﬂ Add File EAddFolder smove Files

Name Type Path

a) (Optional) Add File — Click to browse to the source file.

b) (Optional) Add Folder — Click to browse to the folder location for source files.
22. (Optional) Select any additional Options.
Run analysis report on  Analyzes source files against TMs and generates a report. You can also view this
documents report on the Reports tab, after opening the project.
Pre-translate TXLF files Populates TM leveraged segments when TXLF files are open.

Use primary MT onno  Leverages primary machine translation (MT) when there are no matches with the
match segments local and remote TMs. This option is only available if you selected Pre-translate
TXLF files.

23. Click Create Project to analyze the files and display the project creation summary.
Wordfast1 x
Here you can see the number of the files added, TMs,
& pjacklists and glossaries along with any errors that might
have occurred.

Ea Bilingual (TXLF) Files

Created: 1
Failed: 0

? Translation Memories
Added: 1

D-l Glossaries
Added: 2

!é Reference Files
Added: 0

ﬁ% Blacklists
Added: 2

W] Open created project

24. (Optional) On the Wordfast dialog, select Open created project.
25. Click OK.

The project is created.



Open a Project

Once you create a project, the next step is to open it. You cannot open files for translation without first opening
the associated project.

To open a project:
1. Inthe Project List view, select a project name from the list.

2. Click Open Project or double-click the project name to open it.

RE B £ BB R B B R &

Open Create Open Close Add Modify Remave: Recalculate Impart Import SOL Export
TXLF Project Project Project Project Project Project Progress Package Package Package

The project opens in the Current Project view. A list of the project's language pairs and the associated
translation files displays on the Project Files tab.

Project Files Project TM Project Terminology Reporia Reference Files ? A X

Merg B0 B BE&ERE &5 & B B

i

Tr Close Save Modity  Bilingua Analyze  Transcheck  Segment Changes
Files Foldars File Files Filz Project Project Project Export Report Beport
ﬁ | Files | Word... | TXLF File Location | Creation Date Complete '@ 1=
7 EN -> DE
L sample-File_ 188 C:\Users\ Public\WFP Proje 2019/11/13 10: 2019/11/13 10: szt
i Sample-File_an. . 10 C:\Users\Public\\WFP\Praje . 0191113 10:. 2ngayi3 a0 (S
‘ AdaptiveTrans... 193 C:\Users\Public\WFP\Proje. .. 20191113 10:... 2019/11/13 102.. | 0% |
n’ B samplez_Sa.. 193 Ci\Users\PublicWFP\Proje...  2019/11/13 10:.. 20091113 10:.. [ 18%
B sampleFile_en... 7 Ci\Users\Public\WFP\Proje..  2019/11/13 10:... S 57%
[ samples_sa_. 197 C:\Users\Public\WFP\Preje.. 019/11/13 10:... 19%
R

I-I..I
Tir

A

EM — DE _ 24% Transiatzd

Modify a Project

You can change the project name and target language using the Modify Project action.
To modify a project:

1. In the Project List view, select a project, then click Modify Project.

RE ERBE B B B 8 &

Open Create Open Close Add Modify Remave: Recalculate Impart Import SOL Export
TXLF Project Project Project Project Project Project Progress Package Package Package




2. (Optional) On the Modify Project dialog, enter a different name in the Project Name field.

Modify Project x
- Use this dialog to change the project name and either add or remove
target languages.
Project Hame:* Project1
Target Language(s):* German X
m|
oK Cancel

3. (Optional) In the Target Language(s) field, add a language by selecting one from the drop-down list. Deselect
a language to remove it.

4. Click OK.

The modifications are active and the project list displays the changes.

Remove a Project

To remove a project:

You can add a project to the Project List again, even after you removed it. Wordfast Pro does not
erase removed projects, so you can still retrieve them from the project folder on your computer using
the Add Project action.

1. Click m on the Sidebar to open the Project List view.

2. Select the project from the list, then click Remove Project.

- o
RE R R B R R F B & &

Open Create Open Close Add MModify Remoave Recalculate Import Import SOL Export
TXLF Project Project Project Project Project Project Progress Packags Package Package

3. On the Remove dialog, click one of the action buttons.



*| Remove from the list only

Remove from the list and move the following resources to Archive folder

Resources #
TXLF Files 2
Reference Files 1
OK Cancel
Remove from the list only Remove the project from the Projects List but retain

project resources in the project folder on your computer.

Remove from the list and move the following Move the project TXLF, reference, and source files to
resources to Archive folder the Archive sub-folder within the project folder on your

computer.

4. Click OK.

The project is no longer in the Projects List.

Package Files

A package file contains all of the required information to work on a translation project. You can use a package file
to share content and files among different Wordfast Pro (WFP) users. The package file can contain complete or
incomplete projects.

A package file generally includes:

Source files

All target translatable files

Instructions

Background information

Reference files

Comments

Connection to at least one Translation Memory (TM)
Connection to at least one glossary and blacklist

To access a package file from another user, import the file into WFP. Wordfast connects the imported files to
translation memories and glossaries. It provides you access to all translatable files and additional resources,
including TMs and glossaries, without any additional setup or configuration.

To share a completed project with other users, export it as a package file.



PACKAGE FILES

Import Package Files

Package files allow different Wordfast Pro users to share files. When you import a package file, you automatically
connect the files to translation memories and glossaries. You also gain access to all translatable files and
additional resources. This eliminates the need for manually creating a project.

To import package files:

1. Click ﬁ on the Sidebar to open the Project List view.

2. Click Import Package.

Projects
Open Create Open Close Add Modify Remave: Recalculate Impaort Import SOL Export

THLF Project Project Project Project Project Project Progress Package Package Package

3. On the Import Package dialog, click Browse to locate and select the package file.

Required fields are marked with a red asterisk.

Nz Alternatively, you can drop a package file into the white space on the Import Package dialog to begin
the import process.

Import Package 4
as |mport Package
Select options to impert a GLP file to the project list

Select a GLP file:™ |C:'\.Users'lﬂocumerﬂs‘l.Soume'LWFP Export Browse...
Sowrce Language: en
Target Languageys): de-DE

#) Update an exisfing project

Select project to update:™ Projecti -

*) Only update the project's existing TXLF files
Update the project's existing TXLF files and add new files

Create a new project

Browse..

] Open project after importing

Import Cancel




4. Choose one of the following:
e Update a project by clicking Update an existing project and its options.

e Create a new project by clicking Create a new project and its options.

5. (Optional) Select Open project after importing to open the project in the Current Project view when the
import completes.

6. Click Import.

The package file is imported.
PACKAGE FILES
Export Package Files

Use Export Package to share a complete project package with other Wordfast Pro users.

To export package files:

1. Click ﬁ on the Sidebar to open the Project List view.

2. Select a project from the list of projects , then click Export Package.

= o
2 E R R BER B F B & &

Open Create Open Close Add MModify Remoave Recalculate Import Import SOL Export
THLF Project Project Project Project Project Project Progress Package Package Packags

3. On the Export Package dialog, select either Entire Project or Specific target languages and resources.



Export Package x

e Export Package
Select options to prepare a project export for distribution or archiving

Project Info
Project Name: Project 1
Project Location: C\Users'\WordfastPro\projecis\Project 1
Source Language: English

Export

#) Enfire Project

Specific target languages and resources

Resources to Include in Export

Package Mame

Select Maming Conventicn: | Project Name -

Preview: Project 1.glp

Select Location to Save

C\Users\Documentz\Source\WFP Export Browse...
Export Cancel
Entire Project Click to export all target languages and their associated resources.
Specific target 1. Click to export specific target languages and associated resources.
languages and 2. Click items from the drop-down list for further options to deselect specific
resources Target Language and resources for exclusion from the export.

Choose an existing name from the Select Naming Convention drop-down list or enter a name of your choice
in the Custom Name field.

@ The Preview field provides the name of the file as it will export below the Package Name fields.

Select a save location for the project package, then click Export.

The exported project package is built and saved to the folder location.



PACKAGE FILES

Import SDL Package Files

You can import an SDL package file for conversion of SDL source files to a compatible Wordfast Pro format.
Imports include scores for source content, but do not include translation memories, glossaries, and reference files.

To import SDL package files:

1. Click ﬁ on the Sidebar to open the Project List view.

2. Click Import SDL Package or drop the SDL Package file into the application window.
Pt
DR R R RBERE B BB B £ B

Open Create Open Close Add Modify Remave: Recalculate Impaort Import SDL Export
THLF Project Project Project Project Project Project Progress Packags Package Package

3. On the Import Package dialog, click Browse to locate and select the SDL Package file.

é If the SDL Package file contains unsupported target languages, a warning message notifies you.
Click OK.

Import Package x
e 'Mport SDL Package
Select options to import a package file to the project list
Select a package* CUsers\Desktop\Project 5. sdippx Browse...
Source Language: en-Us
Target Language(s): it-1T,de-DE

Create a new project

Project Mame:* Project 5

Location:* CUsers\Wordfastd\projects Browse...

Open project after importing

Import Cancel

4. Enter the new Project Name.
5. Browse to and select the save location for the new project.

6. (Optional) Select Open project after importing to automatically open the project in the Current Project view
after import. If this option is not selected, the project displays in the Project List view.

7. Click Import.



The SDL Package file import completes.



5. Manage Project Files

When you open a project, the view changes to the Current Project view. A list of language pairs and the
translation files within each language pair displays on the Project Files tab.

Project Files Project TM Project Terminology Reports Reference Files 7 A X
Wew 2L B BoB O 8 B B
Add Add Tranzkate Chair Open Sour Close Save Bodity Bilingua Analyze Transchack Segment Changes —
Filez Folders Filz Files Fil= Project Broject Broject Expart Report Bepart
ﬁ | Files || Word...| TXLF Fie Location | Creation Date — Complete 9 1l =
= EN -> DE
[y sample-File_ 183 C:\Users\PubliclWFP\Proje 2019/11/13 10: 2019/11/13 10: | -
ﬁ Sample-Filz_an.. 19 C:\Users\Public\WFP\Proja.. 019/11/13 10:..  2019/11/13 10... [
B AdaptiveTrans.. 193 C:\Users\Public\WFP\Proje...  2019/11/13 10:.. 20191113 10:... | 0%
ﬁ 5 sample2_sa.. 193 C:\Users\Public\WFP\Proje...  2019/11/13 10:..  2019/11/13 10:.. [ 18%
: B sampleFile_en... 7 Ci\Users\Public\WFP\Proje..  2019/11/13 10:... . 57%
" [l sampled_sa. . 197 C:\Users\PubliclWFF\Proje. 2019/11/13 10: .. 19%
R

1L
L

A

K

EN — DE _ 24% Translated

Add Files

You can add files to an existing project using the Add Files option on the Project Files tab.

@ ¢ If one or more of the source files have a different language code, you will receive a prompt to
modify the project and add the new target language.

To add files to a project:

1. Click ﬁ on the Sidebar to open the Project List view.

2. Select a project from the project list, then click Open Project.

3. Click . on the Sidebar to open the Current Project view.
4. Click Add Files on the Project Files tab.

Project Files Project TM Project Terminology Reports Reference Files

Bk B L B ERBE B & B

Translate Chain Open Source Close Save Modify Bilingual Analyze Transcheck
Files Folders File Files File Project Project Project Export Report

5. Browse to and select one or more source files on the Open dialog.

6. Click Open.



7. On the Files Report dialog, click OK.

Add a Folder

You can add a folder containing multiple files to an existing project using the Add Folders option on the Project
Files tab.

To add a folder to a project:

1. Inthe Current Project view, click Add Folders on the Project Files tab.

Project Files Project TM Project Terminology Reports Reference Files

B E B B E E B B & E

Add Translate Chain Open Source Close Save Modify Bilingual Analyze Transcheck
Files Folders File: Files File Project Project Project Export Report

@

To activate the Current Project view, you must first open a project. Click ﬁ on the Sidebar and

select a project from the Project List view, then click . .

2. Browse to the folder, select it, then click Select Folder. During the import process, you might be asked to
define conversion filters for unknown file types.

3. View the statistics about the added files on the Files Report dialog, then click OK.

Open a Source File

You can view a source file in its original format.
To open a source file:

1. Inthe Current Project view, select a file from the list, then click Open Source File.

Project Files Project TM Project Terminology Reports Reference Files

B w B b B E E B B

Add Translate Chain Open Source Close Save Modify Bilingual
Files Folders File Files File Project Project Project Export

2. View the source file when its default application opens.

@ If the default application is not set, choose an application when prompted to do so.

Close a Project

When you are finished working on a project, close it before you open another.

A You can only have one project open at a time.



e In the Current Project view, click Close Project.

orces - [
n B B E B B

Open Create Open Close Add Modify
TXLF Project Project Project Project Project

Conduct a Bilingual Export

Use Bilingual Export to export the TXLF file with highlighted glossary terms into a .DOC or .DOCX format. This
allows you to edit and spell check the file using Microsoft Word, rather than the internal spell check. You can also
complete a bilingual export or import outside the Project List view using Quick Tools.

é Bilingual exports require you to set Bilingual Export Options in Preferences > General
Preferences.

To conduct a bilingual export:

1. In the Current Project view, select a file, and click Bilingual Export on the Project Files tab.

Project Files Project TM Project Terminology Reports Reference Files

B R B [ B E E B B & B

Add Translate Chain Open Source Close Save Modify Bilingual Analyze Transcheck
Files Folders File Files File Project Project Project Export Report

@ You cannot select files that are already open for bilingual export in TXLF Editor view.

2. Select the destination folder for the exported documents, then click Select Folder.

The session log is displayed. This log and the exported bilingual Word documents are saved in the selected
folder.

Log session start time Wed Aug 21 18:28:18 MDT 2019

Mumber of TXLF files exported successfully: 1
Mumber of TXLF files exported with warnings 0

Mumber of TXLF file exports failed: a

INFCr ToReviewhultiTxf v1.10.1

INFCr Bilingual Review Export

INFC Processing Collsers' WordfastProtprojeds\Wordfast! dett AIPD en-de doodd telf
INFC 32 tus written.

3. (Optional) Open the bilingual export report and review the results.



<FID>a8Sbldef-4098-47 < /FID> Sample 3.docx.txml.txlf

ID | Source (en) Target (de) Score
1 | TRANSLATION MANAGEMENT. UBERSETZUNGSMANAGEMENT. EE]
2 | SIMPLIFIED. VEREINFACHT. 100
3 | STREAMLINE IPROJE CTI MANAGEMENT | EFFEKTIVES PROJEKTMANAGEMENT 100
4 | INTEGFRATE WITH ANY SYSTEM INTEGRATION MIT JEDEM SYSTEM 100
5 | WORK WITH ANY [VENDOR ZUSAMMENARBEIT MIT JEDEM ANBIETER 100
6 | ACCELLERATE TIME TO MARKEET KURYERE BEARBEITUNGSZEITEN 87
7 | CUSTOMIZE WOBEFLOWS INDIVIDUELLE WOREFLOWS 100
8 | ACCESS REAL-TIME EPTDATA ZUGRIFF AUF LEISTUNGSEENNZAHLEN INECHTZEIT | 100
9 | GlobalLink [Proiect Diractod saves Mt GlobalLink Project Director sparen Organisaticnen 100

organizations millions of dollars by automatmg
the management of localization processes and
TES0UrCes.

- aufgrund der-automatischen Verwaltumg vorr ----------------
Lokalisierungsprozessen und -ressourcen Millionen.

10 sEAMIESS [D ATABASE INTEGRATI qu NAHTLOSE DATENBANKINTEGRATION 100

11| Use Uba_-L]'EH Connect with anv CMS, PINL GlobalLimk Connect funktioniert mit jeder CMS-, PIM-, 100
CCMS, or e commierce platforn 7777 - CENS-oder E-Commerce-Plattforny -----------------------1-----

12| WORK WITH ANY FILE FORMAT FURJEDES DATEIFORMAT 100

13| NMext-generation parsing engines extract Parsing-Engines der nichsten Generation extrahieren Inhalte 100
content and prepare it for translation und bereiten sie fiir die Ubersetzung vor

14 [VENDOR-NEUTRAL] PLATFORM ANBIETERNEUTRALE PLATTFORM 100

15| Allow access to anv t'endoj o intarnal Maximale Ressourcenflexibilitat durch Zugriff auf alle 100
translator for maximum resource flexibifity | #mbieter and fernen Ubersetzer =~~~ ==~~""""""""""" - 17

16| CONFIGURABLE WORKFLOW KONFIGURIERBARER WORKFLOW 100

17| Streamlme vour translation process through Optimiernung des Ubersetzungsprozesses durch 100
automation of manual tasks Automatisierung manueller Aufgaben

18| TRANSLATION MEMORY INTEGRATION | INTEGRATION VON TRANSLATION MEMORY 100

Analyze Project Files

Project analysis compares source files to a connected translation memory (TM) to leverage reusable content. Use

the Analyze action to assess files prior to translation or to pretranslate files.

To analyze project files:

1. Inthe Current Project view, click Analyze on the Project Files tab.

Project Files

Project Terminology

Reference Files

B B B2 [ [ R =5
Add Add Translate Chain Open Source Modify Bilingual
Files Folders File Files File Project Export

2. Onthe Project Analyze dialog, select the language pairs and files for analysis.

Comment [OFRT:Glo1]:

From: Glossary
projekie

Comment [OFRT:Glo2]:
From: Glossary
anbister

. -{ Comment [OFRT:Glo3]:

From: Glossary
Project Director

. { Comment [OFRT:Glo4]:
From: Glossal
DATENBANK] GRATION
- { Comment [OFRT:Glo5]:

From: Glossary
GlobalLink

. - | Comment [OFRT :Glo6]:

From: Glossary
Anbistemneutrale

“{ Comment [OFRT:Glo7]:
From: Glossary
anbister

= —
i E"-:::-":!'
Analyze Transcheck
Report

é Verify that the TXLF file you want to analyze is not open in TXLF Editor. You cannot analyze an open

file.




Project Analyze
Project Files (1)

/| Project Languages/Files Word Count

v, BN

| Pretranslate | 100 %

Analysis Options

% matches and | Copy all fags on segments when t ~

EM -> DE DE Use primary MT on no match segments
M AdaptiveTranscheck.doox. bdf 532 Calculats analysis report percentage by:" Words -
| Calculate internal fuzzy matches |75 % | % matches

W Include internal fuzzy matches with TM matches

Lock segments with 100% matches from being edited

Do not allow segments to be merged

Do not allow sources to be edited

Ignore translated segments in from report

Ignore translated exact segments from report

Report Settings

*) Show only analysis report summary

Export Report

Translation Memory (2 )

/| TM Name Location

M = EN-> DE DE

vl German_DE C:\Users\Documents\So...

R i B adantivsTranschack-G C:\llsars\Nnrumantsl Sn T

3. Select options below the Analysis Options heading.

Option Action

Analyze Cancel

Pretranslate

Select to create translated TXLF files, based on Pretranslate options.

Note: Selecting Pretranslate is an optional step. The percentage defines the
minimum leverage required to pre-translate a specific segment.

¢ % matches—Select the percentage of matches to pre-translate from the

list.

e Select one of the following actions from the drop-down list:

o Copy all tags on segments when there is no TM match

o Copy segment source to target when there is no TM match

o Do nothing

e Select Use primary MT on no match segments to leverage machine
translation (MT) matches for all segments that do not have a TM match. If
you have TM matches, but do not select the TM before you click Analyze,
the MT overwrites all target segments.

Calculate analysis
report percentage by

Select an option from the drop-down menu to set the calculation percentage by
either words or segments.

Calculate internal fuzzy
matches

Select to set the calculation percentage for internal partial matches, then
optionally select Include internal fuzzy matches with TM matches.

Lock segments with
100% matches from
being edited

those edits.

Select to prevent the edit of 100% matches and the overwrite of the TM with
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Option Action

Do not allow segments  Select to prevent the merging of translation units (TUs) during analysis.
to be merged

Do not allow sources to Select to prevent an overwrite of the source segment with new edits.
be edited

Ignore translated Do not consider target segments identified in the Analysis report.
segments from report

Ignore translated exact Do not consider exact match target segments identified in the Analysis report.
segments from report

Select the format for the output report below the Report Settings heading.
a) (Optional) Click Show only analysis report summary.

b) (Optional) Click Export Report, then complete the required fields and select a location.
Select a TM below the Translation Memory heading.

Click Analyze.

On the Report File dialog, view the project files analysis.

Click OK.

Run a Transcheck Report

Use a Transcheck Report to verify target segments and identify a variety of common errors within segments in the
translated files. You can run a Transcheck Report on one or more languages or files in a project.

If you have specific terms you want Transcheck to ignore, you can mark those segments for exclusion

in the Transcheck Report using the Transcheck All action. This reduces false positives during
Transcheck error detection. Refer to Use Transcheck All.

To run a Transcheck Report:

1.

2.

In the Current Project view, click Transcheck Report on the Project Files tab.

Project Files Project TM Project Terminology Reports Reference Files

B B B .
Add Add rans

1 =] Save Modify Bilingua Analyze Transcheck
Files Folders File es File roject Project Project Export Report

On the Project Transcheck dialog, select one or more languages or files.



Project Transcheck X

Project Files (1) Transcheck Tests
) ) Configure desired check in Preferences = Transcheck
| Project Languages/Files Word Count
1 .%5 EN - DEDE Report Settings
M ‘.. I Transcheck.doocbdf 532 Report Name-"

Report Location:” ChUsers\Documents\Source Browse...

Glossary (1) Blacklist (1)

" | Glossary Location

M =@ EN-» DE DE

i de-DE-TechDoc C:\Users\Documents. .
Run Transcheck Cancel

. To select the Transcheck Tests you want to conduct, click the underlined Preferences > Transcheck path
name in Transcheck Tests. This link opens the Preferences dialog where you can configure the preferred
settings for each Transcheck.

® Tt

Consistency checks are accessible through the Project Transcheck dialog. Or click = = on the
Sidebar, then click Transcheck under Current Project Preferences.

1. Source Consistency — Use to search for segments with the same target translation, but with
different source segments.

2. Target Consistency — Use to search for segments with same source segments, but with
different target translations.

Select the appropriate check boxes to ignore differences such as case, numbers, tags, and white
space for source and target file consistency checks. Click OK to return to the Project Transcheck
dialog.

. Enter the Report Name and browse to select the Report Location folder, or accept the default settings.

. (Optional) If you want to enable the Glossary or Blacklist checks, select the location of the Glossary or
Blacklist from the list on each tab.

. Click Run Transcheck.



A Report Summary is saved to the chosen location. Once complete, a Transcheck report finished message
displays with the number of segment errors found, if any.

Report is optimized for Google Chrome, some features might not work well in your current browser.

Project TransCheck Report
Report Summary (1 files)

Errars in file {visible highlights)

File Name

PO_en-de.docx, txdf 0

Ignored Terminology Errors

I:r'?-r |I Action " Condition Ill':.':l'r,-?'. I

Highlight: 1 Exact Match B Fuzzy mMatch| B Exact (No match) |Fuzzy (No match)

| Toggle Global Search Filters | Global search filter is OFF

Project TransCheck Report - Wordfastl - English - German
Report Summary (1 file)

TransCheck ran successfully on 1 file and found 39 errors.
Target Consistency Check ran successfully with 0 errors.
Source Consistency Check ran successfully with 0 errors.

File Mamea Total Number of Errors

PD_an-de.docx. ktxIf 20
PD_en-de.docx. txif

Empty Target Check 0
Edited Source Check 0
Capitalization Check 0
Iunedited Fuzzy Check 11
Medited Exact Check 3
Elspelling Check 16
ElTag Check 5
whitespace Check 4
Repeated Words Check 0

Unedited Fuzzy Check

& 1-6-1 | ACCESS REAL-TIME DATA ZUGRIFF ALF 75% Target contains a

Generate a Segment Changes Report

A Segment Changes Report provides you with the history of changes to a segment. You can run a Segment
Changes Report on one or more project files.

Il



To generate a segment changes report:

1. Inthe Current Project view, select one or more project files from the list on the Project Files tab, then click
Segment Changes Report.

Project Files Project TM Project Terminology Reporis Reference Files

BB B @ B E B B & B B

Translale Chain Open Source Close Save Modify  Analyze Transcheck Segment Changes
Files Folders File Files File Project Project Project Report Repori

2. Onthe Segment Changes Report dialog, select the languages or files to include in the report.

Project Files (11) Report Settings
/| Project Languages/Files Word Count Show Columns:
: ] Motes
M =@ EN->DE
M Sample4_Sample-File_Repeat_sn-de.doc. 196 i Comments
vl Sampled_Sample-File_en-de.doobdf 197 | Ratings
M word_preview_6093922392511916140.do 3B6 Post Edit Distance
> Sample3_Sample-File_en-de.doobdf 193
| Enable Diff Highlight
> sample-File_en-de.doox.txlf 188
vl Glossary.bet. bilf 16 Show all segments
M Project Stardust_Launch.doox. tdf 187 Show latest revision from a phase
M Sample-File_en-de-Captive_Word-Docs-de. .. 188 Open report after export
> Sample2_Sample-File_en-de.doocbdf 193
*) Filter Phase- (=)
M AdaptiveTranscheck.doox. bdf 532 fier Fnasenamsts) ! -

Filter Process-name(s):

Custom report name: Sample_Batch_Action_SegmeniChangesRepori_92239251°
Report Location:™ C\Users\Documents\Sourcel\WFP Browse...
Export Cancel
3. Select options from the Report Settings panel.
Option Action
Show Columns Select the columns you want displayed by clicking the appropriate check boxes.

Comments, ratings, and notes each have their own column. Blank columns
indicate the feature you selected is not available or there is no data related to that
option for the segment.

¢ Notes, Comments, and Ratings—Translators and reviewers each have
their own notes column. Only reviewers can add comments and ratings.

¢ Post Edit Distance—Compares new target content to prior target content
and determines how different they are, down to character additions and
deletions.

Enable Diff Highlight Select to compare differences between new target content to prior target content.
Red strike-through highlights indicate deletions and green highlights indicate new
content.




Option

Action

Show all segments

Select to download all segments in the Segment Changes Report, regardless of
any change to the target segment.

Show latest revision
from a phase

Select to include the latest content from a specific workflow phase, regardless of
total number of revisions for that phase.

Open report after export

Automatically open the report once the export completes.

Filter Phase-name(s)

Filter content in the report by a specific workflow phase by selecting that phase
from the drop-down list. You will need to select this option or the next one prior to
export.

Filter Process-name(s)

Filter content in the report by a specific process, such as No Review or Review
from the drop-down list. This option can be inclusive, so you can select several
processes. You will need to select this option or the one previous prior to export.

Include all phases
before selected phase-
name(s)

(Optional) Select this option to include all phases prior to the selected phase
name.

Custom Report Name

(Optional) Enter a unique name for the report if it requires customization.

Report Location

Browse and select the file location for saving the segment changes report.

4. Click Export.

5. On the Segment Changes Summary dialog, verify the names of the files you chose to include, then click OK.

Filename Segments Source segments ch... Target segments ch...
Wordfastl_Tran... 26 0 0
PD_en-de.doox... 32 0 -
PD_en-de.doox. 32 0 6

oK

6. Open the Segment Changes Report in a new browser window, then close the browser window when you are

done.



Segment Changes Report

Total Source Target

File Name SegmentsSegments
HEI0EETE Changed | Changed
PD en-de-IDML-de#TR DC#.idmI5331243546933436583.tx|f 32 1] 2

PD en-de-IDML-de#TR DC#.idmI5331243546933436583.txIf

[ Target Revisions

Translator
Notes

ID Scon Source

Use GlobalLlink Connect with any |documenta|GlobalLlink Connect funktioniert mit
CMS, PIM, CCMS, or e-commerce |( Transiatioljeder CMS-, PIM-, CCMS- oder B
platform. 1) —E-Commerce-
Wed Nov  |Plattform.

23
13:12:19
CsT 2016
documenta|GlobalLink Connect funktioniert mit
(Transistiofjeder CM5-, PIM-, CCMS- oder E-
1) Commerce-Plattform

Mon Nov
21
13:35:13
CST 2016 -

Generate an Export Notes Report

The Notes Report contains all notes added to the bilingual project files. It can be exported to HTML or MS Word.

To generate an Export Notes Report:

1. Inthe Current Project view, click Export Notes Report on the Project Files tab.

Project Files Project TM Project Terminology Reports Reference Files

B wB 2 L B & B RBR B

Tranglale Chain Open Source Analyze Transcheck Segment Changes Export Motes
Files Folders File Files File Report Report Report

2. On the Export Notes Report dialog, select one or more project language files.

Project Files {4 ) Report Settings
l =1 . Project Languagea/Files . Word Count Export notes as:

B = EN-> DE Wiord

=il i [ Po_en-de. fockdf 175 %) Himil

%l . PO_en-de3. doocbif 14 Report Locabion:” CAllsers\Desktop'WF_Test_reports Browse...

=4 i~ B Po_en-dest.docetf 214

% B PO_an-de2, docel £4f_de_notes.doc,tdf 10

3. Browse and select the Report Location destination, then click Export.

4. On the Export Notes Summary dialog, click OK.



Filemame Segments Segments with Notes

Sample_1.doodd beml. bdf 37 3
Sample_3.dooc bl bdf 37 1
Sample_2.doodd beml. bdf 37 0

oK

The notes report saves to the specified location.

Clean Up a Project

After you have translated project files, you can clean them and update the translation memory (TM). The Clean
Up action converts the bilingual TXLF files into translated target files with the file format of the source.

To clean up the project and update the TM:

1. Inthe Current Project view, click Cleanup on the Project Files tab.
Project Files Project TM Project Terminology Reports Reference Files

BB B [ B &8 B B B E

Translate Chain Open Source | Analyze Transcheck Segment Changes Export Notes  Cleanup
Files Folders File Files File Report Report Report

2. On the Project Cleanup dialog, select a language or languages.



Project Cleanup x

e Project Glean Up
Select the options that you would like to use to write translated segments o TM and create translated files

Select languages fo cleanup Translated File Setfings

#) All Language Pairs

Browse
Create subfolders by language
Add language suifix to the translated file name
Single Language Pair
TM Cwverwrite Options
Owerwrite exisling TU -
Add attribute
Add file name as attribute
Owerwrite private TUs (WFSenver TM only)
Select TM(s) io Updats
Symbolic Name Type Source Target Path
German_DE local en-Us de-DE C:\Users\lzielsdorf\Documents!So. .
AdaptiveTranscheck-German local en de-DE C:\Users\lzielsdorf\Documents}So. .
Clean Up Cancel
All Language Pairs Click to clean up all language pairs for the project.

Specific Language Pairs Click to clean up only the language pairs you specify from the drop-down list.

Single Language Pair Click to clean up only one language pair you select from the drop-down list.

Specify the location for the translated files from the drop-down list.

ow

(Optional) Select Create subfolders by language.

(Optional) Select Add language suffix to the translated file name.

Select TM Overwrite Options from the drop-down list.

(Optional) Enable Add attribute, then enter that attribute in the attribute field.

(Optional) Enable Add file name as attribute to add the file name to the file attributes.

© © N o v

(Optional) Enable Overwrite private TUs (WFServer TM only) if you are connected to a Wordfast Server TM
and want to overwrite the private translation units (TU).

10. Select the TM(s) to Update from the table.



11. Click Clean Up.
12. On the Info dialog, click OK.

When the cleaned files are saved at the designated location, a message displays indicating that the cleanup
finished successfully.

Remove a File

Use these steps to remove one or more files from a project.

@ You can add a removed file back into a current project. Retrieve removed files from the project folder
on your computer using the Add Files action.

To remove a file from a project:
1. In the Current Project view, select one or more files, then click Remove File(s) on the Project Files tab.

Project Files Project TM Project Terminology Reports Reference Files

BEw B ! B B E F £ & B

Add Translate Chain Segment Changes Export Notes Cleanup Recalculate Import Export Remove
Files Folders File Files Report Report Progress Package Package File(s)

2. On the Remove dialog, choose a removal option.

*) Remove from the list only

Remaove from the list and move the following resources to Archive folder

Resources #
TXLF Files 3
Source Files 7
4 3
0K Cancel
Remove from the list only Click to remove the selected files from the file list without moving

them to an Archive folder.

Remove from the list and move the Click to remove the selected files from the file list and to move

following resources to Archive folder them into a local Archive folder. When this option is selected, a
warning displays to alert you that this option physically moves
the files from their current project folder into an Archive folder.

3. Click OK.

The files are removed from the current project.



6. Manage Submission Files

Once you have a project set up in Wordfast Pro, you are ready to work with the files. Access the project files
from the Current Project view. When you open a TXLF file, the view switches to the TXLF Editor view. In the
TXLF Editor view, you can translate, review, temporarily combine files by chaining them together, and work with
translation memories and terminology lists.

Translate a File

Save your work often by clicking Save on the File tab or by pressing Ctrl+S.

To translate a file:

1. On the Project Files tab, select a file, then click Translate File or double-click the file name to open it.

SRR TR U Project Terminology  Reports  Reference Files e~ x
e 2 [ B E E B B

Add Add Translate Chain Open Source Close Save Modify Bilingual
Files Folders Fila Files File Project Project Project Export

2. Select a target segment and enter the translation. If you have a translation memory (TM) added to the project,
you can leverage translations from it.

s
Source or Target + Match Case | | Regex |Enter text to fiter sv | Filter: | Select special fiter(s). + | O £F X Sor )
1D Englizh German Score  Status
TRANSLATION MANAGEMENT.  UBERSETZUNGSMANAGEMENT. | 100% -
2 MADE SIMPLE. EINFACH GEMACHT. s
STREAMLINE PROJECT EFFEKTIVES
> | MANAGEMENT PROJEKTMANAGEMENT o

4 INTEGRATE WITH ANY SYSTEM |[INTEGRATE WITH ANY SYSTEM | 100+%
EpWORK WITH MULTIPLE miF WITH MULTIPLE
VENDORS € NDORSE Eold]

6 ACCESS REAL-TIME DATA
GloballLink Project Director saves

5 organizations millions of dollars by v
|lautomatina manaaement of localizz | - . . L LT

K. @

3. Once you are satisfied with the translation, click Next Segment or Alt + Down Arrow. This action updates
the TM and moves to the next target segment. The segment state changes to Translated. Segments that are
changed to Translated are calculated in the progress shown on the Progress Bar at the bottom of the window.

Segments: 24/33 | Segment (8rc/TgtMax): 11/28/- | Paragraph (Src/Tgt/Max): 20/28/- _Ieft)



Translate Segments

When you convert a file to a translatable format, all complete sentences become separate segments, often
divided by formatting or punctuation. Segments may be sentences, words, or numbers, depending on the
formatting of the source file. After you save the segment translations, the application commits the segment
translations to the translation memory (TM). Leveraging the TM automatically and consistently reduces the time
and expense of future translations by translating reoccurring words and phrases.

To facilitate rapid use of language-specific quotation marks, punctuation, and white space, select
Enable Smart Quotes in Preferences > General Preferences > Segment.

You can choose from two layout views for your TXLF Editor workspace.

e Table view — This layout view displays the source segment to the left and the target segment to the right.

e Stacked view — This layout view displays the source segment row directly above the target segmentin a
spanned row.

You can select either layout view by clicking the drop-down list for the Switch Editor Layout action on the File
tab.

If there are either split or merged segments, indicated in the Status column with riorA, all split or
merged rows within the spanned row have the same ID column color.

s
Source or Target + Match Case | | Regex |Enter text to fiter sv | Filter: | Select special fiter(s).. ~ | O £F ¥ Sor
D English German Score  Status
TRANSLATION MANAGEMENT.  UBERSETZUNGSMANAGEMENT. | 100%
2 MADE SIMPLE. EINFACH GEMACHT. e
STREAMLINE PROJECT EFFEKTIVES
> | MANAGEMENT PROJEKTMANAGEMENT o

4 INTEGRATE WITH ANY SYSTEM |INTEGRATE WITH ANY SYSTEM | 100+%

5 | EEPWORK WITH MULTIPLE o WORK WITH MULTIPLE
VENDORS @ NDORS o

6 ACCESS REAL-TIME DATA

GlobalLink Project Director saves
organizations millions of dollars by

SE. 0

lautomatina manacement of localiz: | . . I

-

TRANSLATE SEGMENTS

View Review History

Use the Review History tab to view your translation corrections for the open file, such as step or phase name,
reviewer username, modified target, grading and scoring, comments, modification date and time, and review state
history.



TM Lookup Notes Review History Metadata Transcheck (0}

Step | User Target Ratings Comments Date Modified

Laks Vor-Ort-Installation 2017/04/06 20:35:06
oder Cloud- EDT
Bereitstellung mit
vollem
B funktionsumfang

unknown Mor-Ort-Installation 2017/04/06 20:35:06
oder Cloud- EDT
Bereitstellung mit
vollem
Funktionsumfang

TRANSLATE SEGMENTS

Commit to the TM

Once you have finished translating some or all of the file segments, update the translation memory (TM) with your
translation. This requires committing some or all of the translated target segments to the TM.

To update the translation memory:

1.

In the TXLF Editor view, on the Translation tab, choose one of the following:

e Select a segment, then click Commit to commit a single segment to the TM.

o Click Commit All to commit all segments in the file to the TM.

. = = [ =
B B B R B S 9 g &

Next Previous Commit Leverage Mark All - Copy - Commit Concordance Machine Analyze
Segment Segment Translated Source All Search Translation

. (Optional) Verify that the updates you committed to the TM have a purple highlight.

. (Optional) If you are updating the TM for the current segment only, continue your work and repeat as often as

necessary until you have committed all translated segments to the TM.

TRANSLATE SEGMENTS

Copy Source Content

To copy source content to the target:

1.

2.

3.

In the TXLF Editor view, on the Translation tab, select a source segment.

To copy the source content, choose one of the following:

e Click Copy Source.
e As a shortcut, press Alt+S to copy the source content.

Select a copy action from the resulting drop-down menu.



File Edit Formatiing Translation Terminology Review

| Teminology  Review
E B B R EBE B R PR B
Copy

Next Previous Commit Leverage Mark All - Copy Until Uniil No Translate

Segment Segment Translated Sourcs All Sources Fuzzy Match All
Option Action
Copy Source Select to copy from source all content and tags to the target.
Copy Source Text Select to copy only content from source to the target.
Copy Source, Tags and Term Select to copy from source to target all content text, its tags, and
Translations translated concordance glossary terms.
Copy Source and Term Select to copy from source to target all content text and translated
Translations concordance glossary terms.

Copy Source, Tags, Source and Select to copy from source to target all content text, its tags, and both
Target Terms source and translated concordance glossary terms.

Copy Source with Source and Select to copy all source and translated concordance glossary terms to
Target Terms the target.

The specified source content is copied to the selected target.

TRANSLATE SEGMENTS

Copy All Source Segments
To copy all source segments to all target segments:

1. Inthe TXLF Editor view, on the Translation tab, click Copy All Sources.

E B B B B B B R
T copy | Copy

Next Previous Commit Leverage Mark All Until Uniil No Translate
Segment Segment Translated Source All Sources Fuzzy Match All

All source segments are copied to all segments in the target column.

2. (Optional) Begin translation in the target column.

TRANSLATE SEGMENTS

Split or Merge a Segment

You can split or merge an existing segment to change segmentation. This is particularly useful for certain file
types or for languages where the next segment content may need to precede the previous segment. The best
time to split or merge a segment is early in the translation process.

To split or merge a segment:
1. In the TXLF Editor view, and on the Translation tab, select the segment to split or merge.

2. Click Merge or Split.



Ei

ile Edit Formatiing Translation Terminology Review

@@@%%IBR@E‘E%

Next Previous Commit Leverage Mark All - - Merge Split Do Mot Write LockUnlock Clear
Segment Segment Translated Source To TM Segment Target

The segment is merged or split and the segment Status column contains either Aor i, respectively. If the

me

*Sample-File_en-de-Captive_Word-Docs-de§HN#.docxy %

rge includes an entire paragraph, this is denoted with .

o

Source or Targel = | [ | Match Case | | Regex |Enter text fo fiter seg ~ | Filter: |Select special fiteris)~ | O £F X so:|D )

D ' English -> German ' [ Score | Status |
TRANSLATION MANAGEMENT 20 X .

1 | UBERSETZUNGSMANAGEMENT. s I
MADE SIMPLE.

2 |EINFACH GEBILDET. <
STREAMLINE a

> EFFEKTIVES PROJEKTMANAGEMENT Ly o
PROJECT MANAGEMENT

4 v
INTEGRATE WITH ANY SYSTEM EEIWORK WITH MULTIPLE VENDORS

5 | INTEGRATION MIT JEDEM SYSTEM ZUSAMMEN ARBEIT MIT JEDEM o0 7
ANBIETER ~ .

TRANSLATE SEGMENTS

Lock a Segment

You can lock a segment to prevent any further changes to that segment. The best time to lock a segment is when
the translation is complete and the reviewer has confirmed the content after proofreading it. The Commit action
still updates the translation memory (TM) with the target segment content.

To lock a segment:

1. Inthe TXLF Editor view, on the Translation tab, select the segment to lock.

2. Click Lock/Unlock Segment.

Fi

] Edit Formatting Translation Terminology Review

@;@@%%IRE—Z@,E‘E%

Next Previous Commit Leverage Mark All - Merge Split Do Mot Write LockWUnlock Clear

Segment

Segment Translated Source To TM Segment Target

i is displayed in the segment Status column to indicate the segment is locked.

TRANSLATE SEGMENTS

Clear Target Segments

To clear target segments:




In the TXLF Editor view, on the Translation tab, select a target segment.

. Click Clear Target.

File Edit Formatting Translation Terminology Review

remnooor e

Mext Previous Commit Leverage Mark All - Copy - Merge Split Do Mot Write: LockUnlock Clear
Segment Segment Translated Source To TM Segment Target

From the drop-down menu, select one of the following options:

e To clear the selected target segment, click Clear Target.

e To clear all target segments, click Clear All Targets.
On the Clear Current Segment Target dialog, click Yes to agree to the target content removal.

The target content is removed.

TRANSLATE SEGMENTS

Do Not Write To TM

Translators can use the Do Not Write To TM action to prevent a segment from being added to the translation
memory (TM).

To prevent a segment from being added to the TM:

1.
2.

In the TXLF Editor view, place your cursor in a translation segment..

On the Translation tab, click Do Not Write To TM, or press Alt + Enter.

E B B R B @B BR B B B

Mext Previous Commit Leverage Mark All - Copy Merge Split Do Mot Write LockUnlock Clear
Segment Segment Translated Source To TM Segment Target

The TM is not updated with the target segment content.

The “% icon is displayed in the segment Status column.

. (Optional) To later remove the restriction so the segment can be added to the TM, click Do Not Write To TM

again.

Chain Files

To combine multiple files and view them as a single file, use Chain Files. For example, if you are translating or
reviewing ten files with ten segments each, you can temporarily chain them into a single file of 100 segments.
This is particularly useful when working with duplicate or similar content among files.

A You cannot export or save chained files as a single TXLF file.

@ You can open and work on a single chained file or multiple sets of chained files in the TXLF Editor

view. Each chained file displays on its own tab.



To chain files:

1. In the Current Project view, on the Project Files tab, select a set of files, then click Chain Files.

@ Use Shift+Click to select sequential files or Ctri+Click to select individual files.

Project Files
B wr B 2 B B EE B & E R _
Add Add Translate Chain Open Source Close Save Modify Bilingual Analyze Transcheck Segment Changes -
Files Foldars File Files File Project Proje Project Export Report Report
Files | Wo... ‘ TXLF File Locatio | Cm".- Complete - [ > I
. EN-> DE

: I5) Sample-File_en-de-Captive_Word-Docs-de=HNz. docx.bdf 188 CUsers\Publi.  20.. 20.. [EDNESEEN |

- [ sample2_sample-File_en-de. docx.bif 193 ClUsers\Publi.. 20 20. [ 6% |

- I sample4_Sample-File_en-de.doox.bdf 197  C\Users\Publi. 20 20 [ 15% |

. ‘ Sample-File_en-de-Captive_Word-Docs-de=HNZ L.doc:-004.bdf 19 C:\Users\Publi... 20 zo..  (EGGEEN

i AdaptiveTranscheckl_de-DE_segment_changes.html.bdf 22 C:\Users\Publi... 20..  20.. 0%

B sample-File_en-de-Captive_Word-Docs-de=HN=1.docx-002.bdf 7 CiiUsers\Publi..  20.. .

5 sample-File_en-de-Captive_Word-Docs-de=HNz  doocbdf. doce. bdf 695  C\Users\Publi..  20.. 0% |

[ sample-File_en-de-Captive_Word-Docs-de=HN=3.docxd bdf 188 Cr\Users\Publi..  20.. | 3%

The chained file opens in TXLF Editor.

@ To determine the related file name for a segment, hover over the segment ID.

*Chained Files 2 X .
|Suurce or Target = | | |Match Case | | Regex |Enter lex! lo filler segme | FIler.'|Se|e-.:i special filteris).. = | O ﬁ »  Sor )

[v] Engligh -> German Score Status
TRANSLATION MANAGEMENT. -+
UBERSETZUNGSMANAGEMENT. R R
MADE SIMPLE.

100+% o

2 |
EINFACH GEBILDET.
lSTREAMLIHE PROJECT MANAGEMENT

59%
EFFEKTIVES PROJEKTMANAGEMENT -

INTEGRATE WITH ANY SYSTEM
INTEGRATION MIT JEDEM SYSTEM

WORK WITH MULTIPLE VENDORS
ZUSAMMEN ARBEIT MIT JEDEM ANBIETER
\ACCESS REAL-TIME DATA 4

-

99% o

2. Click a segment to make it the active segment.



The filename changes from the chained name to the source filename of the active segment.

%)

Source or Targel - Malch Case | | Regex |Enter text 1o fiter segme ~ | Fier |Seleel special fiteris) . = | O & X sor }
1D English => German Score Status
TRANSLATION MANAGEMENT. -
.UBERSETZUNGSMANAGEMENT. | I
MADE SIMPLE. |
EINFACH GEBILDET. | e 7
STREAMLINE PROJECT MANAGEMENT
.EFFEK‘I’WES PROJEKTMANAGEMENT | o i
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WORK WITH MULTIPLE VENDORS
.ZUSAMMEN ARBEIT MIT JEDEM ANBIETER | f
ACCESS REAL-TIME DATA | .

6
ZUGRIFF AUF LEISTUNGSKENNZAHLEN IN ECHTZEIT

3. Translate, review, or edit each segment. The Segment State will change to Translated . Toggle the Segment
State between Translated and Needs Translation as needed. The changed Segment State will be calculated in

the completion percentage in the Progress Bar.

4. (Optional) Click Recalculate Progress on the File tab to calculate the progress of the translation and review.
The total percentage displays in the Progress Bar at the bottom of the window. For chained files, the progress

percentage will be for all the files combined.

5. Click Save on the File tab.

@ If you need to review the files again, the chain files will open in the same order you saved them.

The segments are saved in the chained file and restored to their original files without the chained format. The

progress for each individual file will show on the Progress tab.

Find and Replace Content

Use Find/Replace to search for and replace text in translated content.
To find and replace content in a file:

1. Inthe TXLF Editor view, click the Edit tab.

2. Click Find/Replace.

ﬂ Edit Formatting Translation Terminology Review

qa rxkE b B B B

Undo Bedo  Cut  Copy  Pasts Find/  Copy Al | Clearal

Replace Tags Tags

=24
Edit
Source

Revert
Source

[7)

Show Whitespace
Characters

eAx



. On the Find/Replace dialog, click in the Find what field, then enter your search text or select it from the drop-
down list.

Find/Replace x
Q Find what: translation v
3 Reading Highlight = Find Next Cloze
Direction Options
Backward & lgnore Case «" Search Source
* Forward Whole Words Only b Search Target
Ignore NBSP «" Search Open Files
~ Use Regex

. (Optional) Click ¥ and # to expand and collapse the panel for additional options.

@ Search text can include regular expressions (Regex), wild card characters, and non-breaking spaces.

. Click Find Next to move through all instances of the content.

. (Optional) Click Reading Highlight and select the Highlight All action from the drop-down list to highlight all
instances of the content in all open files.

Find/Replace x
Q Find what: translation b
~ Reading Highlight ~ LR Close
Direction ¢ Highlight All
Backward A Ciear Highlighting | Bearch Source
* Forward Whole Words Only & Search Target
Ignore NBSP «" Search Open Files
» Use Regex

. (Optional) To replace regular expressions, wild card characters, or words, click the down arrow on the sidebar,
then click ™..

. Click in the Replace with field and enter replacement text.



Find/Replace x

N\, Find Mext: translation v
Replace with: v
a Replace Replace All Find Next Close
Direction Oplions
Backward | lgnore Case " Search Source
*) Forward Whole Words Only &1 Search Targel
Ignore MNBSP «" Search Open Files

» Use Regex

9. (Optional) Select the direction of the search and any further options.

10.

You cannot use the Whole Words Only search option when entering multiple words or punctuation in

either search field.

@ Select Use Regex to search on regular expressions or wild card characters.

(Optional) Click one of the following actions: Replace, Replace All, Find Next, or Close.

The content you found has been replaced with the new content.

Spell Check a File

You can use a spellchecker to verify translated content aligns with configured spell checking preferences. Refer
to Configure and Enable Spellchecker. You must verify that your Hunspell spelling dictionaries have the latest
updates. Refer to Licensure.

To spell check a file:

1.

On the Review tab, click Spellcheck File.

File Edit Formatting Translation Terminology Review _
3 @ B B OB B

Spellcheck File Mark Spelling Add MNote Edit Noie Delete Moie Export Motes Transcheck Transcheck
Errars Segment All

On the Spelling dialog, review the suggestions and select one of the options.



W Use this pags to check spelling.

Mot in Dictionary:

DICHTUNGSLOSE DATENBANKINTERGRATION Ignore Once
Ilgnore All

Add to Dictionary

Suggestions:
DATENBANKINTEGRATION Change
EINWANDERERGENERATION Change All
Preferences Cancel
Item Action
Ignore Once Click to disregard the suggested change for a word only once.
Ignore All Click to disregard the suggested change for all occurrences of a word in the file.

Add to Dictionary Click to add word to personal dictionary.

Change Click to accept the suggested change for a word.

Change All Click to accept the suggested change for all occurrences of a word in the file.

@ If spell checking is not available for the target language, a warning message notifies you. Click OK.

3. To view spell checking preferences, click Preferences or click Cancel to reject any changes.

4. Close the Spelling dialog.

Leverage Translation Memory

Translation memory (TM) acts as a database to provide maximum re-use of previously translated content. It also
serves to facilitate collaboration between globally distributed localization resources.

Projects connected to a translation memory (TM) leverage content matches against an existing TM. TM matches
generally fall into three categories: 100% match, fuzzy repetitions, or no match. Your organization may choose to
alter or add more fuzzy repetition categories. The typical fuzzy repetition values are for 95% to 75% matches. The
segment highlight identifies the type of TM match.

Color Code Category

Green Indicates a 100% match.




Color Code Category

Green, Dark Indicates a context match. A context match for a segment must meet one of the
following criteria:
e The segment has a correct checksum or attribute match.
e The previous and next segments also have a 100% match.
e The 100% matched segment is a single paragraph.

Grey Indicates there is no TM match.

Pink Indicates a modified segment.

Pink, Light Indicates the segment was a machine translation (MT) instead of a human translation.
Purple Indicates an update to the TM for a modified segment.

Purple, Light Indicates the update to the TM of a translated and committed segment automatically

updates other repetitive segments within the translation.

Yellow Indicates a fuzzy match.

LEVERAGE TRANSLATION MEMORY

Leveraging a segment involves selecting the best possible translation from the connected translation memories
(TMs) or machine translation engines to populate target segments.

To leverage a TM:
1. In the TXLF Editor view, on the Translation tab, select the segments to leverage against the current TM.

2. Select an action to leverage the current TM.

Leverage Select to leverage a single segment.
Until Fuzzy Select to leverage segment content until reaching a fuzzy match.
Until No Match Select to leverage segment content until there is no match.

Translate All Select to leverage all content in all segments.

LEVERAGE TRANSLATION MEMORY

A concordance search looks for specific source segment text in a translation memory (TM). To view concordance
search results for both source and target segments, use the TM Lookup tab in the Editor pane.

To conduct a concordance search:
1. Click the Translation tab, then select a word or phrase in the segment in the TXLF Editor view.

2. Click Concordance Search, or press F8.

You can also search for a word or phrase by entering it in the TM Lookup field. Then, to conduct
a search of both source and target, press Enter. Instances of the search term are highlighted in



the Editor pane, along with its bilingual equivalents. To conduct a more specific search, click Find
Source or Find Target.

@ You can reorder the columns of the TM Lookup results. That reorganization remains, even after you
exit the software.

TM Lookup Notes Segment History Metadata Transcheck (0)

vendor More Options ~  Find Source Find Target Clear
# Source Target Score | TM Mame Last Modified Custom Attribute
WORK WITH ZUSAMMENARBEIT | - Doc TM2 | 2015/11/04
1 | ANY VENDOR MIT JEDEM @
ANBIETER
WORK WITH ZUSAMMENAREBEIT | -* Doc_TM1 | 2017/04/04
2 | ANY VENDOR MIT JEDEM @
ANBIETER
Allow access to Maximale - Doc_TM2 | 2015/11/04
any vendor or Ressourcenflexibilitat
internal durch Zugriff auf alle
3 | translator for Anbieter und internen @
maximum Ubersetzer
resource
flexibility

3. (Optional) To refine the search, select More Options and select a check box from the drop-down list.

Option Action

Match Case Select to filter by upper and lower case.

Exact Select to filter for only those terms organized in the same sequential order.
Automatic Leverage Select to automatically update target content when moving to a new segment.
Diff Highlight Select to highlight the difference between the submitted segment and the TM

source segment.

Include Private TU (GLTMS) Select to include private segments or translation units (TUs) when searching
a remote TM.

The refined search results for the word or phrase you selected are listed on the TM Lookup tab of the Editor
pane. You can use the results of your search in the related target segments.

LEVERAGE TRANSLATION MEMORY

View TM Leverage Results

Leveraging the translation memory (TM) occurs automatically as you move through the target segments. This
provides you with the best possible segment matches from the TM and is the only search that uses scoring to
select the best match.

To view TM leverage results:



1. In the TXLF Editor view, click on a source or target segment.

This populates the columns on the TM Lookup tab of the Editor pane and provides a score, based on TM
leverage results.

TM Lookup Notes Segment History Metadata Transcheck (0)

More Options =  Find Source Find Target Clear

# | Source Target Score TM HName Last Modified Custom Attribute

1 | SIMPLIFIED. VEREINFACHT. | 100% Doc TM2 | 2015/11/04 @
SIMPLIFIEDIE | mit minimalstem | 999 Doc TM2 | 2013/04/26

2 €
plfied Aufwand

3 SIMPLIFIED. Vereinfacht. 99% Doc_TMZ2 | 2014/03/14 ®
Simphiied-

4 SIMPLIFIED B Vereinfacht. 99% Doc_TM2 | 2014/11/07 ®
Simphiied-

5 | SIMPLIFIED. VEREINFACHT. | 100+%* | Doc TM1 | 2017/04/04 @

2. Review TM leverage results in each TM Lookup column for that segment.
Item Behavior
Source Displays source segments provided by the TM. Any difference between the submitted

segment and the TM source segment is highlighted.

Target Displays target segments already in the TM.

Score Displays a TM leverage score.

e Percent (%) — 100% and fuzzy matches
e Plus (+) — Context matches
e Asterisk (*) — Secondary TM match
¢ Red outline — TM has assessed a penalty to the segment
Refer to Leverage Terminology Lists for more information on TM color codes.

TM Name Identifies the name of the leveraged TM. If you are leveraging multiple TMs, it lists the
TMs in order of priority: primary, then secondary TMs.

Creation Date Identifies the TM segment creation date.
Creation User Identifies the username of the segment creator.
Last Modified Identifies the date of the last segment modification.

Modification User Identifies the user who last modified the segment.

Custom Attribute Identifies any segment custom attribute name and its associated values

@ Actions Acts as a button to access score breakdown information, including penalties.

3. (Optional) To constrain the columns within the pane, click on any column head, then deselect the names of the
columns you want to hide.



TM Lookup Notes Segment History Metadata Transcheck (0)

- More Options ~  Find Source Find Target Clear
#  Source w Target Score L TM Name Last Modified
5 | SIMPLIFIED. T Sortascending (A & l Doc_TM1 | 2017/04/06

1 + SortDescending | [/ spurce

1 | SIMPLIFIED. Doc_TM2 | 2015/11/04
" [ col p | T Target —
3 SIMPLIFIED NN vorcunaun  , Doc_TM2 | 2014/03/14
4 | SIMPLIFIED BESHEBEEEE | Vereinfacht &/ ™MName Doc_TM2 | 2014/11/07
SIMPLIFIED FSEEE mit minimals| — oo 0o Doc_ TM2 | 2013/04/26
2 Aufwand Creation User

7 Last Modified —
Medification User
| & Custom Attribute |

w1 Actions

LEVERAGE TRANSLATION MEMORY
Leverage Machine Translations

The machine translation (MT) feature can automatically populate target segments whenever you open a file
or when there are no translation memory (TM) segment matches. Select a project for your MT and configure
Machine Translation options under Preferences > General Preferences.

To leverage MT:

1. In TXLF Editor view, on the Translation tab, click Machine Translation to submit the source segment for MT
and populate the target segment with the results.

. — — e i
B B B R E S 8 g &

Next Previous Commit Leverage Mark All - Copy - Commit Concordance Machine Analyze
Segment Segment Translated Source All Search Translation

2. (Optional) Verify that the quality of the translation for the source segments aligns with your requirements.
The target segments are populated with the MT for the source segments.
3. (Optional) If you are updating the current segment only, continue your work and repeat as often as necessary

until you are ready to save and commit all translated segments to the TM.

LEVERAGE TRANSLATION MEMORY

Commit to the TM

Once you have finished translating some or all of the file segments, update the translation memory (TM) with your
translation. This requires committing some or all of the translated target segments to the TM.

To update the translation memory:



1. Inthe TXLF Editor view, on the Translation tab, choose one of the following:

e Select a segment, then click Commit to commit a single segment to the TM.

o Click Commit All to commit all segments in the file to the TM.

1 = [ =" =
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Mext Previous Commit Leverage Mark All - Copy - Commit Concordance Machine Analyze
Segment Segment Translated Source All Search Translation

2. (Optional) Verify that the updates you committed to the TM have a purple highlight.

3. (Optional) If you are updating the TM for the current segment only, continue your work and repeat as often as
necessary until you have committed all translated segments to the TM.

Leverage Terminology Lists

Terminology lists provide users with the ability to standardize term usage and to control the use of terms, variants
of terms, and parts of speech allowed for terms. A terminology list includes a glossary, a specialized list of source
terms, their definitions, and their preferred translations. It also includes alternate phrases for blacklisted terms.

Segment selection highlights terms from the terminology list on the Terminology pane along with potential

translation options.

@ There are two possible methods for moving among terms on the Terminology pane.

e Click Next Term (Ctrl + 9) or Previous Term ( Ctrl + 8).



Fa

Source or Target - Match Case Regex |Enter text fo fiter segme ~ | Filter: | Select special filter{s)... - D f}' ¥ sor
D English == German Score Status
TRANSLATION MANAGEMENT.
2 95%

Ubersetzungsmanagement. I
MADE [SIMPLE|

> |EINFACH GEMACHT. ' I
STREAMLINE| PROJECT MANAGEMENT
OPTIMIEREN PROJEKTMANAGEMENT v
INTEGRATE WITH ANY SYSTEM
INTEGRATE WITH ANY SYSTEM

- WORK WITH MULTIPLE VENDORS)
o

|\WORK WITH MULTIPLE VENDORS _ , | [
TM Lookup Notes Segment History Metadata Transcl + Terminology
~ | MoreOptions > |-y Glossaries (Target) - 0 X &
[ , eine Stromlinienform geben .
EFFEKTIVES PROJEKTMANAGEMENT = )
Streamline ©
Optimierung
Effektives Projektmanagement . || STREAMLINE ©
4 N OPTIMIEREN -

@ EN—DE | Segments:5/34 | Ssgment (Src/TgtMax): 20/28/- | Paragraph (Src/Tgt/Max): 29/28/- - 91% Translated (169 words left)

The term highlight identifies the type of translation match between the source term and the terminology list.

Use Highlight All Terms to view highlights for term matches in the open file.

Color Code Category

Green Exact term match

Yellow Fuzzy term match

Red Missing exact term match
Purple Missing fuzzy term match

LEVERAGE TERMINOLOGY LISTS

Add a Term

You can add terms to both local and remote glossaries. You need read and write user permissions to add terms to
a remote glossary that is not read-only.

To add a term to a glossary:

1. On the Terminology pane, select a word in the source segment and, optionally, the translation in the target
segment, then click +.

2. (Optional) On the Add Term dialog, enter content in the Description field.



Required fields are marked with a red asterisk.

Add Term x

-

W Use this page to add a term to the selected glossary.

Source:* INTEGRATE WITH |
Target* INTEGRATION MIT |
Description: | |
Glossary: ' Doc_Term1 v |

OK Cancel

3. Select the proper Glossary from the drop-down list.
4. Click OK.

The new term is added to the glossary.

LEVERAGE TERMINOLOGY LISTS

Edita Term

A You can only edit terms in the local glossary.

To edit a term:

1. In the TXLF Editor view, on the Terminology pane, select a term.

4+ A X < Terminology
|Search Glossaries (Source) | D > -!:I-
roject .

ke ‘@

projekie

Project Management ©

Projektmanagement

4 3
2. Click #".

3. On the Edit term dialog, make your edits.



4.

W Use this page to edit a term in the selected glossary.

Source:

| project |

Target:
| projekte |

Description:

Modify Cancel

Click Modify

The term is edited.

LEVERAGE TERMINOLOGY LISTS

Insert a Term

To insert a term into the current target segment:

1.
2.

3.

In the TXLF Editor view, click the location for term insertion.
Select the term to insert from the Terminology pane.
Click +' on the upper left menu bar within the Terminology pane.

The term is inserted into the target segment.

LEVERAGE TERMINOLOGY LISTS

Search for a Term

To search for a term:

1.

2.

On the Terminology pane, enter a term in the terminology filter field.

Click 2 .



The search results from the connected glossaries are displayed.

+ Terminology
project ~ | 0 X 1t
project -
projekie ®
Project Management ®
FProjektmanagement

Project Director ®
Project Director

LEVERAGE TERMINOLOGY LISTS

Copy a Term

To copy a term from the glossary into the current target:

1. In the TXLF Editor view, click a segment that contains glossary terms.

2. On the Terminology tab, click Previous Term or Next Term to select a source term.

Fle Edit Formatting Transiation QREEET
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Terminology Previous Copy MNext Highlight
List Term Term Term All Terms

3. Click on the target location where you want to copy to the glossary term.

4. Click Copy Term.

T e ——— Tcrminology

ey
Terminalogy Previous Copy Next Highlight
List Term Term Term All Terms

The glossary term is copied to the target segment.

LEVERAGE TERMINOLOGY LISTS
Copy a Synonym
To copy a synonym for a term:

1. In the TXLF Editor view, select a source term in a segment that has a glossary term.



This highlights and adds a border around the source and target terms. Synonyms display on a temporary pop-
up pane and on the Terminology pane.

EXpWORK WITH MULTIPLE VENDQE
005
ZUSAMMEN ARBEIT MIT JEDEM A 5“"“"':“'""'""_ 9

noun

Target: Anbieter
noun

Glossary Name: Multi-Ling_Project

Source: vendor
- noun, lower case

Target: Anbieter

G noun, lower case
Glossary Name: Multi-Ling_Project

+ Terminology
D X &

Vendor

Anbieter ‘(D

vendor

Anbieter ‘(D

.4
2. Click within the target segment at the location where you want to copy the term.

3. Click Copy Term.

@ An alternative is to click the preferred target term from the Terminology pane. This also copies the
term to the cursor location in the target segment.

H B &
Previous Copy Hext Highlight

Tem Term Term All Terms

The target synonym is copied to the target segment.

LEVERAGE TERMINOLOGY LISTS
Remove a Term

A You can only remove terms from local glossaries, not read-only or remote glossaries.

To remove a term:

1. In the TXLF Editor view, go to the Terminology pane.

2. Select a term, then click .

Use the Remove Term < at the top of the Terminology pane. Do not use the Reset Search <. This
clears the filter.

A warning message notifies you of the pending deletion and asks you to agree to the term removal.



3. Click Yes.

The term is removed from the local glossary.

Tags contain information related to a block of text, such as format or indentation. Tags are not translated and
come in pairs: an opening and a closing tag.

A Translations must retain the same tags at the correct location within a target segment.

Unless you have disabled Remove incomplete tag pairs in Preferences > General Preferences >
Tags, a warning message results when you try to save a target segment with a missing tag or an
open tag. An open tag is part of a tag pair in the target segment that is missing its matching close tag.
The warning will give you three choices: Fix Manually, Delete, or Always delete.

Hover over a tag to view tool-tip information.

®BBTRANSLATION MANAGEMENT, €

=fontFormat colors"235 327 highlight="D#0#0#0" name="Gothan Medum” size="200" backgroundCabor="DF0#0E0"
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Tags contain numerals to indicate their order in the segment.

Red This is a tag you currently selected, such as the first tag, II in the file.
Purple This is a tag that specifies formatting, such asEZE»
Blue

This is a tag that specifies non-formatting controls, such as EDe €1

MANAGE TAGS

Translated content retains the formatting of the source content, so tags are an important element in the final
translation. You can copy tags from the source to the target for formatting and indentation accuracy.

Use Preferences > General Preferences > Tags to configure tags as full name, short name, or
numbered tags.

To copy a tag:
1. Open afile.

2. Inthe TXLF Editor view, on the Translation tab, select a segment with tags.

When the selected segment contains tags, the first tag is automatically selected. Red indicates
selection.



3. Choose one of the following actions:

e Click a source segment tag and drag it to the corresponding location in the target segment or press Ctrl
+Alt+Down Arrow.

e Click a source segment tag, then click in the corresponding target segment location and click Copy Tag.

e Right click a source segment tag, select Copy (Ctrl+C) in the drop-down menu, click in the corresponding
target segment location, then sele-ct Paste (Ctrl+V).

E B B R B R BR B B0
Copy

Next Previous Commit Leverage Mark All Merge Split Previous Mext Copy Edit
Segment Segment Tranglated Source Tag Tag Tag Tag

The target segment, highlighted in blue, contains the copied tag at the cursor location you selected in the
target segment.

4. (Optional) Click Previous Tag or Next Tag to select another tag and repeat the process.

MANAGE TAGS

Copy All Tags

@ Use Preferences > General Preferences > Tags to configure tags as full-sized or shortened.

To copy all tags:
1. Inthe TXLF Editor view, open a file.
2. On the Edit tab, click Copy All Tags.

All copied tags display at the location of the cursor. Reorder them to mimic the source content order
using the drag-and-drop or copy-and-paste technique.

m Edit Segment Tranalation Terminology Review

a kR B B M

Undo  Fe=da Find/  CopyAl | ClearAll | Show Whitszpacs
Raplacs Tags Tags Characters

3. Select Segment or Document from the drop-down menu.

Segment or Alt+A Select to copy only the tags for the selected segment to the target.

Document or Alt-Shift+P Select to copy all tags for the entire document.

All tags are copied to the segment or document.



MANAGE TAGS

Edit a Tag

Most tags in your target content have specific formatting and indentation settings copied from the source. You can
modify tags to change content format in the translated file.

A Do not edit tags in the source segment.

To edit a tag:
1. Open a translation file.
2. Inthe TXLF Editor view, select a tag in a target segment.

3. Choose one of the following actions:
e On the Translation tab, click Edit Tag.

File Edit Formatting Tranglation Terminology Review ? A X

E BB RB B BRE B BRE

Mext Previous Commit Leverage Mark All Merge Split Previous Mext Copy Edit
Segment Segment Translated Source Tag Tag Tag Tag

e Right-click the tag and select Edit Tag from the drop-down menu.
4. On the Edit Tag dialog, modify the tag.

A Verify that all tag edits are valid. Otherwise, the file could become corrupt.

[Edit Tag x
W You can edit tag content below. Note: Adding
invalid edits can corrupt the file on cleanup.
=ffontFormai=
OK Cancel
5. Click OK.

Edits to the tag are saved.



MANAGE TAGS

Clear All Tags

@ Use Preferences > General Preferences > Tags to configure tags as full-sized or shortened.

To clear all tags:
1. Open afile.
2. In the TXLF Editor view, on the Edit tab, click Clear All Tags.

3. Select Segment or Document.

Segment or Ctrl-Shift+V  Select to clear only the tags from the selected segment.

Document Select to clear all segment tags for all target segments in the file.

A warning message asks you to agree to clear all tags from the open file.

4. Click Yes.

All tags are cleared for the target segment or for all target segments in the document.

MANAGE TAGS

Delete a Tag

You may choose to delete target tags, particularly if there are multiple copies of the same tag in the same target

segment. You can only delete target segment tags.

To delete a tag:

1. Open a translation file.

2. Inthe TXLF Editor view, select a tag in a target segment.

3. Choose one of the following actions:
e Press Delete or Backspace.
e On the Edit tab, click Cut, then paste the tag elsewhere.
E Edit Formatting Translation Terminology Review
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Undao Redo Cut Copy Paste Find / Copy All - Clear All
Replace Tags Tags

@ To undo the change, click Undo or press Ctrl + Z.

The target tag is deleted.
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Revert
Source
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Show Whitespace
Characters
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Manage Project Notes

You can add notes that are specific to each segment during the translation and review process. If you have
chained files together, you can review all notes for all files in the chain.

Use the Notes tab on the Editor pane to view and manage project notes.

MANAGE PROJECT NOTES

View Notes

The Notes tab is on the Editor pane. Notes retain the same ID as the related segment.

@ Segments with notes include O in the Status column.

To view notes:

1. Open a translation file.

2. In the TXLF Editor view, click the Notes tab on the Editor Pane, then view note details for all file segments.

TM Lookup Motes Segment History Metadata Transcheck (0) + Terminology
Add Mote Edit Note Delete Mote Export Notes Search Glossaries (Source) = D x '):I'
D Date Details MADE SIMPLE
Translation 2018/08/27 Use Vereinfacht as the approved VEREINEACHT ®
16:30:54 MDT phrase for this project. MADE SIMPLE
EINFACH GEBILDET ®
SIMPLE
» EINFACH @

EN — DE | Segments: 24/33 | Segment (8rc/TgtMax): 26/34/- | Paragraph (Src/Tgt/Max): 26/34/- _Ieft]n

Notes for all file segments are displayed.

MANAGE PROJECT NOTES

Add a Note

To add a note:
1. Open a translation file.

2. In the TXLF Editor view, select a segment.



3. Choose one of the following actions:
e Click the Notes tab on the Editor pane, then click Add Note.

TM Lookup Notes Segment History Metadata Transcheck (0) -
Add Note Edit Note Delete Note Export Notes

ID | CreatorlD Type Date Details

13 Submitter |Review 2018/06/04 Check for correctness. M
13:19:02 MDT

13 Submitter |Question 2018/06/04 Are you treating "internal translator”
13:19:21 MDT as a single phrase for DE?

4 3

EN — DE-DE | 8egments: 29/33 | Segment (Src/TgtMax): 83/83~ | Par

o On the Review tab, click Add Note, or right click on the target segment and select Add Note to open Add/
Edit Notes dialog.

File Edit Formatting Translation Terminology
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Spellcheck File Mark Spelling Add Mote Edit Mote Delete Note Export Motes Transcheck Transcheck
Errors Segment All

4. On the Add/Edit Notes dialog, select a Type from the drop-down list.

W Use this pags to add or edit a note.

Segment ID: 113

Source: Allow access to any vendor or internal franslator
for maximum resource flexibility.

Creator:” |5ubmiﬂer |

Date: |2018/06/04 13:10:38 MDT |

Type: -

Review

Quesfion
Impaortant

Translation

OK Cancel

@ The selected note Type is saved for the next time Wordfast is run.



Type

Description

Translation Select to include data for the reviewer from the translator.

Review Select to includes data for the translator from the reviewer.
Question Select to solicit a response about the segment from a user.
Important Select to flag the data for the segment as a priority for other users.

5. Enter the information in the note field.
6. Click OK.

The note is saved and associated with the segment.

MANAGE PROJECT NOTES

Edit a Note

To edit a note:
1. Open a translation file.
2. In the TXLF Editor view, select a segment with a note.

3. Choose one of the following actions:
e Click the Notes tab on the Editor pane, then click Edit Note.

-

TM Lookup Notes Segment History Metadata Transcheck (0)

Add Note Edit Note Delete Note Export Notes
ID | CreatorlD Type Date Details
3 Submitter |Review |2018/06/04 Check for correctness. b
13:19:02 MDT

3 Submitter |Question 2018/06/04 Are you treating "internal translator”
13:19:21 MDT |as a single phrase for DE?

3

EN — DE-DE Segments: 29/33 | S8egment (Src/Tgt/Max): 83/83/- @ Par

e On the Review tab, click Edit Note.

File Edit Formatting Translation Terminology Review _
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Spellcheck File Mark Spelling Add Mote Edit Note Delete Note
Errars

4. On the Add/Edit Notes dialog, edit the note.

B

Export Notes



Add/Edit Notes x

W Uss thiz pagse to add or sdit a nots.
Segment ID: 13 |
Source: Allow access to any vendor or internal translator
for maximum resource flexibility.

Creator:™ | Submitter |
Date: |2018/06/04 13:19:02 MDT |
Type: |Reuiew - |
Check for comeciness.

OK Cancel

5. Click OK.

The modified note is saved and associated with the segment.

MANAGE PROJECT NOTES
Delete a Note

To delete a note:
1. Open a translation file.

2. In the TXLF Editor view, select a segment with a note.



3. Choose one of the following actions:

e Click the Notes tab on the Editor pane, then click Delete Note.

TM Lookup Notes Segment History Metadata  Transcheck (0) -
Add Note Edit Note Delete Note Export Notes
ID | CreatorlD Type Date Details
3 Submitter |Review 2018/06/04 Check for correctness. M
13:19:02 MDT

Submitter |Question 2018/06/04 Are you treating "internal translator”
13:19:21 MDT as a single phrase for DE?

4 3
EN — DE-DE Segments: 29/33 Segment (Src/Tgt/Max): 33/83/-  Par

e On the Review tab, click Delete Note.

File Edit Formatting Translation Terminology
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Spellcheck File Mark Spelling Add Mote Edit Mote Delete Note Export Motes Transcheck Transcheck
Errors Segment All

The note is no longer attached to the segment. If there are no other notes, the notes icon is removed from the
Status column for the segment.

MANAGE PROJECT NOTES

Export Notes

To export notes:

1. Open a translation file.



2. In TXLF Editor, choose one of the following actions:

e Click the Notes tab on the Editor pane, then click Export Note.

-

TM Lookup Notes Segment History Metadata Transcheck (0)

Add Note Edit Note Delete Note Export Notes
ID | CreatorlD Type Date Details
Submitter |Review |2018/06/04 Check for correctness. b
13:19:02 MDT

Submitter |Question 2018/06/04 Are you treating "internal translator”
13:19:21 MDT |as a single phrase for DE?

3
EN — DE-DE Segments: 29/33 | S8egment (Src/Tgt/Max): 83/83/- @ Par

e On the Review tab, click Export Notes.

File Edit Formatting Translation Terminology Review
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Spellcheck File Mark Spelling Add Mote Edit Mote Delete Note Export Motes Transcheck Transcheck
Errors Segment All
e Right-click the segment and click Export Notes.
3. On the Export Notes dialog, browse and select a location for the exported notes file.
4. Enter a file name and click Save.

All notes for the open file are saved in the selected folder location as a table in either MS Word or HTML file
format.

Use Transcheck

You can use Transcheck to scan translated content for non-linguistic errors such as missing tags, empty targets,

numbers, and terminology within target segments. @ is displayed in the Status column for segments with errors.

@ To enable Transcheck and customize Transcheck options, configure in Preferences > New Project
Preferences.

USE TRANSCHECK

Use Transcheck During Translation

After you have configured Transcheck options, you can begin using Transcheck when you translate a segment
and commit to the TM. You can also use the Transcheck segments while translating Transcheck configuration
option to check for errors during the translation process.

To use Transcheck during translation:

1. Inthe TXLF Editor view, click a segment and complete your translation of that segment.



2.

Click Next Segment or press Alt+Down Arrow to update the TM, move down one segment, and leverage the
next segment from the TM.

. (Optional) If Transcheck identifies an error in the segment, it posts a warning message. Choose one of the

following actions:

e Click Go back to fix issue to correct the error.

e Click Continue to continue translating without changes.
If you choose to correct the error, @ is removed from the Status column and from the Transcheck tab.

If you do not correct the error, ® remains in the Status column and on the Transcheck tab.

USE TRANSCHECK
Use Transcheck All

Use Transcheck All to scan all segments of a file for non-linguistic errors in the target segments and issue
warnings for missing and incorrect text. Configure and enable your Transcheck preferences under Preferences >
Current Project Preferences > Transcheck.

Use the Transcheck All option before you complete a file.

To use Transcheck All:

1.

2.

In the TXLF Editor view, finish translation of all segments in a file.
Click the Review tab, then click Transcheck All.

Fiile Edit Formatting Translation Terminoclogy Review
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Spelicheck File Mark Spelling Add Note Edit Mote Delete Hote Export Notes Transcheck Transcheck
Ermrors Segment All

A Transcheck report and summary result.
Review the warnings on the Transcheck Summary dialog, then click OK.

(Optional) On the Transcheck Report, determine the terminology errors you want Transcheck to ignore from
highlighted terms in the Terminology Check report section.

To best optimize the Transcheck Report, you can configure Transcheck to ignore highlighted terms
you identify under conditions you specify. The terms and conditions you select are in the Ignored
Terminology Errors section of the report.



Il

Report is optimized for Google Chrome, some features might not work well in your current browser.

Project TransCheck Report
Report Summary (1 files)

File Name Errars in file {visible highlights)

PO_en-de.docx, txdf 0

Ignored Terminology Errors

I:r-r-r |I Action " Condition Ill':.':l'r,-*'. I

Highlight: 1 Exact Match B Fuzzy mMatch| B Exact (No match) |Fuzzy (No match)

| Toggla Global Search Filters | Global search filter is OFF

Project TransCheck Report - Wordfastl - English - German
Report Summary (1 file)

TransCheck ran successfully on 1 file and found 39 errors.
Target Consistency Check ran successfully with 0 errors.
Source Consistency Check ran successfully with 0 errors.

File Mamea Total Number of Errors

PD_an-de.docx. ktxIf 20
PD_en-de.docx. txif

Empty Target Check 0

Edited Source Check 0

Capitalization Check 0
Iunedited Fuzzy Check 11
Medited Exact Check 3
Elspelling Check 16
ElTag Check 5
whitespace Check 4

Repeated Words Check 0

Unedited Fuzzy Check

Block Source Target Score Comment

& 1-6-1 | ACCESS REAL-TIME DATA ZUGRIFF ALF 75% Target contains a

. (Optional) Click a highlighted term.

. (Optional) On the Ignore Terminology Transcheck Error dialog, compare the source string with the target
equivalents.

. (Optional) Select either When term is for source terms in the glossary or When target contains for target
terms.



Ignore Terminology Transcheck Error X

Source string: =irea w
I >
®  Whentermis streamline(eine Stromlinienform
[StraamlinalOntimierunnl
When Target
O Contains:
lgnore Ignore All (3) Mext

8. (Optional) Either click Ignore to disregard the single instance of a string or Ignore All to disregard every
instance of a string.

@ The number following Ignore All contains the total number of instances within that file.

Ignore Terminoclogy Transcheck Error x

Source string:

C o Whentems - yansiaton process

When Target Ubersetzungsprozess
@ Contains:

Ignore All (3) Previous Next

9. (Optional) Review the terms in the Ignored Terminology Errors section of the Transcheck report.




transcheckReport5481583249647184112.html 16

Ignored Terminology Errors

Error IAL‘E:OH I(;ondlt:on II Instances I

translation process was translation process 1
ignored (Ubersetzungsprozess)
when
term is:

enterprise was ENTERPRISE 3
ignored (BERICHTERSTELLUNG)
when
term is

VENDOR was VENDOR(ANBIETER) 1
ignored
when

term is:

Highlight: &1/ Exact Match| F1|Fuzzy Match| F1|Exact (No Match)| 1|Fuzzy(No Match))|

Terminology Check:
transcheckReport5481583249647184112._html

Hide this report

Source Target Comment

3 1-3-1 STREAMLINE @ EFFEKTIVES Incorrect terminology:
PROJECT PROJEKTMANAGEMENT  streamline (eine
MANAGEMENT Stromlinienform geben),

STREAMLINE

fADTTMTED EMY

10. (Optional) After closing the Transcheck report, select any remaining segments with @ in the Status column.



"Sampled_Sample-File_en-de-PK_Word_TX1 F-dedTR_Q# docx X

Fa

Siource or Target v | | Match Cses | | Regex Enter text to fiter segmer «  Filter: Select special filter(s)...  « O 0 X son )
D English German | 8core | Siatus |

GloballLink-Project-Director-saves- Mit-GlobalLink - Project-Director-sparen -

organizations-millions -of -dollars - by - Organisationen -aufgrund -der-

7 |automating -management-of -localization- automatischen -Verwaltung-von- 6% o

processes -and -resources. Lokalisierungsprozessen -und --
ressourcen - Millionen |

BrSEAMLESS-DATABASE - NAHTLOSE-

INTEGRATION- @ DATENBANKINTEGRATION

Use-GlobalLlink-Connect-with-any -CMS, - GlobalLink - Connect -funktioniert - mit- -

-

TH Lookup Notea Segment History Metadata Transcheck (1) + Terminology!

¥ More Options ~  Find Sourcs | | Sesrch Glossaries (Source) * O X 2

# | Source
1 |GlobalLink Project Director saves organizations millions of doll: =

by automating [ management of localization processes and

-
recnlimreas
4 b

® EN—DE | Segments: 32/24 | Sagment {Src/TgtMax): 1331465 | Paragraph (Src/TgtMax): 1331148/ _

11. (Optional) Click the Transcheck tab to examine the details of the segment error.

@ The total number of errors in the segment is the number in parentheses on the Transcheck tab.

TM Lookup Notes Segment History Metadata Transcheck (3)
Previous error Next error Refresh Ignore warning
# Warning Explanation Cause
1 | Tag Check Source contains Source contains "1, 2,
formatting missing in 3" which is missing in
the target. target.
2 | Unedited Fuzzy Target contains a Target contains a 98%
Check fuzzy match that has match that has not
not been modified. been modified.
3 Untranslated Text | Source text is not -
. in" should be
Check translated in the .
translated in target.
target.

12. (Optional) Click Next error or Previous error on the Transcheck tab to view the next or prior segment error.

13. Choose one of the following actions:

e Correct the error and click Refresh to complete the correction.

e Click Ignore warning to continue reviewing error warnings without making any changes.
If you correct the error, @ is removed from the Status column.

If you do not correct the error, @ remains in the Status column.




Leverage Auto-Propagation

The purpose of auto-propagation is to leverage repetitive segments and re-use content. Configure and enable
your auto-propagation preferences under Preferences > General Preferences > Auto-Propagation.

To leverage repetitive content:

1. Select a segment for translation in the TXLF Editor. In this example, a filtered search locates and identifies
duplicate segments.

*SBampled_Sample-File_en-de.docx *  "Bample2_Sample-File_en-de.docx " |

Source or Target - Match Case Regex |Enter lexl to filer segme ~ | Filter: | Duplicale segments - D ;U-' » Sor }
D English => German Score Status

View virtually any set of data points in real time to gauge translation

efficiency.
28|_ : ; - - . 100+%

Zeigen Sie praktisch alle Datenpunkte in Echtzeit an, um die

Ubersetzungseffizienz zu messen.

THOUSANDS OF ORGANIZATIONS TRUST GLOBALLINK TO STREAMLINE

29 CONTENT MANAGEMENT
100+%
TAUSENDE VON ORGANISATIONEN VERTRAUEN BEIM OPTIMIEREN ’

IHRES GLOBALEN CONTENT MANAGEMENTS AUF GLOBALLINK
THOUSANDS OF ORGANIZATIONS TRUST GLOBALLINK TC STREAMLINE
30 CONTENT MANAGEMENT 100+%
TAUSENDE VON ORGANISATIONEN VERTRAUEN BEIM OPTIMIEREN -

.

2. Enter the translation for the first target segment.

3. Choose one of the following actions:

o Click Next Segment or press Alt+Down to update the TM, move down one segment, and leverage the
next segment from the TM.

o Click Commit or Commit All to commit one or all of the segments to the TM.



Once you commit the target segment, this action automatically propagates the TM updates to duplicate
segments throughout the file, based on segment preferences.

*Sampled_Sample-File_en-de.docx *  "Sample?_Sample-File_en-de.docx "‘ N

Source or Target - Match Case Regex |Enler lext lo filer segme ~ | Filer: | Duplicale segmenis - | @) ﬂ' »  Sor }

D English -> German Score Status

View virtually any set of data points in real time to gauge translation

efficiency.
28 _ _ . . . - 100+%
Zeigen Sie praktisch alle Datenpunkte in Echtzeit an, um die

Ubersetzungseffizienz zu messen.
THOUSANDS OF ORGANIZATIONS TRUST GLOBALLINK TO STREAMLINE
CONTENT MANAGEMENT]|

29
TAUSENDE VON ORGANISATIONEN VERTRAUEN BEIM OPTIMIEREN e

IHRES GLOBALEN CONTENT MANAGEMENTS AUF GLOBALLINK
THOUSANDS OF ORGANIZATIONS TRUST GLOBALLINK TO STREAMLINE
30 CONTENT MANAGEMENT 100+%
TAUSENDE VON ORGANISATIONEN VERTRAUEN BEIM OPTIMIEREN .

F

Leverage Auto-Suggestion

You can use autosuggestion to propose target content based on specific source content, such as numbers, URLs,
and proper names. You can also use it to propose terms for the glossary, translation memory (TM) matches, and
sub-segment TM matches. Configure and enable your autosuggestion preferences under Preferences > General
Preferences > Auto-Suggestion.

Monitor Maximum Segment Length

Based on Project Director (PD) settings, your files may have a set maximum segment length. Any violation of
a segment that exceeds the maximum characters allowed results in a change to the segment Max value in the
progress bar from black to red.

Users can monitor the progress bar for maximum segment length violations, and can also configure the
Transcheck Report to flag such violations. Refer to Configure Transcheck.

Get an MS Word Table

You can preview and save the file you have open for translation as a bilingual table in MS Word format.
To get an MS Word table:
1. Inthe TXLF Editor view, select a file with translated content.

2. On the File tab, click Get MS Word Table.



Edit Formatting Tranglation Terminology Review

B B B B B B B a2 B B

Close Recalculate Get M5 Word Open Source Switch Editor - Preview Preview - Save File As Save Save As
Progress Table File Layaout File Translated

3. On the Get MS Word Table dialog, click Get MS Word Table.

@ You can configure MS Word Table settings by clicking the hyperlink to the Preferences location. If
you want to disable the dialog, select Don't show this dialog anymore. If you need to re-enable
the warning dialog, select Show dialog to configure MS Word Table Preferences from General
Preferences > Warnings.

The file downloads as a Microsoft Word document containing a bilingual table of source and target segments.

E IH - (0 = word_preview 1592495237586502499 doc [Compatib., TaeleTo.. 7 0 — [0 X
HO INSE Spell DESI PAGE REFE MAIL REVI VIEW PDF ACR DESIGN LAYOUT LaniZi.. -

. B [ | 1 | 3 ] 4 0~
WARNING: This bilingual document is for review only,

any modification done to target cannot be imported
back in Wordfast bilingual format

. AdaptiveTranscheck.docx.txIf

ID | English () German (Germany) | Score
| TRANSLATION UBERSETZUNGSM | 100
MANAGEMENT. ANAGEMENT.
2 MADE SIMPLE. VEREINFACHT. 99
3 STREAMLINE EFFEKTIVES 100
) PROJECT PROJEKTMANAGE .

PAGE1OFS8 1236 WORDS [[® GERMAN [GERMANY) E B B ————+ 14

4. (Optional) Review the resulting file for completeness.

Preview a File

Use Preview to display the source content in its original format, such MS Office and HTML source formats.
To preview files:
1. Open a file in the TXLF Editor view.

2. Onthe File tab, click Preview, then select a preview type on the drop-down list.

Edit Formatting Translation Terminology Review

B B B B B R 2 B

Close Recalculate Get MS Word Open Source Switch Editor Preview Save File As Save Save As
Progress Table File Layaout Translated

The preview of the source content is displayed in its original format.



Use Live Preview

You can view the translated content in its original format for MS Word .DOC and .DOCX files or MS
PowerPoint .PPT and .PPTX files.

Use the default Live Preview to generate a dynamic preview of the translated file in TXLF Editor view.

@ To configure and enable the Live Preview preference under General Preferences > General, select
Automatically open Live preview for supported files.

To generate a live preview:
1. Open afile in the TXLF Editor view.

2. On the File tab, select Live Preview from the Preview drop-down menu.

@ Only one preview option is possible at a time.

Edit Formatiing Translation Terminology Review

B B B B B R B B B

e Recalculate Get MS Word Open Source Switch Editor = Preview - Save File As Save Save As
Progress Table File Layaout Translated

Fi
C

3. (Optional) Interact with the live preview of the file.

For MS Word files ¥ D>

The preview pane docks to the right. Click £ for Wol’dfa StPl’O 5

docking options. Live Preview highlights the active
segment. Move to any other segment by clicking on
that area of the live preview.

Wordfast Pro 5 is our latest standalone, multi-platform TM
tool designed to address the needs of translators, language
service providers and multinational corporations.

+  Cross-Platform Compatibility
Wordfast Pro & is the only major commercial TM tool on the
market that runs natively on Windows, Mac, and Linux.

«  WYSIWYG Interface
Wordfast Pro 5 offers users the ability to choose either a tag
mark-up editor or WYSIWIG (what you see is what you get)
editor based on personal preference. Proficiency is made
virtually instantaneous by offering users customizable shortcut

Lemus bindinoe ineloding mes conficnrnd chockeot oo mnane fae all



For MS PowerPoint files ¥ Whole docu...  Loadedpag... 4 Page: ENIl 9 » + 28>
PowerPoint files can be graphically intensive and so

may take time to load. The progress bar provides WordfastPro 5

real-time loading status. Click x to cancel the Live Wordfast Pro 5 st unser neuestes cigenstindiges, lattormibergreiendes ThTool,

P review_ das speziell auf die Bediirfnisse von Ubersetzern, Sprachdienstleistern und
multinationalen Unternehmen zugeschnitten ist..

e Docking—The preview pane docks to the
right. Click E1 for docking options. Live Preview
highlights the active segment. Move to any
other segment by clicking that area of the live
preview.

¢ Slide Access—Click the forward or back arrow
to progress through the slide deck or type the
deck slide number in the Page field. To return

to the first slide in the deck, click E.

Enter the translation or leverage the TM for any segment.

. On the Translation tab, click Next Segment or press Alt+Down Arrow to update the TM, move down one

segment, and leverage the next segment from the TM.

The new translation is displayed. To collapse or expand the live preview pane, click E or @. To zoom in and out

of the live preview pane, select a percentage in the zoom drop-down list | 100% =],

(Optional) Click Synchronize Live Preview button to refresh the preview.

Save a File

As you work on a file, frequently save your changes to a local folder .

To save a file:

1.
2.

Click the File tab, if you are not already on it.
In TXLF Editor view, click either Save or a Save Options action.

File Edit Formatting Tranglation Terminology Review

B B B B B e B B B BE

Close Recalculate Get MS Word Open Source Switch Editor  © Preview Preview Save File As Save Save As
Progress Table File Layout File Translated

Save File As Translated Select to save the translated file to a local folder.
Save Select to save the .TXLF file to a local folder with the existing filename.

Save As Select to save the .TXLF file to a local folder under a different name.

A progress bar is displayed. After successful completion, the file is updated in a local folder.



/. Leverage Project TMs

A translation memory (TM) provides maximum content re-use and facilitates collaboration among localization
resources. Users can leverage reusable content using one of two different types of TMs.

Consider using a free, hosted service: WordFast Anywhere (WFA). WFA allows translators to connect
to a shared server and interact with a private, remote TM and glossary.

Local TM Located on your local computer system and only you can access it.
Remote TM Located on a server that other translators can access. This allows multiple

translators to leverage the available content and update the TM with new reusable
content.

@ You can remove a TM from a project so it is no longer in the project TM list. When you remove a local
TM from a project, it remains in the TM folder on your computer system. To add a removed local TM
back to the project, use the Add Local action on the Project TM tab. To add a removed remote TM
to the project, use the Connect to Remote action on the Project TM tab.

Create a Local TM

Create a local translation memory (TM) for quick, local access. If it is possible you may need to share your TM
with other users, connect to a free, hosted service: Wordfast Anywhere (WFA). Refer to Connect to a Remote

Glossary.

To create a local TM:

1. Inthe Project List view, on the Projects tab, select a project from the projects list to open it.
2. Onthe Project TM tab, click Create Local.

Project Files Project TM Project Terminology Reporis Reference Files

= S0 = W e S =t = 9
Create Add Add Connect Open Modify Copy Import Export Remawve
Local Local Project Ths To Remote ™ ™ ™ ™ ™ TM

3. On the Translation Memory dialog, enter the required TM configuration.

@ Required fields are marked with a red asterisk.



Translation Memory

W Create Translation Memory

Name:™* |

Target Language:* German -

Location:™ Browse...

Priority:* Secondary -

| Selected

Read-only
oK Cancel

Field Action
Name Enter a unique TM name that includes the client or organization name and the

TM's language for easy identification.

Target Language

Select target languages. Target languages are limited to those languages
configured in the project.

Location Select the destination where the application saves the new TM.
Priority Set the TM sequence used during translation, using the Primary TM first,
followed by any Secondary TMs.
Note: You can only select one TM as primary.
Selected (Optional) Select to use the current TM for the project.
Read-Only (Optional) Select to leverage the TM without updating it with the new translation.
4. Click OK.

The new TM is created and is displayed in the Project TM list.

Add a Local TM to a Project

You can add a local TM to your project at the time of creation or as a separate action.

You can add TMs created by Wordfast Pro 4 or 5 only. If you want to add TMs from Wordfast Classic
or Wordfast Pro 3, use the Import TM option.

To add a local TM to a project:

1. On the Projects tab, double-click a project from the projects list.

2. Click the Project TM tab, then click Add Local.



Project Files Project TM Project Terminology Reporis Reference Files

== =0 W @ S = =
Create Add Add Connect Open Muodify Copy Import Export Remave
Local Local Project TMs Tao Remote ™ ™ ™ ™ ™ T™

3. On the Opening TM dialog, browse to the local TM folder and select it.
4. Click Select Folder.

The selected TM is added to the project and displayed in the Project TM list.

Add Project TMs

Some projects may use multiple local and remote translation memories (TMs). In such instances, it is more
efficient to add all of the TMs for the project with a single Add Project TMs action.

To add project TMs:
1. In Project List view, on the Projects tab, double-click a project from the projects list.
2. On the Project TM tab, click Add Project TMs.

Project Files Project TM Project Terminology Reporis Reference Files

= e = W S S = - =
Create Add Add Connect Open Modify Copy Import Export Remove
Lecal Local Project ThMs To Remote T™ ™ ™ ™ ™ ™
3. On the Add Project TMs dialog, enter the project TM information.
- Select a Project containing TMs you would like to
add
Select a Project:” AdaptiveTranschack1 b
Source Language: | English
Target Language(s): German (Gemany)
List of TMs: German_DE, Adaptive Transcheck-German
oK Cancel
Field Action
Select a Project Select a project name from the drop-down list.
Source Language Leave the auto-populated source language.

Target Language(s) Leave the auto-populated target languages.




Field Action

List of TMs Review the list of TMs associated with that project.

4. Click OK.

The selected project TMs are added to the project and are displayed in the Project TM list.

Connect to a Remote TM

You can connect to one or more translation memories (TMs) on other computers, including a free, hosted
service:, such as Wordfast Anywhere (WFA).

WFA allows translators to connect to a shared server and interact with a private, remote TM and
glossary.

To connect to a remote TM:

1. On the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, and on the Project TM tab, click Connect To Remote.

Project Files Project TM Project Terminology Reports Reference Files

= .o = W N@ S 2 TR
Create Add Add Connect Open Modify Copy Import Export Remave
Local Local Project TMs To Remoie TM ™ ™ ™ ™ ™

3. On the Connect to Remote TM dialog, select the appropriate tab, based on your server options.

e TM Server
o WF Server
e WFA Server

4. (Optional) Add a TM Server on the TM Server tab, complete the required fields, then click OK.

Required fields are marked with a red asterisk.



W Uss this page to connect to remote Th.

TM Server WF Server

WFA Server

Symbolic Name:”

URL Estting=

URL"

Address”

Part:

TMS Falder:”
Cluster Short Code:"
TM Short Code:”
User:”

Password:"

Workgroup 1D:

TM Update Ssttings

TM Cleanug Passcode:

Priority:
| Selscted

Read-only

Field or Option

example: im:/addressport TMS *im=LE{ Test

Primary -

0K Cancel

Action

Symbolic Name

Enter a unique name for the TM.

URL

Enter the remote TM URL using the following format: t m / / addr ess: port/
TMS?. The remaining URL Settings automatically populate when you enter the
URL string. Click Test to validate the connection.

TM Cleanup Passcode

Enter the password to update the TM for the project.

Priority Select a priority from the drop-down list.
The priority determines the sequence of reference during translation, first
referencing the primary TM, then any secondary TMs. You can only designate
one TM as primary.

Selected (Optional) Select to use the current TM for the project.

Read-only (Optional) Select to leverage the TM without updating it with the new translation.

5. (Optional) Add a WF Server on the WF Server tab, complete the required fields, then click OK.

Required fields are marked with a red asterisk.



W Use this pags to connect to remote Th.

TM Server WF Server

Symbaolic Name:™
URL Esttings
AL
Address”
Part:”
Account Mame:”
Account Password:

Workgroup 1D:

P and TM admin

Use TM {Write) Password

Priority:
| Selected

Read-only

Field or Option

WFA Server

Sample_TM

example: wiljemith:password@address Test

Primary -

0K Cancel

Action

Name Enter a unique name for the TM.

URL Enter the remote TM URL using the following format: wf : / /
j smth. passwor d@ddr ess: port/ TMS?. The remaining URL Settings
automatically populate when you enter the URL string.
(Optional) The Password and Workgroup ID fields depend on server settings.
Click Test to validate the connection.

Address Enter the address associated with the URL.

Port Enter the port associated with the URL.

Account Name

Enter the username associated with the URL log in.

Account Password

(Optional) Enter the password associated with the username.

Workgroup ID

(Optional) Enter the workgroup ID for the project.

Use TM (Write)
Password

Enable, if you are a PM or TM Administrator, to require a password to overwrite
the existing TM with new translations.




Field or Option Action

TM (Write) Password If enabled, enter the password to overwrite the existing TM with new translations.
Selected (Optional) Select to use the current TM for the project.
Read-only (Optional) Select to leverage the TM without updating it with the new translation.

6. (Optional) Add a WFA Server on the WFA Server tab, complete the required fields, then click OK.

Required fields are marked with a red asterisk.

W Use this page to connect to remote TM.

TM Server WF Server WFA Serve
Symbolic Name:” WordFast Anywhere Adaptive Test
APl key:" Test
Priority: Primary -
W Selected
Read-only
0K Cancel
Field or Option Action
Symbolic Name Enter a unique name for the TM.
API key Enter the API key you obtain from WFA.
1. Login to your free WFA account at ht t ps: / / www. freet m com
2. Click TMs & Glossaries, then Setup.
3. On the TMs and glossaries management dialog, select a TM or glossary.
4. Click Manage Sharing.
5. On the TMs and glossaries shares dialog, click the API key and copy the

text string.

6. Paste the API key into the Connect to Remote TM dialog using the
following format: user nanme @ 234567, then click Test to validate the
connection.

Priority Select a priority from the drop-down list.
The priority determines the sequence of reference during translation, first
referencing the primary TM, then any secondary TMs. You can only designate
one TM as primary.

Selected (Optional) Select to use the current TM for the project.

Read-only (Optional) Select to leverage the TM without updating it with the new translation.

The new TM is added to the project and is displayed in the project TM list.



Open and Edit a Local TM

You can open and edit local translation memory (TM) entries at any time after TM creation.
A You cannot open a remote TM in TM Editor.

To open and edit a local TM:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.
2. On the Project TM tab, select a translation memory and click Open TM.

Reference Files

Project Files

Project TM Project Terminology Reporis

S 8 &8 & & & 8 & 8 &
Create Acdd Add Connect Open Modify Copy Import Export Remove:
Lacal Local Project TMs To Remote ™ ™ ™ ™ ™ ™

3. On the TM Editor tab, view the translation units (TUs) for both source and target languages.

T™ Editor
P | = 0 - ™
oo % b B B 5B B [
Mext Previous Cwt  Copy  Paste  DeleteTU Export | Previous Copy  Mext
Update Update Filerad Tag Tag Tag
_ D Souroce Target Creation U... Creation Date | Modific...
i Medal Jweite KOINAI  2012/08/0 | KOIN
Madness Gewinncha i) Al
Source and Iargr.l - .
Second nce bei der 09:29:19
TU Texi:
) Chance Medaillenja MDT
Enter TU Text R .
Giveaway — | gd - Sie
| Maich Case You can still kénnen
(] Exact Match win! immer
TU Creation User noc—h
Enter TU Creation Useér gewinnen!
TU Creation Date: | | J |
Fram: We hope Wir hoffen, | KOINAI | 2012/08/0 | KOIN
1] you're Sie haben 6 Al
Ta: enjoying the  genauso 09:29:20
] 2 Olympics as | viel Spal MDT
TU Modiification User: much as we @ an den
_Eniel TU Modificafion User arel OIYmDBChe
TU Modification Date: n Spielen
From: wie wirl
. - BEfAs some  EEWie KOINAI | 2012/08/0 | KOIN
[+}
— of you have einige von 8 Al
noticed, lhnen 09:29:20
because of sicher MDT
OFind X Clear the way the | bemerkt

2012/08/ =
06

09:29:19

MDT

2012/08/

06
09:29:20
MDT

2012/08/

06
09:29:20
MDT

Translation Units: 5266




4. (Optional) To search for source or target translation units (TUs), enter your search criteria in the appropriate
fields in the Filters sidebar, then click Find.

You can make your filtered search case-sensitive or specify an exact match, then filter further by
creator, user, and modification date.

5. (Optional) To reset your search criteria, click Clear.

6. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste to edit a TM entry.

Modify a TM

To rename, write-protect, or change the priority of a TM, use the Modify TM action.

To modify a local or remote TM:

1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.
2. On the Project TM tab, click a TM.

3. Click Modify TM.
Project TM Project Terminology Reporis Reference Files
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4. On the Connect to Remote TM dialog, modify the details for your connection. Based on your selection, other
fields auto-populate. Refer to Connect to a Remote TM.

@ You can only select one primary TM for a project.

Required fields are marked with a red asterisk.



W Use this page to connect to remote TM.

TM Server
Symbolic Nama:* Sample_TMS_DE-de
URL Seftings
URL:* trns: - = s COM/TMS? Test
Address:" ° . com
Paort:
TMS Folder:* ™S
Cluster Short Code:* GROO000003
TM Short Code:” LTMO0000S
User:” LTM-en-de
Password:* o
Workgroup 10:

TM Update Settings

TM Cleanup Passcode:

Priority: Primary -
W Selected
Read-only
oK Cancel

5. (Optional) Select the TM identified in the Name field for the current project using Selected.
6. (Optional) Select Read-only to allow users to leverage the TM but not update it with new translation.
7. Click OK.

Your modifications to the TM are saved.
Copy a Local TM
Copy a TM to use an existing TM for a new project.
@ The copied TM is in the Wordfast Pro TM format, regardless of the original TM format.

To copy a local translation memory:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. On the Project TM tab, select a translation memory and click Copy TM.



Project Files Project Terminology Reports Reference Files
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3. On the Copy Translation Memory dialog, enter the TM Name.

@ Required fields are marked with a red asterisk.

e Create acopy of the selected transiation memory. Please enter a name for
the copy, location, and decide if you want to flip the TM languages.

Source TM: Doc_TM1

Mame:* | |

Location:* | | Browse...

Flip Languages

Copy Cancel

4. Browse and select the Location on your disk for the TM copy.
5. (Optional) Select Flip Languages, to reverse the source and target languages, then click Copy.

A copy of the translation memory is saved in the selected folder location.

Import a Local TM

To use a local translation memory (TM) from another linguist, use the Import TM action.
To import a local TM:
1. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. Click Import TM on the Project TM tab.
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3. On the Import Translation Memory dialog, select the import File Type from the drop-down list.

Required fields are marked with a red asterisk.



W Import Translation Memory

File Type:" TMX -

Import File:™ C\Users\Deskiop\de-DE TM\TranscheckDE tmx Browse...
Create Mew TM

#) Import Into Existing TM

Existing Th:" -

If TU already exisis” Add as a new TU -

Delete all TUs from existing T

0K Cancel

Field Action

File Type Select an action from the drop-down list.
e TMX — Translation Memory eXchange file format provides compatibility
with all translation tools.

e WF TXT TM format (.txt) — File format provides backward compatibility
for Wordfast Classic and Wordfast Pro 3.

Import File Browse to select the file for import.
Create New TM Click to import the TM into a new TM file.
Import into Existing TM Click to import the TM into an available TM file, based on selection from the drop-
down list.
Existing TM Select an available TM file from the drop-down list.
If TU already exists Select a TM option from the drop-down list to import it into an available TM file.
Delete all TUs from Select to delete the existing TM and replace it with the new TM.
existing TM
4. Click OK.

The translation memory is imported and is displayed in the Project TM list.

Export a Local TM

To share a local translation memory (TM) with another linguist, use the Export TM action.
To export a local TM:
1. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. Select a TM assigned to that project.



3. Click Export TM on the Project TM tab.
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4. On the Export Translation Memory dialog, choose a location and export type for the TM export file.

@ Required fields are marked with a red asterisk.

- Specify existing Translation Memory for export, and
choose a location and export type for the TM
Translation EN_DE-de -
Memory:*
Export Type:* TMX -
File Location:* Browse...
OK Cancel
Translation Memory Select a TM from the drop-down list.
Export Type Select the export file type from the drop-down list.
File Location Browse and select the folder location for the export.
5. Click OK.

The selected translation memory exports to the selected folder location.



8. Leverage Project Terminology Lists

Terminology is a phrase used to identify two distinct groupings: the glossary and the blacklist.

¢ Glossary—A database of preferred source terms, words, and phrases paired with their target equivalents
designated as preferred and client-specific

¢ Blacklist—A database of rejected target terms prohibited from use in the translation

Leverage Project Glossaries

A glossary includes source terms and a correlated list of preferred target terms.

LEVERAGE PROJECT GLOSSARIES
Create a Local Glossary

To create a local glossary:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, on the Project Terminology tab, click Create Local.
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3. On the Create Glossary dialog, enter the glossary information.

W Create/Modify Glossary

Mame:* |

Target Language:* German -

Location:*® Browse...

| Selectad

Read-only

oK Cancel

@ Required fields are marked with a red asterisk.

Field Action

Name Enter a unique name for the glossary.

Source Language Do nothing, since the source language auto-populates.




Field Action

Target Language Select a language from the target languages available for your project in drop-
down list.
Location Browse and select the folder location for the new glossary.
Selected (Optional) Select to use the current local glossary for the project.
Read Only (Optional) Select to leverage the glossary without updating it with new terms.
4. Click OK.

The new glossary is displayed in the project glossary.

LEVERAGE PROJECT GLOSSARIES

Add a Local Glossary

You can only add glossaries created by Wordfast Pro 4 or 5. For glossaries from Wordfast Classic or Wordfast
Pro 3, use the Import Glossary action. Refer to Import a Local Glossary.

To add a local glossary:
1. In the Project List view, on the Projects tab, double-click a project from the projects list.
2. In the Current Project view, on the Project Terminology tab, click Add Local.
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3. On the Creating Glossary dialog, browse to a glossary folder and select it.
4. Click Select Folder.

The selected glossary is added to the project and is displayed in the project Glossaries list.

LEVERAGE PROJECT GLOSSARIES

Add Project Glossaries

Some projects may use multiple local and remote glossaries. In such instances, you can add all of the glossaries
from a previous project with a single Add Project Glossaries action.

To add project glossaries:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, on the Project Terminology tab, click Add Project Glossaries.
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3. Onthe Add Project Glossaries dialog, enter the project glossaries information.



- Select a Project containing Glossaries you would
like to add

Select a Project:* AdaptiveTranscheck1 b
Source Language: | English

Target Language(s): German (Gemany)

List of Glossaries: de-DE-TechDoc

OK Cancel
Field Action
Select a Project Select a project name from the drop-down list.
Source Language Leave the auto-populated source language, based on the project.
Target Language(s) Leave the auto-populated target languages, based on the project.
List of Glossaries Review the list of glossaries associated with that project.

4. Click OK.

The selected project glossaries are added to the project and displayed in the project Glossaries list.

LEVERAGE PROJECT GLOSSARIES

Connect to a Remote Glossary

You can connect to a glossary residing on another server, including a free hosted service, such as Wordfast
Anywhere (WFA).

@ WEFA allows translators to connect to a shared server and interact with a private, remote translation
memory (TM) and glossary.

To connect to a remote glossary:

1. On the Projects tab, double-click a project from the projects list.

2. On the Project Terminology tab, click Connect To Remote.
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3. On the Connect to Remote TM dialog, select the appropriate tab, based on your server options.



¢ TMGR Server
o WF Server
o WFA Server

4. (Optional) Add a Term Manager (TMGR) Server on the TMGR Server tab and complete the required fields.

@ Required fields are marked with a red asterisk.

TMGR Server WF Server WFA Server

Mame:"

Target Language:” German (Germany) -

URL Settings

URL:" example: imgr-/faddress:portimgr? Test
Address”

Username:”

Password:”

Project Short example: ABCOD00001, ABCO000002
Code”

| Selected
Read-only

W] Create Blacklist Connection

OK Cancel
Field or Option Action
Name Enter a unique name for the glossary.
Target Language Select a language from the drop-down list. This list is constrained by the available

target languages for your project.

URL Enter the remote glossary URL using the following format: t ngr: //
address: port/ TMGR?.

Note: The remaining URL Settings automatically populate when you enter the
URL string. This includes the username, password, and project short code.
Click Test to validate the connection.

Selected (Optional) Select to use the current glossary for the project.

Read-onl Optional) Select to leverage the glossary without updating new terms.
y 9 9 ry 9




Field or Option Action

Create Blacklist (Optional) Select to connect to an available blacklist already in TMGR.
Connection

5. (Optional) Add a WF Server on the WF Server tab and complete the required fields.

Required fields are marked with a red asterisk.

W Connsct To Remots Glossary

TMGR Server WF Server WFA Server

Name:” Sample_Glossary
URL Estting=s
URL:" example: wismith:password@ad Test
Address:”
Part:"

Account Name:"

Account Password:

Viorkgroup 1D:
| Selected
oK Cancel

Field or Option Action

Name Enter a unique name for the glossary.

URL Enter the remote glossary URL using the following format: wf : / /
j smith: passwor d@ddress: port/tngr?. The remaining URL Settings
automatically populate when you enter the URL string. Click Test to validate the
connection.

Address Enter the address associated with the URL.

Port Enter the port associated with the URL.

Account Name Enter the username associated with the URL log in.

Account Password (Optional) Enter the password associated with the username.

Workgroup ID (Optional) Enter the workgroup ID for the project.

Selected (Optional) Select to use the current glossary for the project.




Field or Option Action

Read-only (Optional) Select to leverage the glossary without updating new terms.

6. (Optional) Add a WFA Server on the WFA Server tab and complete the required fields.

W Connect To Remote Glossary

TMGR Server WF Server WFA Server

Name:" WordF ast Anywhere Adaptive Test

Target Language:~ German (Germany) -

APl KEY:" username@1234567 Test

Selected
] Read-anly
OK Cancel

Field or Option Action
Name Enter a unique name for the glossary.
Target Language Select a language from the drop-down list.

Note: This list is constrained by the available target languages for your project.

API KEY Enter the API key you obtain from WFA.

Log in to your free WFA account at ht t ps: // www. freet m com
Click on TMs & Glossaries, then Setup.

On the TMs and glossaries management dialog, select a glossary.
Click Manage Sharing.

ok wbd e

On the TMs and glossaries shares dialog, click on the API key and copy
the text string.

6. Paste the API key into the Connect to Remote Glossary dialog on the
WFA Server tab using the following format: user nane@234567, then
click Test to validate the connection.

Selected (Optional) Select to use the current glossary for the project.
Read-only (Optional) Select to leverage the glossary without updating new terms.
7. Click OK.

The selected glossary is added to the project and is displayed in the project Glossaries list.



LEVERAGE PROJECT GLOSSARIES

Open a Remote Glossary

You can open and view remote glossary entries at any time after the glossary is connected.
A You can only view the terms in a remote glossary. You cannot edit the glossary.

To open a remote glossary from the TXLF Editor view:
1. Inthe TXLF Editor view, on the Terminology tab, click Terminology List.

2. In the Project Glossaries dialog, do one of the following:

o Click a remote glossary location link.

e Select a remote glossary, the click Open.

Project Glossaries x
Name Location Read-o... | Active
3MCD00732_en-US_de-DE hitp tmgrs://stg-tmgri.translations.com/TM... v v
Manage Project Glossaries Open Close

3. (Optional) In the Currect Project view, on the Project Terminology tab, do one of the following:

e Click a remote glossary location link.

e Select a remote glossary, the click Open Glossary.

The remote glossary will open in your default browser.

LEVERAGE PROJECT GLOSSARIES
Open and Edit a Local Glossary

You can open and edit local glossary entries at any time after glossary creation.
To open and edit a local glossary:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, on the Project Terminology tab, select a local glossary, and click Open
Glossary.
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3. In the Glossary Editor, view the terms for both source and target languages. You can also filter, add, remove,
and update terms.
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4. (Optional) To search for source or target terms, enter your search criteria in the appropriate fields in the Filters
sidebar, then click Find.

You can make your filtered search case-sensitive or specify an exact match, then filter further by
creator, user, and modification date.

5. (Optional) To reset your search criteria, click Clear.

6. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste within the source and target columns.

LEVERAGE PROJECT GLOSSARIES

Import a Local Glossary

To exchange glossaries with other translators, save the exported glossary to a local drive, then use the Import
Glossary action to import it to your project.

@ To exchange glossaries among projects on your local drive, use the Add Project Glossaries action.

To import a local glossary:
1. In the Project List view, on the Projects tab, double-click a project from the projects list.

2. In the Current Project view, on the Project Terminology tab, click Import Glossary.
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3. On the Import Glossary dialog, select the import File Type from the drop-down list.

Required fields are marked with a red asterisk.

Import Glossary x
W Import Glossary

File Type" |ii'-£i -

Impart File™ ChUsers\Documents\Source\de-DE Term‘de-DE_TechDo Browse...

Create a new glossary

*) Import into existing glossary

Existing Glossary:* de-DE-TechDoc -

If the ferm already exists:™ | Add as new term -

Delete all terms from existing glossary

0K Cancel

Field Action

File Type Select a file format for importing raw text files.

e Term Base eXchange (TBX) — Use with other CAT tool glossaries

e Tab delimited text file (TXT) — Use with Wordfast Classic and Wordfast
Pro glossaries

Import File Click Browse to locate and select an Import File.

Create a new glossary  Click to use the imported glossary to create a new glossary rather than add terms
to an existing glossary.

Import into existing Click to use the imported glossary to add to the selected glossary.

glossary

Existing Glossary Select from the drop-down list to append the imported glossary to an existing
glossary file.

If term already exists Select from the drop-down list to import the term into an existing glossary file.

e Add as a new term — Add the term to the existing glossary file.

¢ Do not overwrite — Ignore the term and retain the term already in the
glossary file.

e Overwrite existing term — Use the new term to replace the term already
in the glossary file.




Field Action

Delete all terms from Select to delete the existing term and replace it with the new glossary term.
existing glossary

4. Click OK.

The glossary is imported and is displayed in the project Glossaries list.

LEVERAGE PROJECT GLOSSARIES
Export a Local Glossary

To exchange glossaries with other translators, use the Export Glossary action and save it to a local drive, then
send it to another translator to import to their project.

@ To exchange glossaries among projects on your local drive, use the Add Project Glossaries action.

To export a local glossary:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list.

2. In the Current Project view, on the Project Terminology tab, select a glossary and click Export Glossary.
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3. On the Export Glossary dialog, select a glossary from the drop-down list.

W Export Glossary

Glossary* Doc_Termi -

Export Type:* TBX -

File:* Browse...
oK Cancel

4. Select the file Export Type from the drop-down list.

¢ Term Base eXchange (TBX) — Use with other computer-assisted translation (CAT) tool glossaries
¢ Tab delimited text file (TXT) — Use with Wordfast Classic and Wordfast Pro 3 glossaries

5. Click Browse to locate and select the export file location, then click Save.
6. Click OK.

The glossary is exported to the specified file location.



Leverage Project Blacklists

You can use a blacklist to exclude words or phrases from use in the target segment.

LEVERAGE PROJECT BLACKLISTS
Create a Local Blacklist

You can create a blacklist for your project on your local computer.
To create a local blacklist:
1. In the Project List view, on the Projects tab, double-click a project from the projects list.

2. In the Current Project view, on the Project Terminology tab, click Create Local in the Blacklist group.
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3. On the Create Blacklist dialog, enter the required blacklist information.

@ Required fields are marked with a red asterisk.

Create Blacklist x
W Create a New Blacklist
Name:* |
Language:* | German -
Location:* Browse...
/| Selected
Read-only
oK Cancel
Field Action
Name Enter a unique blacklist name that includes the client or organization name and the
blacklist target language for easy identification.
Language Select ’Fhe blacklist's target language, which is limited to languages configured in
the project.
Location Select the destination for the new blacklist.
Selected (Optional) Select to use the current blacklist for the project.
Read-Only (Optional) Select to leverage the blacklist without updating it with the new

translation.




4. Click OK.

The new blacklist is created and is displayed in the project terminology list.

LEVERAGE PROJECT BLACKLISTS

Add a Local Blacklist

Use a local blacklist already created on your computer when you want to leverage a translation blacklist, but do
not want to collaborate with other users. You can add a local blacklist to your project at the time of creation or as a
separate action.

To add a local blacklist:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, on the Project Terminology tab, click Add Local in the Blacklist group.
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3. On the Creating Blacklist dialog, browse to a blacklist file and select it.
4. Click Select Folder.

The selected blacklist is added to the project and is displayed in the project terminology list.

LEVERAGE PROJECT BLACKLISTS
Connect to a Remote Blacklist

You can connect to one or more blacklists on another computer or server.
To connect to a remote blacklist:
1. In the Project List view, on the Projects tab, double-click a project from the projects list.

2. In the Current Project view, on the Project Terminology tab, click Connect To Remote.

Project Files Project TM Project Terminology Reports Reference Files

BB K B B BB B &§ @ € © @&

Create Add Connect Open Innport Export Add Project Create
Local Local To Remoie Glossary Glossary Glossary Gloszaries Local Local To Remote Blacklist Blacklist

Caonnect Open Import

3. On the Connect to Term Manager dialog, enter the required information, based on your server options.

Required fields are marked with a red asterisk.



W Connect to Remote Blacklist

Name:™* |

Target Language:* German -
URL Settings

URL:™ Test
Address:*

Username:*

Password:*

Project Shert Code:*

] Selected
OK Cancel

Field or Option Action

Name Enter a unique name for the blacklist.

Target Language Select a target language from the drop-down list.

URL Enter the remote TMGR URL using the following format: t ngr: / /
addr ess: port/ TM5?. The remaining URL Settings automatically populate
when you enter the URL string. Click Test to validate the connection.

Address Enter the remote address.

Username Enter the username associated with the URL log in.

Password Enter the password associated with the username.

Project Short Code Enter the short code for the project, such as ABCO000001.

Selected (Optional) Select to use the current blacklist for the project.

4. Click OK.

The new remote blacklist is displayed in the project terminology list.

LEVERAGE PROJECT BLACKLISTS

Open and Edit a Local Blacklist

You can open and edit local blacklist entries at any time after blacklist creation.
A You cannot open a remote blacklist in Wordfast Pro.

To open and edit a local blacklist:



1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, on the Project Terminology tab, select a local blacklist, and click Open
Blacklist.
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3. On the Blacklist Editor tab, view the blacklist terms for both source and target languages. You can also filter,
add, remove, and update terms.
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4. (Optional) To search for source or target blacklist terms, enter your search criteria in the appropriate fields in
the Filters sidebar, then click Find.

You can make your filtered search case-sensitive or specify an exact match, then filter further by
creator, user, and modification date.

5. (Optional) To reset your search criteria, click Clear.
6. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste to edit entries within the forbidden

and suggested term columns.

LEVERAGE PROJECT BLACKLISTS
Import a Local Blacklist

To use a local blacklist from another source, use the Import Blacklist action.
To import a local blacklist:

1. In the Project List view, on the Projects tab, double-click a project from the projects list.



2. In the Current Project view, on the Project Terminology tab, click Import Blacklist.
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3. On the Import Blacklist dialog, select the import File Type from the drop-down list.

Required fields are marked with a red asterisk.

Import Blacklist x
W Import Blacklist
File Type:® Txt -
Import Fila:™ C\Users\Documents\Source\de-DE Termide-DE_Te Browse...

#) Create a new blacklist

OK Cancel
Field Action
File Type Select TXT as the file format for importing raw text files.
Import File Click Browse to locate and select an Import File.

Create a new blacklist  Click to use the imported blacklist to create a new blacklist, rather than add terms
to an existing blacklist.

Import into existing Click to use the imported blacklist to add to the selected blacklist.

blacklist

Existing Blacklist Select from the drop-down list to append the imported blacklist to an existing
blacklist file.

If term already exists Select from the drop-down list to import the term into an existing blacklist file.

e Add as a new term — Add the term to the existing blacklist file.

¢ Do not overwrite — Ignore the term and retain the term already in the
blacklist file.

e Overwrite existing term — Use the new term to replace the term already
in the blacklist file.

Delete all terms from Select to delete the existing term and replace it with the new blacklist term.
existing Blacklist




4. Click OK.
The blacklist is imported and displayed in the project Blacklist.
LEVERAGE PROJECT BLACKLISTS

Export a Local Blacklist

To share a local blacklist with another linguist, use the Export Blacklist action.
To export a local blacklist:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list.

2. In the Current Project view, on the Project Terminology tab, select a blacklist from the project Blacklist.

3. Click Export Blacklist on the Project Terminology tab.
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4. On the Export Blacklist dialog, choose a blacklist name, export type, and folder location for the blacklist
export file.

@ Required fields are marked with a red asterisk.

Export Blacklist x

W Export a blacklist

Blackhst:* Blackhs! -

Export Type:* Txd i

File Locaton:” Browse...

oK Cancel

Blacklist Select a blacklist from the drop-down list.

Export Type Select the export file type from the drop-down list.

File Location Browse and select the folder location for the export file.
5. Click OK.

The selected blacklist exports to the selected folder location.

Use Project Terminology Options

You can use the Project Terminology tab to modify and remove glossaries and blacklists.



USE PROJECT TERMINOLOGY OPTIONS

Modify a Glossary or Blacklist
To modify a glossary or blacklist:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list.

2. In the Current Project view, on the Project Terminology tab, click a glossary or blacklist.

w

. Click Modify.
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4. On the Create Glossary dialog, modify the details as required. Based on your selection, other fields auto-
populate.

@ Required fields are marked with a red asterisk.

Modify Glossary x
W Modify Glossary

Name:* [Geman Giossan;

Browse..
i Selected
Read-only
OK Cancel
Name Modify the name of the current glossary or blacklist.
Selected (Optional) Select to use the current glossary or blacklist for modification.
Read Only (Optional) Select to leverage the glossary or blacklist without updating it with the new
translation.
5. Click OK.

Your modifications are saved.



USE PROJECT TERMINOLOGY OPTIONS

Remove a Glossary or Blacklist

When you remove a glossary or blacklist from a project, the glossary or blacklist file remains in the glossary or
blacklist folder on your computer. You can add it again with the Add Local or Connect to Remote action.

To remove a glossary or blacklist:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list.
2. In the Current Project view, on the Project Terminology tab, select a glossary or blacklist.

3. Click Remove.
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Lacal Local To Hemaote Blacklist Blacklist Elacklist

A warning message asks you to agree to the removal.
4. Click Yes.

The selected glossary or blacklist is removed from the project terminology list.



9. Monitor Reports

Use the Reports tab to open and to export auto-generated analysis and cleanup reports to .CSV, .HTML, .XLS,

and .PDF formats.

E Wordfast Pro

=

Project Files QA0 Project Terminology [MGE0-B8 Relerence Files 0~ %

Remaove Export
Report
Report Name Loc ation
~ i EN-> DE
= Cleanup

; B clean Up Report2.mpt C:\WsersW ordfastProlprojacisWordf .
- B clean Up Reportl.mt C:\UsersW ordfastPro\projacts\Wordf
|5 dean up Report.mpt C:\UsersiWordfastPro\projects\Wordf..
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Open a Report

Use the Open Report action to open and view an auto-generated report.

To open a report:

1. Inthe Current Project view, on the Reports tab, select a report.

2. Double-click the report file name.

e 23% Transiated
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Primary TM: tms://stg-supportl.com/TMS?
tm=DOC000003/MARDDO003&uUsr=Mar-en-
Secondary TM:
file://C:\Users\Laks\Desktop\LNK\WF\WF
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H summary
Match Types Segments Words Percent Tags
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Repetitions 2 2 1 0
TM Matches
Context 6 60 16 &
100% 64 312 83 0
95%-99% 0 0 0 0
85%-94% 0 0 0 0
75%-84% 0 0 0 0
50%-74% 0 0 0 0
No Match 2 2 1 0
Ignored 0 0 0 0
Total 74 376 100 6
Chars/Word 6.46
Chars Total 2430
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3. Review the report, then click OK to close the dialog.

Export a Report

You can export an auto-generated report to a CSV, HTML, XLS, or PDF file format before you view it.
To export a report:
1. On the Reports tab, select a report.

2. Select a format from the Export drop-down list.

Project Files

Project TM Project Terminology

3. Browse to the location for the report, enter a file name, and click Save.

The report is saved to the designated location.



10. Manage Project Reference Files

You can include reference files in a project to provide context. Typical reference files are additional instructions,
illustrations, workflow diagrams, certifications, or any file that might aid translators and reviewers. Reference files
remain untranslated.

A Users cannot modify reference files once you attach them to the project.
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Add Reference Files

To add reference files:

=

In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, on the Reference Files tab, click Add Files.
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3. On the Open dialog, browse and select the reference file. To select multiple reference files, press Ctrl and
select them.

4. Click Open.

The files are added to the reference files list for the project.



Open a Reference File

To open a reference file:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.
2. In the Current Project view, on the Reference Files tab, select a reference file from the list.

3. Click Open File.
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The selected file is opened.

View Submission Instructions

Submitters can include instructions as part of the Package files imported into Wordfast Pro.
To view instructions:
1. On the Projects tab, double-click a project from the projects list to open it.

2. On the Reference Files tab, click Show Instructions.
Project Files Project TM Project Terminology Reports Reference Files
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BEE & B
Add Open Show Remave
Files File Instructions File(s)

3. On the Instructions dialog, review the instructions on the first Instructions tab, then click the Background
Instructions tab for any project-related or more general information and instructions.

4. Click OK.

The Instructions dialog is closed.

Remove a Reference File

You can remove a reference file from a project, but the file remains on your local computer.
@ To add a removed reference file, use the Add Files action on the Reference Files tab.

To remove a reference file:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.
2. In the Current Project view, on the Reference Files tab, select the files you want to remove.

3. Click Remove File(s).
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4. On the Remove dialog, select one of the available buttons.

) Remove from the list only

Remove from the list and move the following resources to Archive folder

Resources #
Reference Files 1
4 k
0K Cancel
Remove from the list only Removes the reference file from the files list, but

retains the reference files resources in the project
folder on your computer

Remove from the list and move the following Removes the reference file from the files list and
resources to Archive folder moves them to the archive folder inside the project
folder on your local computer

5. Click OK.



11. Use Quick Tools

You can use Quick Tools to create and work with files outside of projects. Typically, Project Managers use Quick
Tools before cleaning up and sending files to translation.

@ e When you first open Quick Tools, the default is the Analysis tab. Once you access Quick
Tools, the default Quick Tools tab is the last one you used.
* You can choose to run many Quick Tools actions in the background and continue your work.

This is useful when processing large numbers of files.
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You can use actions on the Analysis tab to create TXLF files or assess potential translation memory (TM)
matches and repetitions for selected source files.

Analyze without using the TM panel is a quick way to obtain the word count of the files before TM leveraging.

¢ When you first open Quick Tools, the default is the Analysis tab. Once you access Quick
Tools, the default Quick Tools tab is the last one you used.

¢ You do not need to select languages when using Analyze without a TM.

You can pre-translate target segments using your TM and machine translation on No Match. You can also select
Maintain existing target (if present) to pre-translate only blank target segments and preserve any existing
translations in TXLF target segments with no TM match.

To analyze files:
1. Click the Wordfast Pro drop-down menu, then select Quick Tools.

2. Click the Analysis tab, if it is not already selected.
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3. On the Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the available search

field nextto ~’ on the Files panel.

Add Files
Add Folder

Remove Files

Click to browse and select a file from a folder.
Click to browse and select a folder and all its files.

Click to remove a folder and all its files or all selected files from the list.

choose one of the following actions:

o

search field nextto /' on the Translation Memories panel.

To search the TM Name column for a particular string, enter the search string in the available

(Optional) On the Translation Memories panel, select one or more TMs from the list of available TMs, then



¢ [f you do not select a TM, the analysis report displays the word count without TM leverage and
the Language Selection option is not available.

Item

Action

Create Local

Click to open the Create TM dialog and create a local TM for quick, local access.
Refer to Create a Local TM.

Add Local TM

Click, then select a local TM or a project TM from the project list from the drop-
down list. Refer to Add a Local TM to a Project and Add Project TMs.

Connect to Remote

Click to open the Connect to Remote TM dialog and complete the appropriate
information to connect to a remote TM for the project. Refer to Connect to a
Remote Glossary.

Import TM Click to open the Import Translation Memory dialog and complete the
appropriate information to import a TM for the project. Refer to Import a Local TM.

Open TM Click to open and edit the selected TM. Refer to Open and Edit a Local TM.

Modify TM Depending on the TM you select, click to open either the Modify a Local TM
dialog or the Modify a Remote TM dialog, then complete the appropriate
information to rename, write-protect, or change the priority of a TM for the project.
Refer to Connect to a Remote Glossary.

Remove TM Click to remove the selected TM from the project list.

5. (Optional) On the Analysis Options panel, select the method for bilingual source file creation from the Create
TXLF files drop-down list, such as InDesign or MS Word files.

6. For Analyze without TM, select the appropriate languages from the Source Languages and Target

Languages drop-down list.

The options are not available for TXLF source files, or for non-TXLF source files when you also select

aTM.

7. (Optional) Complete Pretranslation Options.

a) Select Pretranslate, then set the baseline match percentage for the TM leverage with the type of match

from the drop-down list.

Item

Action

Copy Source (clears
existing target)

When there is no matching target content, select to insert source content in its
place.

Copy Tags (clears
existing target)

When there is no matching target content, select to insert source tags in its
place.

Primary MT (if
available, clears
existing target)

Select to leverage machine translation (MT) matches for all segments that do
not have a TM match.

If you have TM matches, but do not select the TM before you click Analyze, the
MT overwrites all target segments.




Item Action

Maintain existing target When there is existing target content, retain it. Otherwise, insert source content

(if present) in its place.
Clear existing target Overwrite target content with source content.
content

b) Select any of the following actions:

Item Action

Lock leveraged 100%  Write-protect all leveraged matches that are 100% matches.
matches

Lock leveraged context Write-protect all leveraged matches that are contextual matches.
matches

Ignore translated Do not consider target segments identified in the Analysis report.
segments from report

Ignore translated exact Do not consider only exact match target segments identified in the Analysis
segments from report  report.

8. For the Report Settings, choose from the following actions:

Item Action
Calculate analysis report percentage by: Select Words or Segments as the means of
calculating analysis percentages from the drop-down
list.
Calculate internal fuzzy matches e (Optional) Select according to the match
percentage you set or select an alternate
percentage.

e (Optional) Select Include internal fuzzy
matches as TM matches.

e (Optional) Select Include whitespace in total
character count. This is useful for including
space counts in the character count.

Report type Select a report type from the drop-down list.

Report location Select one of the following actions:

¢ Next to source

e Custom location, then browse to and select
an alternate location for the report on your local
computer.

9. Click Analyze Files.

10. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the
background batch action for future analysis actions, then click Run in Background.
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Analyzing document(s)

79% completed...

Always run in background

Run in Background m

11. If you chose to run Analyze Files in the background, you can monitor its progress.

L7
Background Actions '\::!

If you choose to run more than one batch action in the background, each action will have its own
progress bar.

12. After successful completion, view the report, then close the report browser window.

The Analysis Report is saved to your computer at the specified location.

Extract Unigues

You can use actions on the Extract Uniques tab to remove frequently occurring segments, control exclusions for
matches, and create a .TXLF file of these unique segments before sending it out for translation. It uses the action
for each file you selected in the TXLF Files panel.

You can set the number of occurrences of a segment to be extracted to two or higher to create a file containing
only repeated segments. If you exclude context TM matches, 100% TM matches, and locked segments from the
extract, it further reduces the number of extracted segments.

To extract unique segments:



1. Inthe Quick Tools view, click the Extract Uniques tab, if it is not already selected.
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2. On the TXLF Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the available search

field nextto &’ on the TXLF Files panel.

Add Files Click to browse and select a file from a folder.
Add Folder Click to browse and select a folder and all its files.
Remove Files Click to remove a folder and all its files or all selected files from the list.

3. (Optional) On the Extract Unique Segments Options panel, select an Extract option:

Make one uniques file Select to create a separate TXLF file for each selected file in the TXLF Files
per TXLF panel.
New uniques file after # Select to split a TXLF file into smaller files, based on the number of unique

segments segments you specified. The default value is 250. For example, this option would
split a file with 1000 unique segments into four files of 250 segments each.



4. (Optional) Select an Extract Location, by choosing one of the following actions:
o Select Place unique segments next to TXLF.

e Select Place in subfolder, then browse to and select a location on your computer, then use the default
uniques prefix or create your own.

[ ]
@ If you changed the uniques prefix, it will have the prefix you designate at the location you select.

5. (Optional) Select the type of segments you want to exclude in the Extract Uniques Options panel and the
minimum frequency of occurrence.

e Exclude context TM matches
e Exclude 100% TM matches
e Exclude locked segments

6. Click Extract Uniques.

7. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the
background batch action for future analysis actions, then click Run in Background.

b= ]
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8. If you chose to run Extract Uniques in the background, you can monitor its progress.

Background Actions * :'

If you choose to run more than one batch action in the background, each action will have its own
progress bar.

After successful completion, the .TXLF files containing unique segments are saved to your computer at the
selected location.

Populate Uniques

You can use actions on the Populate Uniques tab to add the target translation from the translated uniques

file back into the original TXLF file. After the uniques population, it creates a Frequents Population Report that
identifies all related segment errors. This is helpful when determining why certain target segments did not properly
populate.

To populate unique segments:



1. Inthe Quick Tools view, click the Populate Uniques tab, if it is not already selected.
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2. On the Uniques Files and Original TXLF Files panels, choose one of the following actions to select a file or
files to receive unique segments that have a high frequency of occurrence as an import from the original TXLF
files you selected.

@ e To search the File Name column for a particular string, enter the search string in the available

search field nextto /= on the Uniques Files and Original TXLF Files panels.

¢ If you do not choose a new folder for this action, the populated files are placed in a separate

folder.
Add Files Click to browse and select a file from a folder.
Add Folder Click to browse and select a folder and all its files.
Remove Files Click to remove a folder and all its files or all selected files from the list.

3. (Optional) Select from the following Populate Unique Segments Options:
o Populate TXLF in new folder

e Only report non-populated segments
4. (Optional) Add a report name prefix or use the default uniques prefix you used for the Extract Uniques report.
5. Select a Report Location, by choosing one of the following actions:

o Select Next to Original TXLF.
e Select Custom Location, then browse to and select the report location on your computer.



6. Click Populate Uniques.
The uniques from the translated uniques file are populated into the original .TXLF file.

7. After successful completion of the action, view any errors that occur in the Frequents Population Report that
have to do with the population of segments into the original TXLF file, then close the report browser window.

The Frequents Population Report is saved to your computer at the selected location.

Quick Tools Transcheck

You can use Transcheck to scan translated content for non-linguistic errors such as missing tags, empty targets,
numbers, and terminology within target segments. Using the Quick Tools Transcheck action is best for running
on groups of files as a bulk batch.

If you have specific terms you want Transcheck to ignore, you can mark those segments for exclusion
to reduce false positives during Transcheck error detection.

To run Quick Tools Transcheck:

1. Inthe Quick Tools view, click the Transcheck tab, if it is not already selected.

[w] Wordfast Pre - Quick Tools - O h4
Rl 1 Ui oo Tonceion Bt ot B oport &
TXLF Files (000 Selected) Transcheck Options
E;} F@ []Eg P Transcheck Capitalization
ﬁ Eile Name: Source Language Target Language Size Segment Content Checks - All Caps Mismaich
1 Capitalization First Word Case Difference Chack

+| Source Consistency N
Target Capialzation Mismaich
~ Target Consistency Chetk
T Copied s
piad saurce Source Capitalization Mismatch
“ Em pty Target Check
Nete Skip exact matches
Mumber Difference

R

Punctuation
+ Repeated Word
% Segment Length
Smart Punctuation
ol Tag
- + wihitespace
-_| |: Segment Status Checks

Glossary (0) Blacklist (0) Edited Context Match

| ~"  Edited Exact Match
B} B - BQ OF [ [ R o | d

-
Roeport Eatfinga

Glogsary ... | S8ource La... | Target Lan... | Type Location P g r——
Garman G English Garman Local Gles Ci\Ugers), !

®) Mext to THLF
Test English German (.. Local Glos...  Ci\Users),.

<

2. On the TXLF Files panel, choose one of the following actions:



To search the File Name column for a particular string, enter the search string in the available search

field nextto ' on the TXLF Files panel.

Add Files Click to browse and select a file from a folder.
Add Folder Click to browse and select a folder and all its files.
Remove Files Click to remove a folder and all its files or all selected files from the list.

3. Select an action for the Glossary or Blacklist tabs.

To search the Glossary Name or Blacklist Name column for a particular string, enter the search

string in the available search field nextto *' on the Glossary or Blacklist panels.

Option Action

Create Local Select to create a new glossary or blacklist and add it to the list of available ones.

Add Local Select and choose from the drop-down list to add to a local or project glossary or
blacklist.

Connect to Remote Select to connect a remote glossary or blacklist to the project.

Import Glossary or Select to import .TBX or tab-delimited files to a glossary or blacklist assigned to

Import Blacklist the project.

Open Select to open a glossary or blacklist in the Editor view.

Modify Select to modify a glossary or blacklist assigned to the project.

Remove Select to remove a glossary or blacklist assigned to the project.

4. On the Transcheck Options panel, select items within any of the major categories.

e To search for an option, enter text in the search field above the options column list. To select
all, click the checkbox, and to clear all options, deselect the checkbox. Use the Up or Down
Arrow keys to move among the options, then the Spacebar to enable or disable.

e The Sub-options panel to the right of the Transcheck Options panel contains any sub-options
related to the selected category. Use the Tab key to enter and move among sub-options, then
the Spacebar to enable or disable. To enter the Sub-options panel, press Tab. To exit the Sub-
options panel, press Shift + Tab.

a) Select items for the Segment Content Checks category.

Option Action

Capitalization Select to identify any capitalization issues for translated segments in the edited
file.

Source Consistency Select for consistency of source content across a single file or multiple edited
files.

Target Consistency Select for consistency of target content across a single file or multiple edited

files.




Option

Action

Copied Source

Select to identify any target segments that are identical to the source segment
in the edited file.

Empty Target Select to identify any empty target segments that do not contain a translation in
the edited file.
Note Select to identify any target segments in the edited file with related notes.

Number Difference

Select to compare numerical values in source and target segments in the
edited file, then identify any discrepancies.

Punctuation

Select to compare punctuation in source and target segments in the edited file,
then identify any discrepancies.

Repeated Word

Select to identify any repetitions of words in target segments within the edited
file.

Segment Length

Select to compare source and target segment length in the edited file, then
identify any discrepancies.

Smart Punctuation

Select to confirm the punctuation in the target segment is correct for that
language.

Tag

Select to identify any target segments in the edited file with missing tags.

Whitespace

Select to compare source and target segment white space usage in the edited
file, then identify any discrepancies.

Option

b) Select items for the Segment Status Checks category.

Action

Edited Context Match

Select to identify any changes to the context matches for translated segments
in the edited file.

Edited Exact Match

Select to identify any changes to exact matches for translated segments in the
edited file.

Edited Source

Select to identify any updates to the original segment content in the edited file.

Unconfirmed Segment

Select to identify any translated segments marked as unconfirmed in the edited
file, so not committed to the translation memory.

Unedited Exact Match

Select to identify any unedited or overlooked exact match segments in the
edited file.

Unedited Fuzzy Match

Select to identify any unedited or overlooked fuzzy match segments in the
edited file.

Option

c) Select items for the Reference Checks category.

Action

Blacklist

Select to cross-reference the available blacklist with the edited file.

Forbidden Character

Select to identify any provided forbidden characters remaining within the edited
file.




Option Action

Mistranslated Text Select to identify any mistranslated or inaccurate translation in segments within
the edited file.

Spelling Select to identify any misspellings in translated segments within the edited file.

Terminology Select to identify any overlooked terminology matches for translated segments
in the edited file.

Untranslatable Text Select to identify all target segments that contain content that cannot be
translated in the edited file.

Untranslated MT Select to identify all target segments that contain untranslated machine
translation (MT) content in the edited file.

5. Create your Report Settings.
a) (Optional) Use the default transcheck prefix or create an alternate prefix for the report.

b) Select Next to TXLF to create the Transcheck Report next to the existing TXLF file location, or browse and
select an alternate Report Location on your local computer.

6. Click Transcheck Files.

7. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the
background batch action for future analysis actions, then click Run in Background.
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Analyzing document(s)
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8. If you chose to run Transcheck in the background, you can monitor its progress.

Background Actions ° :'

If you choose to run more than one batch action in the background, each action will have its own
progress bar.

9. After successful completion, view the report, then close the report browser window.

The Project Transcheck Report is saved to your computer at the selected location.

TM Update

To clean up and convert bilingual .TXLF files to their original source format in the target language, use TM
Update. Refer to Translate Segments.

A TM Update actions overwrite the translation memory (TM).



To use TM Update:
1. Click the Wordfast Pro drop-down menu, then select Quick Tools.

2. Click the TM Update tab, if it is not already selected.
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3. On the TXLF Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the available search
field next to £~ on the TXLF Files panel.

Add Files Click to browse and select a file from a folder.
Add Folder Click to browse and select a folder and all its files.
Remove Files Click to remove a folder and all its files or all selected files from the list.

4. On the Translation Memory panel, choose a TM or several TMs from the list, then choose one of the
following actions:

@ e To search the TM Name column for a particular string, enter the search string in the available

search field next to & on the Translation Memory panel.



e To better understand context matches or the TM, refer to Leverage Project TMs.

Item

Action

Create Local

Select to create a new TM and add it to the list of available TMs.

Add Local TM or Add
Project TMs

Select and choose from the drop-down list to add to a local TM or to a project
T™.

Note: If you choose a project TM, you can only add a TM to a locale already
assigned to the project.

Connect to Remote

Select to connect a remote TM to the project.

Import TM Select to import . TMX or .TXT files to a TM assigned to the project.
Open TM Select to open a TM in the TM Editor view.

Modify TM Select to modify a TM assigned to the project.

Remove TM Select to remove a TM assigned to the project.

5. (Optional) Configure the TM Update Options:

Use the search field next to a TM action to search that column above the search field location.

Item

Action

Update Option

Select one of the TM update options from the drop-down menu:
e Append
e Do not add to TM
e Do not overwrite TU to retain existing TUs
e Overwrite existing TU to overwrite existing translation units (TUs)
e Overwrite if attributes are identical

Add attribute

Select to add an attribute to write to the TM for cleaned up segments.

Add file name as an
attribute

Select to add the TXLF file name as an attribute to write to the TM for
cleaned up segments.

Overwrite private TUs
(WFServer TM only)

Select to replace existing private TUs with new ones. This requires a Cleanup
password.

Write 'unedited fuzzy' to TM

Select to write fuzzy matches to the TM without user modification.

Write 'unedited
autopropagated fuzzy' to
™

Select to write automatically inserted fuzzy matches to the TM without user
modification.

Write exact matches to TM

Select to write context matches to the TM without user modification.

Write 'unedited MT' to TM

Select to write machine translation to the TM without user modification.

6. Select a Translated File Settings option for translation file creation from the drop-down list.



Item Action

Next to source with target  Select to save translated files in the same location as the source TXLF files,

language suffix in original format, after appending the target language code to the file name
as a suffix.

Inside subfolder and Select to save translated files in the same location as your TXLF files, butin a

maintain folder structure for subfolder that retains the source folder hierarchy.

folders

Do not create translated Select to prevent the creation of translated files and retain the source TXLF

files files.

7. Choose one of the following actions, when enabled for the options you selected:

Item Action

Update & Create Click to update the TM and create a translated TXLF file.
Create Translated Files Click to create a translated TXLF file without updating the TM.
Update TM Click to update the TM without creating a translated TXLF file.

8. (Optional) On the Progress Bar dialog, you can select Always run in the background to preserve the
background batch action for future analysis actions, then click Run in Background.

e ]

Analyzing document(s)

79% completed...

Always run in background

Run in Background =

9. If you chose to run Update & Create in the background, you can monitor its progress.

Background Actions - :

If you choose to run more than one batch action in the background, each action will have its own
progress bar.

The bilingual TXLF file is converted to its original source format in the target language.

Pseudo Translation

Pseudo-translation simulates the entire translation process. This is particularly useful for several situations.

e Use to verify successful completion of the extraction, translation, and creation of a translated file.
¢ Use to identify any text expansion issues that might occur during translation.

¢ Use to identify any font issues during creation of the translation file.

¢ Use to identify any formatting or missing content issues.



You can copy the source content to the target content to preview translatable content for target languages and the
complexity of associated formatting. This preview is particularly useful when content has accented characters and
when the content is likely to expand during translation.

@ ¢ Pseudo-translation requires source files in a supported file format, such as .DOC or .TXT files.
¢ If you use Wordfast Pro in Demo Mode, the limit on processing pseudo translation is 20 files.
To simultaneously pseudo-translate more than 20 files, obtain a Wordfast Pro license.

To pseudo-translate files:

1. In the Quick Tools view, click the Pseudo Translation tab, if it is not already selected.

[#] Weordfast Pro - Quick Tools - O >
| Analysis  ExiractUniques  Populate Uniques  Transcheck  TM Update [T WREUETE NN  Bilingual Export  Bilingual Import )
Files (2/2 Selactad) Pseudo Translation Options
: ?‘ Eih o
I::'.'I: {: ﬂ" Language Gelecson
ﬁ « | Fila Mame File Type Source Lang... | Target Lang... | Size Selec! Sourse Language:” English [Unded Slates -
] PD_. WFTXLFDo.. Englsh Gesman 3.. | Selest Target Language:” Gemman (Gemnany -
~ 4 PD_. WFTXLFDo.. Englsh German 3.

Piaiads Tranalatas Optons
. L Creals pseudo ranslated largel e

Add pseuds suffod 1o the tlis name

*| Place pseudo translated files in the criginal files location

K
: Chaose location for pseudo transiated filkes
—
) —
-

&

2. On the TXLF Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the available search
field next to .~ on the TXLF Files panel.

Add Files Click to browse and select a file from a folder.
Add Folder Click to browse and select a folder and all its files.
Remove File(s) Click to remove a folder and all its files or all selected files from the list.

3. Select a Source Language and Target Language for the Language Selection section.

4. (Optional) In the Pseudo Translation Options section, select either or both options for creating a target file
and adding a suffix to the target filename, then click an option to either place it next to the source file or to
browse and select an alternate location.

5. Click Pseudotranslate Files.



6. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the
background batch action for future analysis actions, then click Run in Background.

Analyzing document(s)

79% completed...

Always run in background

Run in Background =

7. If you chose to run Pseudotranslate Files in the background, you can monitor its progress.

L}
Background Actions "'::!

If you choose to run more than one batch action in the background, each action will have its own
progress bar.

The pseudo-translation is created and a successful completion message is displayed.

Quick Tools Bilingual Export

Use Bilingual Export to export the TXLF file with highlighted glossary terms to a .DOC or .DOCX format for edit
and translation of the content using Microsoft Word (Word).

You must not edit the exported table format. This includes merging or expanding segments and
adding text outside of the target or notes column. Editing the exported table format will result in errors
during bilingual import.

To conduct a Quick Tools bilingual export:



1. Inthe Quick Tools view, click the Bilingual Export tab, if not already selected.

[] werdfast Pro - Quick Teols — O ¥
| Analysis  ExiractUniques  FPopulaleUniques  Transcheck  TMUpdale  Pseudo Transiotion [EGIDNIEUSESOEN  Bilingual import )
TXLF Files (111 Selected) Glossaries (1/1 Selected)
EYY: o 3O E3 R ER R o
ﬂ ] | File Name Source Language Target Language Hize ] Glogsary ... | Sourcela...  Targetlan... Type Location
~ = PD_en-de English Geman 3. ~| GermanG..  English German Local Glos C:\Users),

Bilingual Export Options

, Ogprignz
!/ :
Salect export type fram drop down: Bikngual Review Export
Open report afler export

% Exclude the notes column

Track changes

o Prolect document (Ward 2003+
] —
= W Export as Docx

Export all THLF files as one bilingual file
Custom instructions: Browse...

App Name Instructions Legend Thiz document

Place exported files in the original files location

%) Choose lacafion for the exported files EBrowse...

<< Export Bilingual Files

2. On the TXLF Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the available search

field next to /~ on the TXLF Files panel.

Add Files Click to browse and select a file from a folder.
Add Folder Click to browse and select a folder and all its files.
Remove Files Click to remove a folder and all its files, or all selected files from the list.

To search the File Name column for a particular string, enter the search string in the available search

field next to X~ on the Glossaries panel.

3. On the Glossaries panel, choose one of the following actions:

Item Action

Create Local Create a glossary on your local computer.

Add Local or Add Select and choose from the drop-down list to add to a local glossary or to a
Project Glossaries project glossary.

Note: If you choose a project glossary, you can only add a glossary to a locale
already assigned to the project.




Item Action

Import Glossary Select to import .TBX or tab-delimited files to a glossary assigned to the project.
Connect to Remote Select to connect a remote glossary to the project.

Open Select to open a glossary in the Glossary Editor view.

Modify Select to modify a glossary assigned to the project.

Remove Select to remove a glossary assigned to the project.

4. On the Bilingual Export Options panel, choose your export options.

Option

Action

Select export type from drop-
down

Select an export type option from the drop-down list:

e Bilingual Review Export — Creates a bilingual Word document.

e WEFC Bilingual Export (Export only) — Creates a Wordfast
Classic compatible document solely for export.

e MS-Word Table — Creates a Word document with the source
and target in a two-column table.

¢ Bilingual Review Export - WFC (allows import) — Creates a
bilingual Word document for import by Wordfast Classic users.

Open report after export

Select to automatically display the Export Report after action
completion.

Exclude the notes column

Select to remove the Notes column from the exported Word document.
Instead, the export includes the notes from the TXLF file as Comments
in the Word document.

Track changes

Select to track changes in the exported Word document.

Protect document (Word 2003+)

Select to only allow content edits in the available table space.

Note: This helps avoid any import errors.

Export as DOCX

Select to export bilingual file to a .DOCX Word file format.

Export all TXLF files as one
bilingual file

Select to export all converted TXLF files into a single bilingual Word
document.

5. (Optional) Either browse to and select a Custom instructions text file, or choose any of the following options
to include in the file, using default instructions:

e App Name
e Instructions
e |legend

e This document

6. Choose to either use the original file location, or browse and select an alternate location.

7. Click Export Bilingual Files.



8. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the
background batch action for future analysis actions, then click Run in Background.

Analyzing document(s)

79% completed...

Always run in background

Run in Background m

9. If you chose to run Export Bilingual Files in the background, you can monitor its progress.

Background Actions ° E

If you choose to run more than one batch action in the background, each action will have its own
progress bar.

Each exported document is saved to the specified folder on your local computer. The example does not
include any custom content.

10. (Optional) View the bilingual files at the location you specified on your computer.

<FID>aB89%1def-4098-47c2-b58d-bTbedc60098£</FID> Sample 3.docx.tzml.txlf
ji1} Source (en) Target (de) Score
1 TRANSLATION MANAGEMENT. UBERSETZUNGSMANAGEMENT.
2 SIMPLIFIED. VEREINFACHT. 100
3 STREAMLINE PROJECT| MANAGEMENT EFFEKTIVES PROJEKTMANAGEMENT 100 ?MMEI‘I [OFRT:Glo1]:
4 [ INTEGRATE WITH ANY SYSTEM TNTEGRATION MIT JEDEMSYSTEM 00 | |eeee
3 WORK WITH ANY [VENDOH| ZUSANMMENARBEITMIT JEDEM ANBIETER 100
- Comment [OFRT:Glo2]:
6 ACCELLERATE TIME TO MARKET KURZERE BEARBEITUNGSZEITEN 87 From: Glossary
7 CUSTOMIZE WORKFLOWS TNDIVIDUELLE WORKEFLOWS 100 [“”’"‘" ]
8 ACCESS REAL-TIME KPT DATA ZUGRIFF AUF LEISTUNGSKENNZAHLEN IN ECHTZEIT | 100
9 GlobalLink Project Directo] saves Mit GlobalLink Project Director sparen Organisationen 100 - (= mgr‘:s[gmmm]:
organizations millions of dolizrs by suitomatny | 2ufgrund derautometischen Verwaltung vor - ------------==r oo Fraest et
the management of localization processes and Lokalisierungsprozessen und -ressourcen Millionen.
TESDUITEs.
10 SEAMLESS [D:\T:\B:\SE I\‘TEGR:\TIO?q NAHTLOSE DATENBANKINTEGRATION 100 ‘Comment [OFRT:Glo4]:
11 [ Use [GlobalLind] Connect with any CMS, PIM, | GlobalLink Connect funktionert mit jeder CMS-, PIMF, 100 DATENE\AuNKI GRATION
CCMS, or e commerce plaform COMS-oder E-Commerce-Plattform —
12 [ WORK WITH ANY FILEFORMAT FURJEDES DATEIFORMAT 100 rom: Glossary
13 Next-generation parsing engines extract Parsing-Engines der nichsten Generation extrahieren Inhalte 100 [ ]
content and prepare it for translation und bereiten sie fiir die Ubersetzung vor
14 | [VENDOR-NEUTRAL]PLATFORM ANBIETERNEUTRALE PLATIFORM 100 = Com m;‘l [OFRT-Glo6]:
15 | Aflow access to any or internal Maximale Ressourcenflexibilitat durch Zugriffauf alle 100 Anbietemeaize.
translator for maximum resource flexipibty | FiPleter und imtermen R R Comment [OFRTGla7]:
16 CONFIGURABLE WORKFLOW KONFIGURIERBARER WORKFLOW 100 From: Glossary
17 [ Streamline vour translation process through Optimierung des Ubersetzungsprozesses durch 100 ]i“”’"‘" ]
automation of manual tasks Automatisierung manueller Aufgaben
18§ [ TRANSLATION MEMORY INTEGRATION | INTEGRATION VON TRANSLATION MEMORY 100

Quick Tools Bilingual Import

Use Bilingual Import to re-import your translated or edited Microsoft Word (Word) bilingual export document.
Bilingual Import options allow you to open a report, accept tracked changes, and create a merged file from a

translated Word document.

é You must upload both the translated or edited bilingual Word document and the source TXLF file you
used during export.

. Since imports overwrite content from the export, create a backup of the original TXLF file for
reference.



@ e For bilingual files, the first number in the Counter column indicates the count of TXLF files
in the bilingual file that are paired with the added files in the TXLF Files panel. The second
number indicates the total count of TXLF files that were used during bilingual export.

e For TXLF Files, when the bilingual Word document and the corresponding TXLF file are paired,
+ is displayed. If the files are not paired, R is displayed.

To conduct a Quick Tools bilingual import:
1. Inthe Quick Tools view, click the Bilingual Import tab, if not already selected.

Wordfast Pro - Quick Toels B

] >

Bilingual Files (1/1 Selected) Bilingual Import Options
Options
E‘i‘i D
E ﬁ L) ~ Open raport after impart
ﬁ ~/] | File Name File Type e " Accep! Tracked Changes
~1 =} Bilingual_PD_en-de. M5 Word Document (®.doc) 16KE

" Create merged file

- THLF files location: Browse...

2. On the Bilingual Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the available search

field next to &~ on the Bilingual Files panel.

Add Files Click to browse and select a TXLF file from a bilingual export folder, such as
Sampl e. t x| f. doc, and add it to the Bilingual Files list.

: You must select the correct file format from the drop-down list. Select MS
Word Document when uploading the bilingual Word document and WF TXLF
Document when uploading the TXLF file.

Add Folder Click to browse and select a folder and all its files from a bilingual export folder to
add to the available TXLF Files list.

Remove Files Click to remove a folder and all its files or all selected files from the list.

3. On the Bilingual Import Options panel, choose your import options.

Open report after import  Select to automatically open a report after bilingual import.



Accept Tracked Changes Select to accept tracked changes in a bilingual Word document.

Create merged file Select to create a single merged file as a bilingual Word document.

4. Browse to and select a TXLF files import location.

5. Click Import Bilingual Files.

@ Files excluded during export are ignored during import.

6. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the
background batch action for future analysis actions, then click Run in Background.

e ]

Analyzing document(s)

79% completed...

Always run in background

Run in Background m

7. If you chose to run Import Bilingual Files in the background, you can monitor its progress.

Background Actions = E

If you choose to run more than one batch action in the background, each action will have its own
progress bar.

The translations and edits in the bilingual export Word document are imported into the specified TXLF file on
your local computer.

@ The import overwrites the TXLF file content with the imported bilingual Word document content.

Segment Changes

You can run a Segment Changes Report on one or more project files to view the history of changes to a segment.
The report includes the segment ID, TM score, source and target content with the highlighted changes, username,
time stamp, and translator notes. This is particularly useful in workflows that involve multiple people.

To generate a segment changes report:



1. Inthe Quick Tools view, click the Segment Changes tab, if it is not already selected.

] Wordfast Pra - Quick Toels B
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2. On the TXLF Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the available search

field next to .~ on the TXLF Files panel.

Add Files Click to browse and select a file from a folder.
Add Folder Click to browse and select a folder and all its files.
Remove Files Click to remove a folder and all its files, or all selected files from the list.

3. Select one or more files for the Segment Changes Report.



4. On the Segment Changes Report Options pane, choose from the following options:

e Show Columns option—Select any of the column options. The report does not include any columns you
do not select with this option.

e Enable Difference highlighting

e Show all segments (including unmodified)
e Show only changes in most recent phase
e Open report after export

o Filter Phase-name(s)—Select a phase name from the drop-down list to filter by the project's workflow
phases.

e Filter Process-name(s)—Select a process name from the drop-down list to filter by the project's
processes.

e Include all phases before selected phase-Name(s)
5. (Optional) Use the default prefix of segmentchanges or enter a custom prefix.

6. Choose one of the following actions:

e Select Next to Original TXLF to save the segment changes report next to the original TXLF file.

e Browse and select the Custom location folder where you want to save the segment changes report.
7. Click Run Segment Changes.

The Segment Changes Summary is displayed.

Segment Changes Summary x
Filemame Segments Segments with changes
sample_1.dood. teml bdf 37 3
Sample_2.doodl.teml bdf 37 0
Doc_Termd.xsx.bdf 29 1
oK

8. After review, click OK.

9. (Optional) Go to the designated location and view the Segment Changes Report.



Segment Changes Report

Source Target
Total 9
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32 o 2
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Mon Mov
21
13:35:13
CST 2016
11 | 95 |MNext generation parsing engines |docurnentalParsing-Engines der ndchsten £ This is the

extract content and prepare for  |(TranslatiolGeneration extrahieren Inhalte und
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Advanced Quick Tools

The Advanced tab gives you access to several advanced features, each with its own independent action or set of
actions.

ADVANCED QUICK TOOLS
Lock or Unlock Segments

You can quickly lock or unlock segments in the .TXLF files you select. You can lock 100% or context matches to
prevent translators or editors from making changes to them.

To lock or unlock segments:



1. Inthe Quick Tools view, click the Advanced tab, if it is not already selected.

TXLF Files (111 Selected) Advanced Options

L Unkock Eagmants
EE'I E @ L ] Lock 100% malches
- Fl.leuuna Bource Languags Target Langusge Size ) Lok context malches
~ [ wordfast w English (United States)  German (Germany) 41,

Swap scurce and targed
Clear target
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SplitTierge THLF
Spit TXLF in new folder

=| Place spll files in the aniginal files lbeation
Choose kcation for the spift files

Split Fila Opdions:

®| Spit atter |2 > | Tus (appro)
Spi o 2 | parts (apprax )
Spit after | 2 | words (approx. )

Merge File Oplions:

Original files location: | Cillsers\FubliciDocuments Browse...
Update sxisling fils

®) Create naw marped fls
®) Merge TELF in new folder

Choose location fior the manged files
T
2. Onthe TXLF Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the available search

field next to & on the TXLF Files panel.

Add Files Click to browse and select a file from a folder.
Add Folder Click to browse and select a folder and all its files.
Remove Files Click to remove a folder and all its files, or all selected files from the list.

3. On the Lock/Unlock Segments area, select one or both of the Lock/Unlock Segments options:
e Lock 100% matches

o Lock context matches
4. Click either Unlock Segments or Lock Segments.

The segments you selected are locked or unlocked.



ADVANCED QUICK TOOLS

Swap the Source and Target

You can swap the source and target in translation files to create a back translation that validates the translated
content.

To swap the source and target:

1. In the Quick Tools view, click the Advanced tab, if it is not already selected.

Populale Uniques  Tranacheck  TM Updale  Pscudo Translation  Bilingual Export  Bilingual import  Segment Changes [ gl 7 ~ X |

TXLF Files (111 Selected) Advanced Opticns
LocicUnlock Sagmants
: D
[?} E @ Lock 100% malches
~"] | File Name Source Language Target Language Size Lotk conbexdt mabchas

« L JB Wordfsstw_.  English (United States])  Germon (Germany) 41

Swap sowce and targes
bl Cisar tanget
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SplitTsgs THLF
Spit THLF in new folder
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Split Fila Opdions:

= Spit atter |2 > | TUs (appron.)
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Merge File Oplions:
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*| Creale new marpad file
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2. On the TXLF Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the available search

field next to =~ on the TXLF Files panel.

Add Files Click to browse and select a file from a folder.
Add Folder Click to browse and select a folder and all its files.
Remove Files Click to remove a folder and all its files, or all selected files from the list.

3. On the Advanced Options panel in the Swap source and target area, click Swap.

4. (Optional) Select either or both of the following options before clicking Swap.



Clear target Select to clear target language when Swap is clicked. For example, swapping
an English to German translation, German will be the source language and the
target language column will be empty.

Remove notes Select to remove all notes from each segment when Swap is clicked.

The source and target content is swapped.

ADVANCED QUICK TOOLS

You can split files to break a large file into smaller files. You can set a specific number of translation units (TUs),
parts, or words the translated content for each file. For example, you can break a file of 1,000 TUs into four files of
250 TUs each. If there is a remainder, the last file contains the remnant.

You can use a file merge to either update the original file or create a new merged file.
With either option, you designate a specific location to split or merge the files to.

To split or merge a TXLF file:



1. Inthe Quick Tools view, click the Advanced tab, if it is not already selected.

{ niques Transcheck TH Update Peudo Translalion Bilingual Export Bilingual lmp-ort SBegmenl Changes Advanced [ E 1

TXLF Files (11 Selected) Advanced Options
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2. On the TXLF Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the available search
field next to =~ on the TXLF Files panel.

Add Files Click to browse and select a file from a folder.
Add Folder Click to browse and select a folder and all its files.
Remove Files Click to remove a folder and all its files, or all selected files from the list.

3. On the Advanced Options panel in the Split/Merge TXLF area, select one of the following:
e Split TXLF in new folder

o Place split files in the original files location

e To Choose location for the split files, click Browse... to select a folder.



4. Select one of the following Split File Options:
e Split after x TUs (approx.)

e Split to x parts (approx.)
e Split after x words (approx.)
5. If you have already split files, you can merge them back into a single TXLF file. To do so, on the TXLF Files
panel, Add Files to be merged, then choose one of the following Merge File Options:
Original files location: Click Browse... to select the folder the original files are in.
Update existing file Click to browse and select a folder and all its files.
Create new merged file The new file will be created in the original file location.

Merge TXLF in new The merge TXLF file will be in a new folder in the original files location.
folder

Choose location for the Click Browse... to select a folder you want the merged file to be create.
merged files

6. Click either Split TXLF or Merge TXLF.

The files you selected are split into multiple . TXLF files or are merged into a single .TXLF file format.



12. Configure Preferences

You user preference options control the functions available to you in the user interface. Configure preferences at

either the project level or the file level.

Preferences fall into primary categories:

e General Preferences
e Current Project Preferences

General Preferences

Use General Preferences to configure user interface and TXLF Editor view preferences.

GENERAL PREFERENCES

Configure Color Settings

The Colors preferences control color customization for specific types of content in TXLF Editor view.

@ When you change preferences from the default options, click OK to activate your selection.

If you wish to return to the defaults, click Restore Defaults in Advanced Settings. Refer to
Configure Advanced Settings.

To configure colors used in the translation table:
—
=
1. On the Sidebar, click = ==,

2. On the Preferences dialog, click Colors under General Preferences.



Mew Project Preferences
Replacement
Translation Memory

Terminology

e

General Prelerences W Customize the colors used in the translation table
Colors
General Colors
Fonts
lcons Active Segment
Layout Auto-Fropagated
Segment Committed into TM
Shortcuts Cantext Match
Warni
armnas Exact TM Match
Tags Exact Term Match
Auto-Propagation
opags Fuzzy TM Match
Auto-Suggestion
Furzry Term Match
Spelichecker
Machine Translated
Machine Translation

Missing Exact Term Match
Misging Fuzzy Term Match
Modified Target

Mo TM Match

Selected Term

Editor View
Editor View
Editor View
Editor View
Editor View
Editor View
Editor View
Editor View
Editar View
Editor View
Editor View
Editor View
Editor View

Editor View

BOORRO0000NENEE
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3. Click the color box for any Item Name, then select another color from the color palette on the Color Picker

dialog.
4. Click OK to close the dialog.
5. Click OK.

GENERAL PREFERENCES

Configure General Settings

General preferences link a specific username to project-related content changes.

To customize general settings:
rpla

-l
1. On the Sidebar, click ==,

2. On the Preferences dialog, click General under General Preferences.



Qeneral Preferences WC}hange general settings
Colors

General User Name
Fonts Usar Name: Sample User
lcons: Disclaimer
La Selected user name will be placed for Notes, TM and Segment changes. For this change to take effect,

¥ please reopen your project(s) to re-establish connections.
Segment

Project Source file options
Shortcuts
*) Copy Source or TXLF Files into Project Folder Structure
Warnings
Create TXLF File with language suffix next to the Source File

Tags Create Folder with language suffix next to the Source File where TXLF file will be stored
Auto-Propagation Disclaimer

Auto-Suggestion Project Source file options will not be applied when working with Quick Projects

Spelichecker Quick Project Options

Machine Translation ' Show Open TXLF choices dialog when opening TXLF

. Get MS Word Table Options
New Project Preferences

Replacement Show Columns: v Segment ID
| Source
Translation Memory
v Score
Terminclogy
T - Set tag mode to: Show supported text formatting v -
OK Cancel
3. Enter the User Name for user identification on notes, TM, and segment changes.
4. Select one of the source file locations.
@ If the source file is a TXLF file, a copy is saved.
Option Action
Copy Source or TXLF Files into Project Folder Click to create a sub-folder within the project
Structure language folder for storing source files.

Create TXLF File with language suffix next to the Click to create a TXLF copy of the source file at the

Source File same location with the target language code as a
suffix.

Create Folder with language suffix next to the Click to create a TXLF copy of the source file in a

Source File where TXLF file will be stored source file sub-folder using the target language code
as a suffix.

5. Select the Quick Project Options to show the Open TXLF choices dialog during the process of creating a
Quick Project. Refer to Open a TXLF File.

6. Select columns to include in the Get MS Word Table Options, then set the tag mode.

Option Action

Segment ID Select to include the Segment ID column in the MS
Word table.




Option

Action

Source Select to include the Source column in the MS Word
table.
Score Select to include the Score column in the MS Word

table.

Set Tag mode to:

Select the tag mode from the drop-down list.

e Show supported text formatting
e Show formatting as Tags
e Do not show Tags

7. Select the Bilingual Review Export options to export a file with highlighted glossary terms in a Microsoft

Word .DOC or .DOCX format.

Option

Action

Open report after export

Select to automatically open the Bilingual Report after
the export completes.

Exclude the notes column

Select to exclude the notes column from the exported
MS Word document.

Track changes

Select to enable track changes in the exported MS
Word document.

Protect document (Word 2003+)

Select to write-protect the document. This allows
users to edit only the target segment content and add
notes.

Export all TXLF files as one bilingual file

Select to export all submission files as a single
bilingual file.

Export as Docx

Select to export the bilingual report in the
Word .DOCX file format.

8. Select the option to display the dialog for running Quick Tools analysis and cleanup as batch actions that run

10.

in the background.

. To automatically provide a live preview of the translated file when working in the TXLF Editor, enable the Live

Preview option. This option supports MS Word .DOC and .DOCX or MS Powerpoint .PPT and .PPTX source

file formats.

Set the search depth when using the remote TM for your connected TM server type. The search depth is the
number of segment results that can be viewed for a particular search within a remote TM.

GENERAL PREFERENCES

Fonts preferences control customization of font type and size for application-wide functions, such as notes.

To configure fonts:



—
] —
1. On the Sidebar, click ==,

2. Click Fonts under General Preferences.

General Preferences W Customize the fonts used throughout the application
Colors
General Fonts
Fonts T 1 ~
Hem Name Font Size Change
cons THLF Editor Font Arial 13-
Layout THM Lockup Font Arial 12
Segment Term Lookup Font Arial 12
| Blackiist Editor Font Arial 13 e
Shortcuts
Warnings Preview:
Tags
Auto-Propagation The quick brown fox jumps over the lazy dog.
Aulo-Buggestion
Spelichacker Languags Spaciic Fom
Machine Translation
ttem Name Font Size Add
Chinese SimSun 13 = Remove
New Project Preferences Japanese MS Mincho 13 -
Jnange
Replacement Kerean Batang 13 |
Translation Memory o
Dizclaimer
Terminology Font Styles (Typeface on OSX) are not supported by the editor

Select an application-specific font and size for an item name, such as Segment History Font.
Click Change. A sample of the selected font displays in the Preview: pane.
Select a language-specific font.

Add, remove, or change the language-specific font

N o o &~ W

Click OK.

GENERAL PREFERENCES
Configure Icon Settings
Icons preferences control the relative size of the icon and include or exclude the icon title.

To configure icon settings:
rpls
1. On the Sidebar, click = ==,

2. On the Preferences dialog, click lcons under General Preferences.



Preferences

General Preferences W Customize the appearance of the icons the application ribbon
Colors

General lcons
Fonls Set icons size:

— Large icons

®) Medium icong

L. ut
e Small icons

Segment ~] Display text
Shortcuts

Warnings

Tags

Auto-Propagation

Auto-Suggestion

Spelichecker

Maching Translation

New Project Preferences
Replacement
Translation Memory

Terminology

KN ~—

3. Select a size for application icons.
4. (Optional) Clear Display text to exclude icon description text.

5. Click OK.

GENERAL PREFERENCES

Configure Layout Options
Layout preferences control the arrangement of user interface views.
To configure layout options:
—
.
1. On the Sidebar, click = ==,

2. Click Layout under General Preferences.



General Preferences

W Change the layout and appearance of the application

Colors

e Editor

Fonts Table View:

lcons Hide ID Column
Layout Hide Score Column
Segment Hide Table Header
Shortouts Score Column Position:
Warnings Before Target
Tags *) After Target

Auto-Propagation

Current Project
Auto-Suggestion

+" Display Language Codes in Current Project View
Spelichecker

Display Full Language Name in the Gurrent Project View
Machine Translation

Status Bar Representation
New Project Preferences * Language Codes
Replacement Full Language Name
Translation Memory

Terminoclogy

OK Cancel

3. Modify the Table View layout to hide or show columns and headers. The default setting has none of these
items selected.

4. Modify the TM Score Column Position layout for before or after the target column. The default setting is After
Target.

5. Modify the Current Project layout to include the target language name or use a language code in the view.

6. Modify the Status Bar Representation layout in the Current Project view.

Language Codes Click to include language codes on the Status Bar.

Full Language Name Click to include the complete language name on the Status Bar.

7. Click OK.

GENERAL PREFERENCES

Configure Segment Actions
Segment Actions preferences control segment action behaviors, such as Smart Quotes or Smart Punctuation.
To configure segment actions:

—
q —
1. On the Sidebar, click ==,

2. On the Preferences dialog, click Segment under General Preferences.



General Preferences W Configure how sagment will work in the text editor

Colors

General Segment actions

Fonts ~ MextPrevious Segment action leverages next/previous segment

lcons ~f "Commit" changes the segment state to "Translated”

Layout +| Open the last edited segment when opening a file

Segment Leverage the first opened segment on click

Shortcuts | Capitalize the first letter of the target segment (Except Asian languages)
Warnings ~*| Enable Smart Quotes

Tags Skip Unedited 100% Matches

Aulo-Propagation Skip Unedited Context Matches

AuteeBuggestion Cursor position on segment opening:

=) Start
End

Spelichecker

Maching Translation

Mew Project Preferences
Replacement
Translation Memory

Terminology

OK Cancel

3. Select a segment option.

Option Action

Next/Previous Segment action Select to automatically leverage the TM for the segment as you
leverages next/previous segment make the segment active.

Commit changes the segment state = Select to change the segment state to Translated when you click
to Translated Commit. You can toggle back to Needs Translation by clicking the
segment state.

Open the last edited segment when  Select to go to the last segment edited after reopening a file.
opening a file

Leverage the first opened segment  Select to automatically leverage the TM for the first open segment
on click you click after opening a file for translation.

Capitalize the first letter of the target Select to convert translated segments to sentence case. Not
segment (Except Asian Languages) applicable for Asian languages.




Option Action

Enable Smart Quotes Select to activate both Smart Quote and Smart Punctuation
features.

¢ Smart Quotes—Changes the quotation marks to smart
quotes, depending on the target language.

¢ Smart Punctuation—Changes white space and punctuation
mark elements to those appropriate for the target language,
with the exception of Chinese, Japanese, and Korean (CJK)
languages and those that read from right-to-left (RTL), such
as Arabic, Hebrew, Persian, and Urdu.

Note: The white space group includes spaces, non-breaking
spaces, and white space representations: the middot and overring.
The white space group also includes cases where an exclamation
point or question mark exists in isolation at the beginning of the
segment, sentence, or paragraph.

Skip Unedited 100% Matches Select to ignore 100% matched segments.

Skip Unedited Context Matches Select to ignore segments with context matches.

Cursor position on segment opening Select to place the cursor at the beginning or end of the active
segment.

e Start—The default places the cursor at the beginning of the
segment on segment selection.

e End—Places the cursor at the end of the segment on
segment selection.

GENERAL PREFERENCES

Shortcuts preferences control keyboard shortcuts for the commands that you frequently use.
To customize keyboard shortcuts:
ol
o
1. On the Sidebar, click = ==,

2. On the Preferences dialog, click Shortcuts under General Preferences.



Preferences

Ganesal Prafararmnas W Customize and define your keyboard shortouts for the application
Colors
General Shortcuts
Fonts Scheme: |CEEENEEETE -
lcons ﬂ Include Unbound Commands
Layout
Saarch: |
Segment
Select command by single clicking to assign new key combination

SITE Shortcut View
Warnings Add Blacklist Alt+C Project -
Tags Add Blacklist Term Choose Binding Blacklist Editor

Add Files Choose Binding Quick Tools, Project
Auto-Propagation

Add Folder Choose Binding Quick Taols, Project
Auto-Suggestion Add Glossary Alt+0 Quick Tools, Project
Spelichecker Add Note Alt+shift+N Editor
Machine Translation Add Project Crri+Shift+a Home

Add Project Glossaries Choose Binding Quick Tools, Project

Add Project TMs ad+shift+B Quick Taols, Project

N P fer
ew Project Preferences Add Reference Files Choose Binding Project
Replacement Add TH fu T Owiick Toole Drniact
Translation Memory Description:
Terminclogy
-
0K Cancel

3. Select a style Scheme from the drop-down list.
You cannot change the standard Windows keyboard shortcuts such as copy, paste, bold, or italic.

When changing or creating new shortcut key sequences, the sequence must either begin with a Ctrl,
Alt, or Shift, must use a function key, or use a combination of these.

4. Select a Command from the command list and enter a new sequence of keys in the Shortcut column, then
click OK.

5. (Optional) If you choose a shortcut key sequence already in use, a warning message notifies you that it will
override the prior key sequence. Click Yes to save the new shortcut for a command.

The new shortcut key sequence is saved.

GENERAL PREFERENCES
Configure Warning Messages

Warnings preferences control the type of warning notifications you receive.
To configure warning messages:
— =
=
1. On the Sidebar, click = ==,

2. On the Preferences dialog, click Warnings under General Preferences.




Y ) FY

General Preferences W Configure which warning messages you want to see in the application

Colors

General Warnings

Fonts 1 Welcome message

lcons /1 No TM available warning

Layout ] Transcheck warnings

Segment ] Owverwrite target warning

Shortcuts /1 Copy all sources warning

Warnings 1 End of document warning

Tags 1 Remove segment tags warning

Auto-Propagation 1 Remove all tags warning

Auto-Suggestion ] Remove Targetwarmning

Spellchecker 1 Remove all target warning

Machine Translation 8 Remove Term waming

1 Show duplicate shortcuts warning

Current Project Preferences /1 Show targetwith tags warning

Replacement /] Terminology highlighting info message

Translation Memory 1 Remove TM warning

Terminology /1 Remove glossary warning

R - /T Remove blacklist waming -

Kl -

3. Select your warning notifications.

4. Click OK.

GENERAL PREFERENCES

Configure Tags and Formatting
Tags and Formatting preferences control the tag mode, representation, and font size in the TXLF Editor view.
To configure tag and formatting options:
rpls
1. On the Sidebar, click = ==,

2. On the Preferences dialog, click Tags under General Preferences.



~
General Preferences W Configure how tags and formatting are viewed and worked with in the editor
Colors
General Tags and Formatting
Fonts Text Formatting:

L] j il
lcons Show supported text formatting

Show formatting as Tags

Layout
Preview:
Segment
This is the Formatting mode.
Shortcuts
Warnings Tag Naming:
Tags =) Full Name

. Short Name
Auto-Propagation
Numbered Tags
Auto-Suggestion
Spelichecker | Remove incomplete tag pairs

Machine Translation | Apply source segment formatiing to target zegment

New Project Preferences
Replacement
Translation Memory

Terminology

0K Cancel
3. Modify Text Formatting options.
Option Action
Show supported text Click to display formatted content in the TXLF Editor view, along with a
formatting sample of the formatted content in Preview.
Show formatting as Tags Click to display content with formatting tags in the TXLF Editor view,

along with a sample of the formatted content and tags in Preview.

4. Modify Tag Naming options.

Option Action

Full Name Click to view the tag's full name, for example Font .
Short Name Click to view the tag's short name, for example F.
Numbered Tags Click to view the tag's number, for example 3.

Remove incomplete tag pairs  Select to delete incomplete or incorrect tags from the file.

Apply source segment Select to apply segment formatting within a tag from the source segment
formatting to target segment  to the target segment.




GENERAL PREFERENCES

Configure Auto-Propagation

Auto-Propagation preferences control the automatic update of TXLF segments with specified types of repeated
content.

To configure auto-propagation:
— =

A=

1. On the Sidebar, click = ==,

2. On the Preferences dialog, click Auto-Propagation under General Preferences.

Preferences x
General Preferences W Configure how Auto-Propagation options will populate segments
Colors
General Auto-Propagation
Fonts | Enahle Auto-Propagation for repetitions
lcons Enabling Auto-Propagation will update all empty target segments for the entire file.
Layout Enable Auto-Propagation across all open files
Segment UUse Auto-Propagation to overwrite segments containing:
Context matches

Shortcuts

~4] 100% matches
Warnings

] Fuzzy matches
Tags

A No match

Auto-Propagation
W Auto-propagated matches

Auto-Suggestion
Edited segments

Spelichecker
pe | Machine translated segments

Machine Translation
Committed segments

New Project Preferences
Replacement
Translation Memory

Terminology

n canw'

3. Select Enable Auto-Propagation for repetitions to activate additional auto-propagation options (default).

4. Select Enable Auto-Propagation across all open files to allow the user to apply the proposed propagation
to all files that are open.

5. Select any of the Auto-Propagation overwrite options.

Option Action

Context matches Select to overwrite context leveraged translation memory (TM) matches.

100% matches Select to overwrite 100% leveraged TM matches, enabled by default.

Fuzzy matches Select to overwrite partial TM matches, enabled by default.

No match Select to overwrite the target segment for segments that have no match, enabled

by default.




Option Action

Auto-propagated Select to overwrite all auto-propagated matches, enabled by default.

matches Note: If there are multiple segments with the same content, editing a segment

auto-propagates the change to all matching segments.

Edited segments Select to overwrite edited segments.
Machine translated Select to overwrite machine translated segments, enabled by default.
segments

Committed segments Select to overwrite all translated segments that are committed to the TM.

GENERAL PREFERENCES

Auto-Suggestion preferences control automatic recommendations for source content, such as numbers, URLs,
and proper names. It can also recommend terms for the glossary, Translation Memory (TM) matches, and
machine translation (MT) matches.

To configure auto-suggestion:

—
] —
1. On the Sidebar, click ==,

2. On the Preferences dialog, click Auto-Suggestion under General Preferences.



Genorl Proferonces W Configure how features will work in the text editor

Colors

General Auto-Suggestion

Fonts | Enable Auto-Suggestion

lcons Enable suggestions for:

Layout & Capitalized source words
Segment ~ Glozsary terms
Shortcuts 1 T™

Warnings TM sub-segments

Tags MT

Auto-Propagation
Auto-Suggestion
Spelichecker

Machine Translation

Mew Project Preferences
Replacement
Translation Memory

Terminology

0K Cancel

3. Select the Enable Auto-Suggestion check box and suggestion options, then click OK.

Option Action

Capitalized source Select for source segment suggestions: numbers and capitalized words only.

words

Glossary terms Select for glossary suggestions, based on the project.

™ Select for translation suggestions from the TM.

TM sub-segments Select for sub-segment translation suggestions from the TM.

MT Select for machine translation (MT) translation suggestions.

GENERAL PREFERENCES

Configure and Enable Spellchecker

Spellchecker preferences control the interaction between the application and Microsoft Office, Hunspell, or Bing.
The Hunspell option requires software installation on your computer.

To configure and enable Spellchecker:
T

=]
1. On the Sidebar, click = ==,



2. Click Spellchecker in the General Preferences group.

General Preferences W Configure how spellchecking will work in the editor
Colors

General Spelichecking

Fonts | Enable Spelichecking

lcons Check for spelling errors as you type

Layout

Choose spellchecker
Segment Microsoft Office (PC-only and if installed)
Shortcuts * Hunspell

Bing

Warnings
Tags
Auto-Propagation

Disclaimer for Bing Spell Check
Auto-Su. stion ~ L
age Target segments are submitted to Microsoft Bing Spell Check. Make sure this is

Spellchecker compatible with your confidentiality requirements. Bing Spell Check APl goes through

constant changes and sometimes results are inconsistent.
Machine Translation

New Project Preferences
Replacement
Translation Memory

Terminology

OK Cancel

3. Select Enable Spellchecking to activate the spellchecker in TXLF Editor. This option is selected by default,
and makes the Spellcheck File option available on the Review tab in TXLF Editor. You need to configure
the spellchecker for Microsoft Office, Hunspell, or Bing language engines. Hunspell is selected by default, and
comes with several languages already preset: English, German, French, and Spanish.

f Clear Enable Spelichecking to disable the spellchecker. Disabling the spelichecker clears all
spellchecker preferences. You must reconfigure your preferences the next time you enable
Spelichecker.

@ Bing requires a paid subscription.

®

\'

To install additional Hunspell languages, click —I on the Sidebar, then click Update Wordfast
Pro. Click Check For Updates. Select the languages to update, then click Update. You will then
need to restart the application. Hunspell is available for the following languages.

Language Code Language Code
Arabic AR Korean (South Korea) KO-KR
Basque (Basque) EU-ES Latvian (Latvia) LV-LV
Bosnian (Bosnia) BS-BA Lithuanian (Lithuania) LT-LT

Bulgarian (Bulgaria) BG-BG Malaysian (Malaysia) MS-MY




Language Code Language Code
Catalan (Catalan) CA-ES Norwegian (Bokmal Norway) NB-NO
Croatian (Croatia) HR-HR Norwegian (Nynorsk Norway) NN-NO
Czech (Czech Repubilic) Cs-Cz Polish (Poland) PL-PL
Danish (Denmark) DA-DK Portuguese (Brazil) PT-BR
Dutch (Netherlands) NL-NL Portuguese (Portugal) PT-PT
English (Canada) EN-CA Romanian (Romania) RO-RO
English (United Kingdom) EN-GB Russian (Russia) RU-RU
English (United States) EN-US Scottish Gaelic (United Kingdom) GD-GB
Estonian (Estonia) ET-EE Serbian (Serbia) SR-RS
Farsi (Iran) FA-IR Slovak (Slovakia) SK-SK
Finnish (Finland) FI-FI Slovenian (Slovenia) SL-SI
French (Canada) FR-CA Spanish (Mexico) ES-MX
French (France) FR-FR Spanish (Spain) ES-ES
Galician (Spain) GL-ES Swedish (Sweden) SV-SE
German (Germany) DE-DE Swahili (Kenya) SW-KE
Greek (Greece) EL-GR Tagalog (Philippines) TL-PH
Hebrew (Israel) HB-IL Thai (Thailand) TH-TH
Hindi (India) HI-IN Turkish (Turkey) TR-TR
Hungarian (Hungary) HU-HU Ukrainian (Ukraine) UK-UA
Indonesian (Indonesia) ID-ID Urdu UR
Irish (Ireland) GA-IE Vietnamese (Vietnam) VI-VN
Italian (Italy) IT-IT Welsh (United Kingdom) CY-GB
Japanese (Japan) JA-JP Zulu (South Africa) ZU-ZA
Kazakh (Kazakhstan) KK-KZ

4. Select Check for spelling errors as you type to auto-check text as you type it into TXLF Editor.

5. Click OK to save your spelichecker configuration.

GENERAL PREFERENCES

Machine Translation (MT) preferences control automatic population of target segments with translations that
have no translation memory (TM) segment matches using a machine translation engine.

To configure machine translation:



—
] —
1. On the Sidebar, click ==,

2. On the Preferences dialog, click Machine Translation under General Preferences.

Genaral Preferences W Configure how machine translation engines work while you are translating
Colors
General Machine Translation
Fonts Machins Translaton Bahavior
lcons: (#) Show MT results in TM Lookup when there is no TM match
Layout Always show MT results in TM Lockup
Allow all unedited segments in active document to be leveraged with MT
Segment
Remove MT score from score column when a segment is edited
Shortcuts
Warnings
| Enable Deepl Pro
Tags
Enable Google Translator
Auto-Propagation
| Enable Microsoft Translater
Aulo-Buggestion _
Enable SYSTRAN Pure Neural Server
Spelichecker

~ Enable WorldLinge
Machine Translation

& Use WorldLingo as primary Test

Mew Project Preferences
Dizclaimer for public providsrs
Replacement Source segments are submitted to Machine Translation providers. Make sure this is compatible with your
confidentiality requirements. Mote that target segments (yvour translation) are not fed into MT providers,

they remain confidential.

Translation Memaory

Terminclogy

3. Select one of the following:
e Show MT results in TM Lookup when there is no TM match, to show machine translated content without
local or remote TM matches.

o Always show MT results in TM Lookup, to show machine translated content with leveraged segments.
TM matches display in TM Lookup with the MT matches.

4. Select check boxes to allow All unedited segments in active document to be leveraged with MT, and to
Remove MT score from score column when a segment is edited.

5. Select Enable DeepL Pro, Enable Google Translator, Enable Microsoft Translator, Enable SYSTRAN
Pure Neural Server,or Enable WorldLingo as the primary machine translator. You can enable all five, but
you can only designate one as the primary machine translator.

6. Select MT options for each machine translator, then perform the designated setup tasks associated with each
machine translator.

@ WorldLingo has a limited set of source languages for MT.



e Arabic e French e Korean

e Chinese Simplified e German e Portuguese

e Chinese Traditional e Greek ¢ Russian

e Dutch e ltalian e Spanish

e English e Japanese e Swedish
Translator Options

Enable DeepL Pro +"! Enable Deepl Pro

You need to subscribe to Deepl Pro in arder to use this machine translation service. After subscribing,
enter your API key below (if left blank, DeepL Pro will be disabled).
API: Test

& Use Deepl Pro as primary

To subscribe, please go to the Deepl Pro website,
For the list of available languages and other FAQ, please check oul Deepls FAQ.

Enable Google
Translator

+"! Enable Google Translator

Google Translator is a paid serace, you need to register for it and get an API key to enter below (if 1eft blank, Google
engine will be disabled).

AP :

Use Google Premium Edition (using Neural MT for limited language pairs)

Use Google Translator as primary Test

To regster, please check Google Translate AP,

To access and enable Google Premium edition please check Google Translate Premium Edition AP

Premium Edition using Meural MT is only available for limited language pairs listed below. If unsupporied languages
are usad with Premium, Google might provide you with standard edition translations.

Available language for Google Translate
Available language for Premium Google Translate

Enable Microsoft +" Enable Microsoft Translator

Translator
Microsoft Translator AP is now available in the Azure podal under the Cognitive Services category. You need to

subscribe to the new service and enter the new kay in the field below (if left blank, MS Translator will be disabled).
Also, you can broaden your search by entenng a category as one of the parameters.

Key:
Category Name :

| Usa Microsoft Translator as primary Test

To regster, follow the link below. The free option still exists; however, a credit card is now required for identification.
How to sign up for Microsoft Translator on Azure
Available language for Azure Search Service BEST AP|




Translator Options

Enable SYSTRAN
Pure Neural Server

+ Enable SYSTRAN Pure Meural Server

You need a SYSTRAN Pure Neural Server enterprise account to use this machine translation service. Enter your
Gateway URL and API key provided by SYSTRAMN below (if left blank, SYSTRAN Pure Meural Server will be
dizabled).

Gateway URL :
API -

W] Use SYSTRAN Pure Neural Server as primary Test

To subscribe, please go to the SYSTHAN Pure MNeural Server
List of available languages

Enable WorldLingo Enable WorldLingo
| Use WaorldLingo as primary Test

WorldLingo MT has a limited source language set.

7. Click Test to validate the connection to the external machine translation provider.
8. Read the disclaimer and click OK.

Your machine translation preferences are configured.

Current Project Preferences

Current Project Preferences control settings unique to individual projects. Either you or your Project Manager
can set project preferences.

CURRENT PROJECT PREFERENCES
Configure Replacement

Replacement preferences allow you to select certain types of content in the source translation units (TUs) that
will be replaced with the correct target language format in the translation memory (TM). These replacements
provide better TM matches when the files are analyzed.

To enable replacements:
— =
o —
1. On the Sidebar, click = ==,

2. Click Replacement in the New Project Preferences group.



Preferences

General Preferences
Colors
General
Fonts
lcons
Layout
Segment
Shoricuts
Warnings
Tags
Auto-Propagation
Auto-Suggestion
Spelichecker

Machine Translation

Mew Project Preferences
Replacement
Translation Memaory

Terminology

-

W Configure how franslation memories ars used in your project

Replaceables
i) Enable replacement of detected text in TM results for higher TM matches
& Number replacement
&/ URL replacement
&/ Punctuation replacement

| Email address replacement

OK

Cancel

3. Select Enable replacement of detected text in TM results for higher TM matches, then enable specific

content type replacement options. You can select one or more options. All options are selected by default.

Options include:

e Number replacement
e URL replacement

¢ Punctuation replacement

e Email address replacement

4. Click OK.

CURRENT PROJECT PREFERENCES

Configure a Translation Memory

Translation Memory (TM) preferences control project-level TM behaviors.

To configure a translation memory:

—
q —
1. On the Sidebar, click ==,

2. Click Translation Memory in the Current Project Preferences group.




Preferences

S
Shortcuts
Warnings

Tags
Auto-Propagation
Auto-Suggestion
Spelichecker

Machine Translation

Current Project Preferences

Replacement
Translation Memory
Terminclogy
Penalties
Transcheck
Segmentation

Filters

User Preferences

Advanced Settings

“
W Configure how translation memories are used in your project

Segment state
| Set segments to Translated with leveraged Context Matches
| Set segments to Translated with leveraged 100% Matches
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3. Configure how TMs are used in your project. After all segment and TM options are selected, click OK to

activate them.

Option

Action

Segment State

Use these options to tell TXLF Editor how to handle segments that have high
leverage from the TM. The default setting has the following options selected.

Set segments to Translated with leveraged Context Matches — When
a translated segment has a context match from the TM, this option sets the
segment state to Translated.

Set segments to Translated with leveraged 100% Matches — When a
translated segment has a 100% Match from the TM, this option sets the segment
state to Translated.

Set segments to Translated for Auto-propagated segments — When
segment is auto-propagated, this option sets the segment state to Translated.

Translation Memory

Use these options to determine TM behavior during translation in TXLF Editor.

Write 'exact' matches to TM — Automatically add exact matched segments to
the TM. This action changes the segment state to Translated.

Write 'unedited MT' to TM — Automatically add unedited machine translated
segments to the TM. This action changes the segment state to Translated.

Write 'unedited fuzzy' to TM — Automatically add unedited fuzzy matched
segments to the TM. This action changes the segment state to Translated.




Option

Action

Write 'unedited autopropagated fuzzy' to TM — Automatically add unedited
autopropagated fuzzy matched segments to the TM. This option is only available
when the Write 'unedited fuzzy' to TM option is selected.

Copy source to Target on no match — Automatically copy the source content
into the target translation field when there is no matching from the TM. This
option allows the translators to replace the source text as they translate in the
target language.
Select an option from the drop-down list to specify which elements from the
source segments will be copied to the target fields:

e Copy Source

e Copy Source Text

e Copy Source, Tags And Term Translations

e Copy Source And Term Translations

e Copy Source, Tags, Source And Target Terms

e Copy Source with Source And Target Terms

Set Fuzzy match threshold (%): — Select or type the baseline percentage for
fuzzy TM matches in the percentage box. The default is 75%. This percentage
specifies the TM leverage limit for a fuzzy match. For example, with a threshold
of 75%, all segment translations between 75 to 99% match with the TM are
considered Fuzzy Match segments. Any segment matches below 75% are
considered No Match segments.

Report Settings — The settings in this box are used for narrowing the
calculations in TM analysis reports.

e Calculate analysis report percentage by: — Select either Words or
Segments. Words is the default setting.

e Calculate internal fuzzy matches and set threshold to (%) — Use this
option to calculate internal fuzzy matches in the analysis report. Internal
fuzzy matches are segments that are translated in the current project but
not yet incorporated into the TM. Select or type the threshold percentage
for internal fuzzy matches in the percentage box. The default is 75%. They
will be included in a separate report category unless the next option is
selected as well.

¢ Include internal fuzzy matches as TM matches — Select this option
to include internal fuzzy matches as fuzzy matches in the project TM
analysis. This option is only available when the previous option is
selection. Internal fuzzy matches will be included in the fuzzy match
percentage instead of broken out into a separate category.




Option Action

When Updating an existing TU — The settings in the box determine how you
want the TM to behave when editing an existing translation unit (TU).

Add to TM by overwriting the existing TU — This option overwrites the
previous translation in the TM.

Add to TM; overwrite the existing TU if attributes are identical
(default) — If all attributes of the TU are identical, this option overwrites
the previous translation in the TM.

Add new segments to TM; do not overwrite the existing TU — This
option adds edited segments to the TM as new segments instead of
overwriting the previously translated segment.

Add to TM; do not overwrite the existing TU — This option adds the
translation to the TM without overwriting the existing translation. Instead of
creating a new segment, the translation will be offered as another possible
translation of the same source segment.

Do not add to TM — Edits to existing TUs are not committed to the TM.
The segment state will remain as Needs Translation.

TM Lookup Settings — Select or type the total number of TUs to be shown in
the TM Lookup pane during translation.

CURRENT PROJECT PREFERENCES

Terminology preferences control terminology lists for leveraging previously translated content.

To select terminology options:

—
q_
1. On the Sidebar, click ==,

2. Click Terminology under New Project Preferences. All options are enabled by default.
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3. Select Enable fuzzy term recognition to view fuzzy matches.

4. Select Enable term highlighting when typing terms to indicate terminology matches by highlight when
entered in the translation.

5. Select Ignore case for term highlighting to ignore case difference in terminology matches.

6. Select the number of matches you can view, then click OK.

CURRENT PROJECT PREFERENCES
Configure TM Penalties

Penalties preferences help maintain a high quality of content leveraged from a translation memory (TM). This
involves assessing a penalty to TM matches to provide a relative score for those TM matches. You can assign
a relative value to each penalty type when calculating the translation score. This score helps users differentiate
between 100% match, fuzzy match, and no match content.

To configure penalties for TM matches:
s
1. On the Sidebar, click = ==,

2. On the Preferences dialog, click Penalties under New Project Preferences.
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3. Select a penalty, supply a threshold, then click OK.

1

1

n Canml

Penalty Action

Case Select to consider differences in case.

Non Literal Select to consider differences in special characters, including
punctuation, space, apostrophe, dash, and quote.

Tag Select to consider differences in tagging.

Whitespace Select to consider differences in blank spacing.

Align Select to consider differences in translation units (TUs) with
alignment attributes.

Machine Select to consider differences in TUs based on machine

Translation translation (MT).

Multiple Select to consider differences in TUs based on duplicates within

Translation the TM with different translations.

Local TM Select to consider differences in TUs from the local desktop
copy.

Remote TM Select to consider differences in TUs from a remote TM.

Private TU Select to consider differences in work-group TUs from a remote
TM.

Public TU Select to consider differences in non-work-group TUs from a

remote TM.




Penalty Action

Secondary TM Select to indicate that the translation leverages a secondary TM.

Attribute Select to consider differences in attributes.

If attribute is not Select for when a custom attribute in a TU does not match the
text box attribute.

If filename Select for when the file name attribute in a TU does not match
attribute does not the TXLF file name.
match

CURRENT PROJECT PREFERENCES

Transcheck preferences control how Transcheck verifies target segments and issues warnings about common

translation errors within a project. For example, if a translated term conflicts with the designated glossary, @
displays in the Status column in the TXLF Editor view.

To configure Transcheck:

-h
q—
1. On the Sidebar, click ==,

2. On the Preferences dialog, click Transcheck under New Project Preferences.

e To search for an option, enter text in the Transcheck search field above the options column
list. To select all, click the Transcheck check box. To clear all options, deselect the check box.
Use the Up or Down Arrow keys to move among the options, then the Spacebar to enable or
disable.

e The Sub-options panel to the right of the Transcheck Options panel contains any sub-options
related to the selected category. Use the Tab key to enter and move among the sub-options,
then the Spacebar to enable or disable. To exit the Sub-options panel, press Shift+Tab.
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3. Enable Transcheck segments while translating to use Transcheck during translation.
4. On the Transcheck Options panel, select items within any of the major categories.

a) Select items for the Segment Content Checks category.

Option Action

Capitalization Select to identify any capitalization issues for translated segments in the edited

file.

Source Consistency Select for consistency of source content across a single file or multiple edited

files.

Target Consistency Select for consistency of target content across a single file or multiple edited

files.

Copied Source Select to identify any target segments that are identical to the source segment

in the edited file.

Empty Target Select to identify any empty target segments that do not contain a translation in
the edited file.
Note Select to identify any target segments in the edited file with related notes.

Number Difference Select to compare numerical values in source and target segments in the

edited file, then identify any discrepancies.

Punctuation Select to compare punctuation in source and target segments in the edited file,

then identify any discrepancies.




Option

Action

Repeated Word

Select to identify any repetitions of words in target segments within the edited
file.

Translation Length

Select to set a character length restriction on the translated segment or to
check character and word expansion percentages.

Smart Punctuation

Select to confirm the punctuation in the target segment is correct for that
language.

Tag

Select to identify any target segments in the edited file with missing tags.

Whitespace

Select to compare source and target segment white space usage in the edited
file, then identify any discrepancies.

b) Select items for the Segment Status Checks category.

Option

Action

Edited Context Match

Select to identify any changes to the context matches for translated segments
in the edited file.

Edited Exact Match

Select to identify any changes to exact matches for translated segments in the
edited file.

Edited Source

Select to identify any updates to the original segment content in the edited file.

Do Not Write To TM
Segment

Select to identify any translated segments marked not to be committed to the
translation memory.

Unedited Exact Match

Select to identify any unedited or overlooked exact match segments in the
edited file.

Unedited Fuzzy Match

Select to identify any unedited or overlooked fuzzy match segments in the
edited file.

c) Select items for the Reference Checks category.

Option

Action

Blacklist

Select to cross-reference the available blacklist with the edited file.

Forbidden Character

Select to identify any provided forbidden characters remaining within the edited
file.

Mistranslated Text

Select to identify any mistranslated or inaccurate translation in segments within
the edited file.

Spelling

Select to identify any misspellings in translated segments within the edited file.

Terminology

Select to identify any overlooked terminology matches for translated segments
in the edited file.

Untranslatable Text

Select to identify all target segments that contain content that cannot be
translated in the edited file.

Untranslated Text

Select to identify all target segments that contain untranslated content in the
edited file.




Option Action

Unedited MT Select to identify all target segments that contain unedited machine translation
(MT) content in the edited file.

5. Click OK.

Transcheck is configured for the current project.
CURRENT PROJECT PREFERENCES
Configure Segmentation
Segmentation preferences control how the TXLF editor separates file content into logical segments for a project.
To select segmentation options:

s

1. On the Sidebar, click = ==,

2. Click Segmentation under New Project Preferences.

Preferences
e —
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3. Change Segmentation based on your preferences. After all segmentation preferences are selected, click OK.

Option Description

Segmentation on break Click this option to enable segmentation on line breaks.




Option

Description

Select segmentation
type

Select APPLICATION from the drop-down list to use application-specific
segmentation rules.
Select SRX from the drop-down list to use SRX segmentation rules.

Define end-of-segment
markers (ESM)

Enter specific characters into the ESM field to specify custom segment end
characters, such as .?!..
Select checkboxes for any additional end-of-segment markers. Select as many or
as few as you prefer.
Options include:

e Space

e Tab

¢ Non-Breaking Space

e Line Feed

e Carriage Return

Define rules for ending
segments

Select the rules you want for ending segments. Select as many or as few as you
prefer.
Options include:

e A number followed by an ESM

e An ESM without a trailing space should end a segment

e An ESM followed by a space and a lower-case letter should end a segment

Select abbreviations
that should not be
segmented on

This area allows you to define which abbreviations should not be considered as
end-of-segment markers (ESM). To do so, first select a language from the Select
a language the drop-down list.

Standard abbreviations for that language will be displayed in the text box below
the language selection. You can edit, add, or delete abbreviations in the box.

In the Segmentation Preview box, type a few lines of text that contain
abbreviations or an ESM.

Click Check it out to view how the text will be segmented in the bilingual files for
translation.

CURRENT PROJECT PREFERENCES

Filters preferences control the file format filters for importing source content to Wordfast Pro.

To configure a file format filter:
—

-
1. On the Sidebar, click ==,

2. On the Preferences dialog, click Filters under New Project Preferences.
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3. Select a file format filter configuration from the Extract numbers drop-down list to define the filter action on
source segments that contain only numbers.

all Select to extract all segments with only numbers for translation.
time_date_measure Select to extract only segments with a measurement value or the time and date.
none Select to ignore any segments that contain only numeric values during extract.

4. To select the file filter settings for the open project, click a filter to list the current settings on the Format
Settings pane.

@ To search the filters, enter the search string in the Available filters search field.

5. (Optional) Highlight a filter name and change settings on the Format Settings pane. The available options are
specific to the file filter you select.

6. (Optional) Add a custom file filter for a filter you need that is not already in the list by clicking Add or Remove.

7. On the New Filter dialog, select a format from the Choose file format drop-down list to use as a template for
the new filter.

@ The Format Settings options vary, depending on the file format you choose.



= Choose a file format and enter the filter name to
display.

Choose file format:” Adobe InDesign Interchange (*.imx)

Filter Mame:™ Sample IMNX File Filter

Format Sattings

Fontmapping file: Browse...

OK Cancel
8. Enter a filter name in the Filter Name field, then verify your configuration is correct on the Format Settings
pane.
9. (Optional) Browse for and select any of the related Format Settings for that file format.
10. Click OK.

The file format filter you selected is configured.

User Preferences

You can manage your user preferences, including restoring them to the default state and exporting or importing
them.

USER PREFERENCES
Configure Advanced Settings

Advanced Settings preferences allow you to restore a Wordfast Pro installation to factory or default settings,
migrate preferences between computers, and customize strings.

To configure advanced settings:
— =
o
1. On the Sidebar, click = ==

2. Click Advanced Settings under User Preferences.
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3. Change Advanced Settings based on your preferences.

Option

Description

Default Settings

Restore Original reverts all the preferences to their original factory settings.

Note: Once you click this option, all general preferences and custom new project
preferences will be lost.

Restore Defaults reverts the preferences only for the current project to the
default new project preferences.

Note: You must have a project open for this option to take effect.

Export/import
Preferences Settings

Export allows you to export the settings values that you currently have applied in
Preferences for general settings and for a current project. You can select specific
preferences or export them all. You will be asked to browse to a path where the
export file will be saved with a .pref extension.

Import allows you to browse to a saved .pref file and import it. When the file is
selected, a dialog displays the preferences that will be imported. The imported
settings will not be activated in Preferences until you click OK.

Customization String
List

This field is primarily for developer's use. Click &, type an option in the
Customization String List field, then click OK. Highlight an option and click &
to delete it from the list.

Note: You must restart the application for the customized strings to be applied or

remaved




The application supports accented characters for many language sets: those that have accents combined with

standard characters and those that are autonomous ligatures.

The key combinations identified here are for use with Windows operating systems and do not pertain
to Mac OS.

Many accents combine with standard characters.

Accent Sample Key Combination Notes
Acute 6orO Ctrl+', v 'is the apostrophe key
Ctrl+', Shift+V v is a lower case vowel
V is an upper case vowel
Circumflex 6 or O Shift+Ctrl+A, v v is a lower case vowel
Shift+Ctrl+*, Shift+V V is an upper case vowel
Grave dor0O Ctrl+’, v v is a lower case vowel
Ctrl+", Shift+V V is an upper case vowel
Tilde fi or N Shift+Ctrl+~, ¢ ~ is the tilde key
Shift+Ctrl+~, Shift+C c or C is a character, but only works with upper
and lower case N, O, or A
Umlaut dor0O Shift+Ctrl+:, v . is the colon key

Shift+Ctrl+:, Shift+V

v is a lower case vowel
V is an upper case vowel

Other accents require incorporation with the individual characters, so are treated as a complete character.

Complete Name Key Combination Notes
Character
i Inverted exclamation Alt+Shift+Ctrl+! Press and hold all three keys simultaneously
point
A Inverted question mark Alt+Shift+Ctrl+? Press and hold all three keys simultaneously
corC French C cedilla Ctrl+, , c Press Control and the comma key, release both
Ctrl+, , Shift+C keys, then press C or press and hold Shift+C
ce or CE OE ligature Shift+Ctrl+&, o Press and hold Shift+Ctrl+&, release the keys,
Shift+Ctrl+&, Shift+O and press O or press and hold Shift+O
K] German sharp or Shift+Ctrl+&,s Press and hold Shift+Ctrl+&, release the keys,
double S and press S.
gord Nordic O slash Ctrl+/, o Press and hold Ctrl+/, release both keys, and

Ctrl+/, Shift+O

press O or press and hold Shift+O




Complete Name Key Combination Notes

Character

aorA Nordic A-ring, Shift+Ctrl+@, a Press and hold Shift+Ctrl+@, release the keys,
Angstrom sign Shift+Ctrl+@, Shift+A  and press A or press and hold Shift+A

xor k£ Old English AE ligature Shift+Ctrl+&, a
Shift+Ctrl+&, Shift+A

Press and hold Shift+Ctrl+&, release the keys,
and press A or press and hold Shift+A

dorb Icelandic or Old English Ctrl+', d
eth Ctrl+', Shift+D

"is the apostrophe key
Press and hold Ctrl+', release both keys, and
press D or press and hold Shift+D

To insert accents or accented characters:

1. (Optional) To enter a character that combines with an accent, follow the key combinations in the accent table.

e For example, to create an A with an acute ligature, hold down the Control key and press the apostrophe

key. Release both keys and either press A or press and hold Shift+A.

e For example, to create an O with the grave ligature, hold down the Control key and press the
apostrophe key. Release both keys and either press the O or press and hold Shift+O.

2. (Optional) To enter a complete accented character, follow the key combinations in the complete character

table.

e For example, to create the inverted exclamation point, press and hold Alt+Shift+Ctrl+!, then release all

keys.

e For example, to create the ce ligature, first press and hold Shift+Ctri+&, then release the keys and either

press O or press and hold Shift+D.

The Formatting tab in the TXLF Editor includes formatting tools you can use to edit the target content format.

Formatting tools fall into three categories: format, tags, and options.

FORMATTING TOOLS

Format category options are only available for MS Office source file formats.

Button Keyboard Shortcut Description
B Ctrl+B Format the selected text as bold.
Bold

I Ctri+l Format the selected text as italic.

Italic




Button

Keyboard Shortcut

Description

U Ctrl+U Format the selected text as underlined.
Underline
X Ctrl+= Format the selected text as subscript.
Subscript
X Ctrl+Shift+= Format the selected text as superscript.
Superscript
ABE No shortcut Format the selected text to display as strikethrough

Strike

(deleted), without actually deleting the text.

FORMATTING TOOLS

Button Keyboard Shortcut Description
= No shortcut Display actual formatting associated with tags for the
Tag active segment (when supported.)
Formatting
No shortcut Display the content of the formatting tags for the active
Tag segment.

Mon-Foermatting

FORMATTING TOOLS

Button

Keyboard Shortcut

Description

[= ]

Mon-Breaking

Ctrl+Shift+Space

Insert a non-breaking space at the cursor location.

Space
qq No shortcut Insert a marker to indicate left-to-right reading direction.
Left To Right
Marker
qq No shortcut Insert a marker to indicate right-to-left reading direction.
Right To Left
Marker
& Ctrl+D Attach and detach the Formatting toolbar. When

Attach /
Detach

attached, the toolbar is displayed as a tab. When
detached, the toolbar is displayed as a minimized
toolbar that can be moved to any area of the TXLF
Editor.




This topic includes the keyboard shortcuts that are available for PC and Apple users for Wordfast Pro, Wordfast
Classic, SDLX, and Trados.

KEYBOARD SHORTCUTS

A This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View
Add Blacklist Alt+C Project
Add Glossary Alt+O Project
Add Note Alt+Shift+N Editor
Add Project Ctrl+Shift+A Home
Add Project TMs Ctrl+Shift+B Quick Tools
Add Term Ctrl+Alt+T Editor
Add TM Ctrl+N Project
Analyze Ctrl+Space Editor
Attach/Detach Toolbar Ctrl+D Editor
Bold Ctrl+B Editor
Clear all tags (Segment) Ctrl+Shift+V Editor
Clear Target Document Alt+Shift+Delete Editor
Clear Target Segment Ctrl+Alt+X Editor
Close Ctrl+W Editor
Close project from home window Ctrl+Shift+X Home
Close segment Esc Editor
Commit All Segments to TM CtrlI+Alt+End Editor
Commit Current Segment Alt+End Editor
Confirm/Unconfirm Segment Alt+Enter Editor
Confirm All Segments Ctrl+Shift+Enter Editor
Copy CtrlI+C Blacklist Editor, TM Editor, Glossary Editor, Editor
Copy All Sources Ctrl+Alt+Insert Editor
Copy All Tags (Document) Alt+Shift+P Editor
Copy All Tags (Segment) Alt+A Editor




Commands Shortcut View
Copy selected text to target Alt+F12 Editor
Copy Source Alt+S Editor
Copy Tag Ctrl+Alt+Down Editor
Copy Term Ctrl+0 Editor
Copy TM Ctrl+Shift+C Project
Create Blacklist Alt+B Project
Create Glossary Alt+N Project
Create TM Ctrl+Shift+N Project
Current Segment Leverage Alt+- Editor
Cut Ctrl+X Blacklist Editor, TM Editor, Glossary Editor, Editor
Delete Note Alt+Shift+D Editor
Edit Note Alt+Shift+E Editor
Edit Term Ctrli+E Editor
Export Blacklist Alt+K Project
Export Glossary Alt+E Project
Export Report as PDF format Alt+U Project
Export TM Ctrl+Shift+E Project
Find/Replace Ctrl+F Editor
Get Bilingual Table Ctrl+Alt+P Editor
Go To Segment Ctrl+G Editor
Help Ctrl+Alt+H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home
Import Blacklist Alt+J Project
Import Glossary Alt+l Project
Import TM Ctrl+Shift+l Project
Insert a cent sign Ctrl+; Editor
Insert Copyright Symbol Ctrl+Alt+C Editor
Insert Ellipsis Ctrl+Alt+. Editor
Insert em dash Alt+Shift+- Editor
Insert en dash F10 Editor
Insert non-breaking hyphen Ctrl+Shift+- Editor
Insert non-breaking space Ctrl+Shift+Space Editor
Insert Registered Trademark Ctrl+Alt+R Editor

symbol




Commands Shortcut View

Italic Ctrl+l Editor

Key Assist Panel Ctrl+Shift+L Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment Shift+F5 Editor

Leverage Previous TU Alt+Left Editor

Leverage the first TM Lookup Alt+1 Editor

match

Leverage the second TM Alt+2 Editor

Lookup match

Leverage the third TM Lookup  Alt+3 Editor

match

Leverage the fourth TM Lookup  Alt+4 Editor

match

Leverage the fifth TM Lookup Alt+5 Editor

match

Leverage the sixth TM Lookup  Alt+6 Editor

match

Leverage the seventh TM Alt+7 Editor

Lookup match

Leverage the eighth TM Lookup Alt+8 Editor

match

Leverage the Next TU Alt+Right Editor

Machine Translate Ctrl+Shift+M Editor

Merge Segments Alt+Page_Down Editor

Modify Alt+M Project

Modify TM Ctrl+Shift+T Project

Move the cursor between the Shift+Tab Editor

source and the target

Next Segment (Committo TM)  Alt+Down Editor

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctri+Alt+Right Editor

Next Term Ctrl+9 Editor

Next View Alt+W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist Alt+H Project

Open Glossary Alt+G Project




Commands Shortcut View

Open Project Ctrl+Shift+P Home

Open TM Ctrl+Shift+G Project

Paste Ctrl+Vv Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) Ctrl+Up Editor

Previous Segment (TM Commit) Alt+Up Editor

Previous Tag Ctri+Alt+Left Editor

Previous Term Ctrl+8 Editor

Pseudo Translate Ctrl+Shift+Y Quick Tools

Quick Tools Alt+Q Home

Redo Ctrl+Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Reference Files Alt+0 Project

Remove Report Alt+Z Project

Remove TM Ctrl+Shift+R Project

Replace/Find Ctrl+H Editor

Run Transcheck Ctrl+Shift+Q Editor

Save Ctrl+S Editor

Save As F12 Editor

Save File As Translated Ctrl+Alt+S Editor

Show White Space Characters  Ctrl+Shift+8 Editor

Simple Project Creator Ctrli+P Home

Source TM Lookup Ctrl+Shift+F Editor

Spell Check F7 Editor

Split Segment Alt+Page_Up Editor

Strikethrough Ctrl+K Editor

Subscript Ctrl+= Editor

Superscript Ctrl+Shift+= Editor

Term Info Alt+T Editor

Terminology Highlight Ctrl+F5 Editor

TM Concordance F8 Editor

Toggle uppercase/lowercase Shift+F3 Editor




Commands Shortcut View

Translate All Ctrl+Shift+End Editor

Translate File Ctrl+O Project

Translate Until Fuzzy Ctrl+Alt+F Editor

Translate Until No Match Ctrl+Shift Editor

+Page_Down

Unconfirm All Segments Alt+Shift+Enter Editor

Underline Ctrl+U Editor

Undo Ctrl+zZ Blacklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment Ctri+Alt+V Editor

A This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist Alt+C Project

Add Glossary Alt+O Project

Add Project Ctrl+Shift+A Home

Add Project TMs Ctrl+Shift+B Quick Tools
Add Reference Files Alt+1 Project

Add Term Ctrl+Alt+T Editor

Add TM CtrlI+N Project
Analyze Ctrl+Space Quick Tools
Attach/Detach Toolbar Ctrl+D Editor

Bold Ctrl+B Editor
Clear Target Document Alt+Shift+Delete Editor
Clear Target Segment Ctrl+Alt+X Editor
Close project from home window Ctrl+Shift+X Home
Commit All Segments to TM Ctrl+Alt+End Editor
Commit Current Segment Alt+Q Editor
Confirm/Unconfirm Segment Alt+Enter Editor
Confirm All Segments Ctrl+Shift+Enter Editor

Copy Ctrl+C Blacklist Editor, TM Editor, Glossary Editor, Editor




Commands Shortcut View

Copy All Sources Ctrl+Alt+Insert Editor

Copy All Tags (Segment) Alt+P Editor

Copy Source Alt+Insert Editor

Copy Tag Alt+Shift+Down Editor

Copy Tag Ctrl+Alt+Down TM Editor

Copy Term Ctrl+Alt+0 Editor

Copy TM Ctrl+Shift+C Project

Create Blacklist Alt+B Project

Create Glossary Alt+N Project

Create TM Ctrl+Shift+N Project

Current Segment Leverage Alt+- Editor

Cut Ctrl+X Blacklist Editor, TM Editor, Glossary Editor, Editor

Export Blacklist Alt+K Project

Export Glossary Alt+E Project

Export Package Ctrl+E Home

Export Report as PDF format Alt+U Project

Export TM Ctrl+Shift+E Project

Find/Replace Ctrl+F Editor

Go To Segment Ctrl+G Editor

Help Ctri+Alt+H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist Alt+J Project

Import Glossary Alt+l Project

Import TM Ctrl+Shift+l Project

Insert non-breaking space Ctrl+Shift+Space Editor

Italic Ctrl+l Editor

Key Assist Panel Ctrl+Shift+L Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment Shift+F5 Editor

Leverage Previous TU Alt+Left Editor

Leverage the Next TU Alt+Right Editor

Merge Segments Alt+Page_Down Editor

Modify Alt+M Project

Modify Project Ctrl+Shift+M Home




Commands Shortcut View

Modify TM Ctrl+Shift+T Project

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctrl+Alt+Right Editor

Next Term Ctrl+Alt+9 Editor

Next Update Alt+Down Blacklist Editor

Next View Alt+W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist Alt+H Project

Open Glossary Alt+G Project

Open Project Ctrl+Shift+P Home

Open Reference Files Alt+2 Project

Open TM Ctrl+Shift+G Project

Paste Ctrl+V Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (TM Commit) Alt+Up Editor

Previous Tag Ctri+Alt+Left Editor

Previous Term Ctrl+Alt+8 Editor

Pseudo translate Ctrl+Shift+Y Quick Tools

Redo Ctrl+Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Project CtrI+Alt+R Home

Remove Reference Files Alt+0 Project

Remove Report Alt+Z Project

Remove tag Ctrl+Alt+Up Editor

Remove TM Ctrl+Shift+R Project

Replace/Find Ctrl+H Editor

Save Ctrl+S Editor

Save As F12 Editor

Save File As Translated Ctrl+Alt+S Editor

Show White Space Characters  Ctrl+Shift+8 Editor

Simple Project Creator CtrlI+P Home

Spell Check F7 Editor




Commands Shortcut View
Split Segment Alt+Page_Up Editor
Strikethrough Ctrl+K Editor
Subscript Ctrl+= Editor
Superscript Ctrl+Shift+= Editor
Term Info Alt+T Editor
Terminology Highlight Ctrl+F5 Editor
TM Concordance Ctrl+Shift+F Editor
Translate File CtrI+O Project
Translate Until Fuzzy Ctrl+Alt+F Editor
Translate Until No Match Ctrl+Shift Editor
+Page_Down

Unconfirm All Segments Alt+Shift+Enter Editor
Underline Ctrl+U Editor
Undo Ctrl+Z Blacklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment Ctri+Alt+V Editor

A This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist Alt+C Project

Add Glossary Alt+O Project

Add Note Alt+Shift+N Editor

Add Project Ctrl+Shift+A Home

Add Project TMs Ctrl+Shift+B Quick Tools
Add Term CtrlI+Al+T Glossary Editor
Add Term Ctrl+T Editor

Add TM Ctrl+N Project
Analyze Ctrl+Space Editor
Attach/Detach Toolbar Ctrl+D Editor

Bold Ctrl+B Editor
Clear Target Document Alt+Shift+Delete Editor




Commands Shortcut View

Clear Target Segment Ctri+Alt+X Editor

Close Ctrl+Shift+W Editor

Close project from home window Ctrl+W Home

Commit All Segments to TM Alt+End Editor

Commit Current Segment Alt+Q Editor

Confirm/Unconfirm Segment Alt+Enter Editor

Confirm All Segments Ctrl+Shift+Enter Editor

Copy CtrlI+C Blacklist Editor, TM Editor, Glossary Editor, Editor

Copy All Sources Ctrl+Alt+Insert Editor

Copy All Tags (Document) Alt+Shift+P Editor

Copy All Tags (Segment) Alt+P Editor

Copy selected text to target Alt+F12 Editor

Copy Source F4 Editor

Copy Tag Ctrl+Alt+Down Editor

Copy Term Ctrl+Alt+0 Editor

Copy TM Ctrl+Shift+C Project

Create Blacklist Alt+B Project

Create Glossary Alt+N Project

Create TM Ctrl+Shift+N Project

Current Segment Leverage F8 Editor

Cut Ctrl+X Blacklist Editor, TM Editor, Glossary Editor, Editor

Delete Note Alt+Shift+D Editor

Edit Note Alt+Shift+E Editor

Edit Term Ctrl+E Editor

Export Blacklist Alt+K Project

Export Glossary Alt+E Project

Export Report as PDF format Alt+U Project

Export TM Ctrl+Shift+E Project

Find/Replace Ctrl+F Editor

Go To Segment Ctrl+L Editor

Help Ctri+Alt+H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist Alt+J Project




Commands Shortcut View
Import Glossary Alt+l Project
Import TM Ctrl+Shift+l Project
Insert copyright symbol CtrlI+Alt+C Editor
Insert ellipsis F11 Editor
Insert em dash Ctrl+F10 Editor
Insert en dash F10 Editor
Insert non-breaking hyphen Ctrl+F9 Editor
Insert non-breaking space Ctrl+Shift+Space Editor
Insert Registered Trademark Ctrl+Alt+R Editor
symbol
Italic Ctri+l Editor
Key assist panel Ctrl+Shift+L Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home
Last Modified Segment Shift+F5 Editor
Leverage previous TU Alt+Left Editor
Leverage the first TM Lookup Alt+1 Editor
match
Leverage the second TM Alt+2 Editor
Lookup match
Leverage the third TM Lookup  Alt+3 Editor
match
Leverage the fourth TM Lookup  Alt+4 Editor
match
Leverage the fifth TM Lookup Alt+5 Editor
match
Leverage the 6th TM Lookup Alt+6 Editor
match
Leverage the 7th TM Lookup Alt+7 Editor
match
Leverage the 8th TM Lookup Alt+8 Editor
match
Leverage the Next TU Alt+Right Editor
Machine Translate Ctrl+Shift+F8 Editor
Merge Segments Ctrl+J Editor
Modify Alt+M Project
Modify Project Ctrl+Shift+M Home




Commands Shortcut View

Modify TM Ctrl+Shift+T Project

Move the cursor between the Shift+Tab Editor

source and the target

Next Segment (Committo TM)  Alt+Down Editor

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctrl+Alt+Right Editor

Next Term Ctrl+Alt+9 Editor

Next View Alt+W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist Alt+H Project

Open Glossary Alt+G Project

Open Project Ctrl+Shift+P Home

Open TM Ctrl+Shift+G Project

Paste Ctrl+Vv Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) Ctrl+Up Editor

Previous Segment (TM Commit) Alt+Up Editor

Previous Tag Ctrl+Alt+Left Editor

Previous Term Ctrl+Alt+8 Editor

Pseudo Translate Ctrl+Shift+Y Quick Tools

Redo Ctrl+Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Reference Files Alt+0 Project

Remove Report Alt+Z Project

Remove Tag Ctrl+Alt+Up Editor

Remove TM Ctrl+Shift+R Project

Replace/Find Ctrl+H Editor

Run Transcheck F12 Editor

Save Ctrl+S Editor

Save File As Translated Ctrl+Alt+S Editor

Show White Space Characters  Ctrl+Shift+8 Editor

Simple Project Creator Ctrl+P Home




Commands Shortcut View
Source TM Lookup Ctrl+Shift+F Editor
Spell Check F6 Editor
Split Segment Ctrl+Enter Editor
Strikethrough CtrlI+K Editor
Subscript Ctrl+= Editor
Superscript Ctrl+Shift+= Editor
Term Info Alt+T Editor
Terminology Highlight Ctrl+F5 Editor
TM Concordance F7 Editor
Toggle uppercase/lowercase Shift+F3 Editor
Translate All Ctrl+Shift+End Editor
Translate File CtrI+O Project
Translate Until Fuzzy Ctrl+Alt+F Editor
Translate Until No Match Ctrl+Shift Editor
+Page_Down

Unconfirm All Segments Alt+Shift+Enter Editor
Underline Ctrl+U Editor
Undo Ctrl+Z Blacklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment Ctri+Alt+V Editor

A This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist Alt+C Project

Add Glossary Alt+O Project

Add Project TMs Ctrl+Shift+B Quick Tools
Add Reference Files Alt+1 Project

Add Term CtrI+Al+T Glossary Editor
Add Term Ctrl+F11 Editor

Add TM Ctrl+N Project
Analyze Ctrl+Space Quick Tools




Commands Shortcut View

Attach/Detach Toolbar Ctrl+D Editor

Bold Ctrl+B Editor

Clear Target Document Alt+Shift+Delete Editor

Clear Target Segment Ctrl+Alt+X Editor

Close Ctrl+W Editor

Close project from home window Ctrl+Shift+X Home

Commit All Segments to TM Ctrl+Shift+U Editor

Commit Current Segment Alt+Q Editor

Confirm/Unconfirm Segment Alt+Enter Editor

Confirm All Segments Ctrl+Shift+Enter Editor

Copy CtrlI+C Blacklist Editor, TM Editor, Glossary Editor, Editor

Copy All Tags (Segment) Alt+P Editor

Copy selected text to target Alt+F12 Editor

Copy Source F4 Editor

Copy Tag Ctrl+F4 Editor

Copy Term Ctrl+Alt+Down Editor

Copy TM Ctrl+Shift+C Project

Create Blacklist Alt+B Project

Create Glossary Alt+N Project

Create TM Ctrl+Shift+N Project

Current Segment Leverage Alt+Space Editor

Cut Ctrl+X Blacklist Editor, TM Editor, Glossary Editor, Editor

Export Blacklist Alt+K Project

Export Glossary Alt+E Project

Export Package Ctrl+E Home

Export Report as PDF format Alt+U Project

Export TM Ctrl+Shift+E Project

Go To Segment Ctrl+L Editor

Help Ctrl+Alt+H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist Alt+J Project

Import Glossary Alt+l Project

Import TM Ctrl+Shift+ Project




Commands Shortcut View

Insert en dash F10 Editor

Insert non-breaking space Ctrl+Shift+Space Editor

Italic Ctri+ Editor

Key Assist Panel Ctrl+Shift+L Blacklist Editor, TM Editor, Glossary Editor, Quick

Tools, Editor, Project, Home

Last Modified Segment Shift+F5 Editor

Machine Translate Ctrl+Shift+F8 Editor

Merge Segments Ctrl+J Editor

Modify Alt+M Project

Modify Project Ctrl+Shift+M Home

Modify TM Ctrl+Shift+T Project

Move the cursor between the Shift+Tab Editor

source and the target

Next Segment (Committo TM)  Enter Editor

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctrl+Alt+Right TM Editor

Next Update Alt+Down Blacklist Editor

Next View Alt+W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist Alt+H Project

Open Glossary Alt+G Project

Open Project Ctrl+Shift+P Home

Open Reference Files Alt+2 Project

Open TM Ctrl+Shift+G Project

Paste Ctrl+V Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Tag Ctri+Alt+Left Editor

Previous Update Alt+Up Blacklist Editor

Pseudo Translate Ctrl+Shift+Y Quick Tools

Redo Ctrl+Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Project CtrI+Alt+R Home

Remove Reference Files Alt+0 Project




Commands Shortcut View
Remove Report Alt+Z Project
Remove TM Ctrl+Shift+R Project
Save Ctrl+S Editor
Save File As Translated Ctrl+Alt+S Editor
Show White Space Characters  Ctrl+Shift+8 Editor
Simple Project Creator Ctrl+P Home
Source TM Lookup Ctrl+Shift+F Editor
Spell Check F6 Editor
Split Segment Alt+S Editor
Strikethrough Ctrl+K Editor
Subscript Ctrl+= Editor
Superscript Ctrl+Shift+= Editor
Term Info Alt+T Editor
Terminology Highlight Ctrl+F5 Editor
TM Concordance F7 Editor
Translate All Ctrl+Shift+A Editor
Translate File CtrI+O Project
Unconfirm All Segments Alt+Shift+Enter Editor
Underline Ctrl+U Editor
Undo Ctrl+Z Blacklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment Ctri+Alt+V Editor

A This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist ~C Project
Add Glossary 0 Project

Add Note 0N Editor

Add Project BTA Home

Add Project TMs $0B Quick Tools
Add Term T Editor




Commands Shortcut View
Add T™M #N Project
Analyze ¥$Space Editor
Attach/Detach Toolbar #D Editor
Bold ¥B Editor
Clear all tags (Segment) 8BV Editor
Clear Target Document R Editor
Clear Target Segment AMX Editor
Close W Editor
Close project from home window X Home
Close segment # Editor
Commit All Segments to TM B H Editor
Commit Current Segment ON# Editor
Confirm/Unconfirm Segment oe# Editor
Confirm All Segments EOH# Editor
Copy #C Blacklist Editor, TM Editor, Glossary Editor, Editor
Copy All Sources #¥~\Insert Editor
Copy All Tags (Document) ~OP Editor
Copy All Tags (Segment) A Editor
Copy selected text to target ~F12 Editor
Copy Source oS Editor
Copy Tag N Editor
Copy Term 80 Editor
Copy TM ®1C Project
Create Blacklist ~B Project
Create Glossary ~oN Project
Create TM BN Project
Current Segment Leverage Q Editor
Cut #X Blacklist Editor, TM Editor, Glossary Editor, Editor
Delete Note ~D Editor
Edit Note ~oTE Editor
Edit Term HE Editor
Export Blacklist K Project
Export Glossary ~E Project




Commands Shortcut View

Export Report as PDF format ~uU Project

Export TM H$OE Project

Find/Replace ¥*F Editor

Get Bilingual Table $P Editor

Go To Segment ®G Editor

Help #¥~H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist ~J Project

Import Glossary ~ Project

Import TM £ Project

Insert a cent sign 8; Editor

Insert copyright symbol $C Editor

Insert ellipsis . Editor

Insert em dash - Editor

Insert en dash - Editor

Insert non-breaking hyphen B- Editor

Insert non-breaking space ¥ Space Editor

Insert Registered Trademark #\R Editor

symbol

Italic £ Editor

Key Assist Panel $oL Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment TF5 Editor

Leverage Previous TU B Editor

Leverage the first TM Lookup 1 Editor

match

Leverage the second TM 22 Editor

Lookup match

Leverage the third TM Lookup  ~\23 Editor
match
Leverage the fourth TM Lookup ~4 Editor
match
Leverage the fifth TM Lookup o5 Editor
match
Leverage the sixth TM Lookup  ~\6 Editor

match




Commands Shortcut View

Leverage the seventh TM ~7 Editor

Lookup match

Leverage the eighth TM Lookup ~=8 Editor

match

Leverage the Next TU 8- Editor

Machine Translate ¥ITM Editor

Merge Segments ¢ Editor

Modify M Project

Modify TM BT Project

Move the cursor between the 7> Editor

source and the target

Next Segment (Committo TM) ! Editor

Next Segment (No Commit) 8 Editor

Next Tag B~ Editor

Next Term 9 Editor

Next View W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist ~H Project

Open Glossary G Project

Open Project $oP Home

Open TM ®BG Project

Paste 8V Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) 81t Editor

Previous Segment (TM Commit) ~ct Editor

Previous Tag B\ Editor

Previous Term 8 Editor

Pseudo Translate BY Quick Tools

Redo ®Y Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary ~R Project

Remove Reference Files ~20 Project

Remove Report Z Project

Remove TM #OR Project




Commands Shortcut View
Replace/Find ¥$H Editor
Run Transcheck "Q Editor
Save #8S Editor
Save As F12 Editor
Save File As Translated $\S Editor
Show White Space Characters 18 Editor
Simple Project Creator 8P Home
Source TM Lookup BOF Editor
Spell Check F7 Editor
Split Segment ~¢ Editor
Strikethrough #K Editor
Subscript 8= Editor
Superscript ®o= Editor
Term Info T Editor
Terminology Highlight ¥#F5 Editor
TM Concordance F8 Editor
Toggle uppercase/lowercase TF3 Editor
Translate All HONH Editor
Translate File #0 Project
Translate Until Fuzzy H~F Editor
Translate Until No Match E I Editor
Unconfirm All Segments T e# Editor
Underline U Editor
Undo *Z Blacklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment oV Editor

A This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View
Add Blacklist ~C Project
Add Glossary 0 Project




Commands Shortcut View

Add Note 0N Editor

Add Project $TA Home

Add Project TMs ®0B Quick Tools
Add Reference Files 1 Project

Add Term T Editor

Add T™M N Project
Analyze ¥$Space Quick Tools
Attach/Detach Toolbar #D Editor

Bold B Editor
Clear Target Document R Editor
Clear Target Segment AX Editor
Close project from home window X Home
Commit All Segments to TM BNH Editor
Confirm/Unconfirm Segment oe# Editor
Confirm All Segments HU<# Editor

Copy #¥C Blacklist Editor, TM Editor, Glossary Editor, Editor
Copy All Sources ~fInsert Editor

Copy All Tags (Segment) ~P Editor

Copy Source ~Insert Editor

Copy Tag N TM Editor
Copy Tag o Editor

Copy Term #$\0 Editor

Copy TM ®1C Project
Create Blacklist ~B Project
Create Glossary ~oN Project
Create TM BN Project
Current Segment Leverage Q Editor

Cut #X Blacklist Editor, TM Editor, Glossary Editor, Editor
Delete Note ~D Editor

Edit Note ~oTE Editor

Edit Term HE Editor
Export Blacklist K Project
Export Glossary ~E Project




Commands Shortcut View

Export Package H$E Home

Export Report as PDF format ~uU Project

Export TM BOE Project

Find/Replace *F Editor

Go To Segment ®G Editor

Help #¥~H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist ~J Project

Import Glossary ~ Project

Import TM £ Project

Insert non-breaking space ¥ Space Editor

Italic £ Editor

Key Assist Panel #$oL Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment TF5 Editor

Leverage Previous TU B Editor

Leverage the Next TU H—> Editor

Merge Segments ¥ Editor

Modify M Project

Modify Project ®BTM Home

Modify TM BT Project

Next Segment (No Commit) * Editor

Next Tag - Editor

Next Term 9 Editor

Next Update o Blacklist Editor

Next View W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist ~H Project

Open Glossary G Project

Open Project ®oP Home

Open Reference Files 2 Project

Open TM ®BG Project

Paste 8V Blacklist Editor, TM Editor, Glossary Editor, Quick

Tools, Editor, Project, Home




Commands Shortcut View

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (TM Commit) ~* Editor

Previous Tag F Editor

Previous Term 8 Editor

Pseudo Translate ®UY Quick Tools

Redo 8BY Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary ~R Project

Remove Project #\R Home

Remove Reference Files 0 Project

Remove Report \Z Project

Remove tag N

Remove TM BOR Project

Replace/Find ¥$H Editor

Save #8S Editor

Save As F12 Editor

Save File As Translated #\S Editor

Show White Space Characters 08 Editor

Simple Project Creator ¥*P Home

Spell Check F7 Editor

Split Segment % Editor

Strikethrough 8K Editor

Subscript 8= Editor

Superscript ®o= Editor

Term Info T Editor

Terminology Highlight BF5 Editor

TM Concordance #OF Editor

Translate File #0 Project

Translate Until Fuzzy F$~F Editor

Translate Until No Match E I Editor

Unconfirm All Segments o e# Editor

Underline U Editor

Undo ¥*Z Blacklist Editor, TM Editor, Glossary Editor, Editor




Commands

Shortcut

View

Verify Segment

¥V

Editor

A This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist ~C Project

Add Glossary 0 Project

Add Note 0N Editor

Add Project HTA Home

Add Project TMs 8B Quick Tools
Add Term T Editor

Add Term BT Glossary Editor
Add T™M N Project
Analyze ¥Space Editor
Attach/Detach Toolbar #D Editor

Bold ¥B Editor
Clear Target Document N Editor
Clear Target Segment AX Editor
Close BIW Editor
Close project from home window #W Home
Commit All Segments to TM O Editor
Confirm/Unconfirm Segment ~e# Editor
Confirm All Segments HU<# Editor

Copy ®C Blacklist Editor, TM Editor, Glossary Editor, Editor
Copy All Sources #~cInsert Editor

Copy All Tags (Document) ~ 0P Editor

Copy All Tags (Segment) ~P Editor

Copy selected text to target ~F12 Editor

Copy Source F4 Editor

Copy Tag N Editor

Copy Term $\0 Editor




Commands Shortcut View

Copy TM #0C Project

Create Blacklist ~\B Project

Create Glossary ~oN Project

Create TM BTN Project

Current Segment Leverage ~Q Editor

Cut #»X Blacklist Editor, TM Editor, Glossary Editor, Editor

Delete Note ~tD Editor

Edit Note ~TE Editor

Edit Term HE Editor

Export Blacklist ~K Project

Export Glossary ~E Project

Export Report as PDF format ~uU Project

Export TM BOE Project

Find/Replace $F Editor

Go To Segment £ Editor

Help ¥~H Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blacklist ~J Project

Import Glossary ~ Project

Import TM £ Project

Insert copyright symbol $C Editor

Insert ellipsis F11 Editor

Insert em dash - Editor

Insert en dash - Editor

Insert non-breaking hyphen 8F9 Editor

Insert non-breaking space ¥ Space Editor

Insert Registered Trademark #\R Editor

symbol

Italic Eq Editor

Key Assist Panel $oL Blacklist Editor, TM Editor, Glossary Editor, Quick

Tools, Editor, Project, Home

Last Modified Segment tF5 Editor

Leverage Previous TU B Editor




Commands Shortcut View

Leverage the first TM Lookup 1 Editor
match
Leverage the second TM 22 Editor

Lookup match

Leverage the third TM Lookup o3 Editor
match
Leverage the fourth TM Lookup ~4 Editor
match
Leverage the fifth TM Lookup o5 Editor
match
Leverage the sixth TM Lookup 6 Editor
match
Leverage the seventh TM 7 Editor

Lookup match

Leverage the eighth TM Lookup ~8 Editor
match

Leverage the Next TU H- Editor
Machine Translate H$0F8 Editor
Merge Segments ~J Editor
Modify ~M Project
Modify Project ®BTM Home
Modify TM BT Project
Move the cursor between the e Editor

source and the target

Next Segment (Committo TM) ~c! Editor

Next Segment (No Commit) * Editor

Next Tag H - Editor

Next Term 9 Editor

Next View W Blacklist Editor, TM Editor, Glossary Editor, Quick

Tools, Editor, Project, Home

Open Blacklist ~H Project

Open Glossary G Project

Open Project ®BOP Home

Open TM 801G Project

Paste #*V Blacklist Editor, TM Editor, Glossary Editor, Quick

Tools, Editor, Project, Home




Commands Shortcut View
Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home
Previous Segment (No Commit) 81t Editor
Previous Segment (TM Commit) ~ct Editor
Previous Tag H Editor
Previous Term H\8 Editor
Pseudo Translate ®UY Quick Tools
Redo BY Blacklist Editor, TM Editor, Glossary Editor, Editor
Remove Glossary ~R Project
Remove Reference Files 0 Project
Remove Report \Z Project
Remove tag N Editor
Remove TM BOR Project
Replace/Find ¥$H Editor
Run Transcheck F12 Editor
Save #S Editor
Save File As Translated #\S Editor
Show White Space Characters 08 Editor
Simple Project Creator ¥*P Home
Source TM Lookup ®OF Editor
Spell Check F6 Editor
Split Segment oe# Editor
Strikethrough #K Editor
Subscript 8= Editor
Superscript ®o= Editor
Term Info ~T Editor
Terminology Highlight ¥$F5 Editor
TM Concordance F7 Editor
Toggle uppercase/lowercase OF3 Editor
Translate All BONH Editor
Translate File 80 Project
Translate Until Fuzzy H~F Editor
Translate Until No Match E I Editor




Commands Shortcut View
Unconfirm All Segments RN Editor
Underline U Editor
Undo 8Z Blacklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment F$V Editor

A This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blacklist ~C Project

Add Glossary ~0 Project

Add Project TMs ®0B Quick Tools
Add Reference Files 1 Project

Add Term F$F11 Editor

Add Term BT Glossary Editor
Add TM 8N Project
Analyze ¥$Space Quick Tools
Attach/Detach Toolbar #D Editor

Bold ¥#B Editor
Clear Target Document R Editor
Clear Target Segment AMX Editor
Close W Editor
Close project from home window § X Home
Commit All Segments to TM #oU Editor
Confirm/Unconfirm Segment ~oe# Editor
Confirm All Segments BooH Editor

Copy #C Blacklist Editor, TM Editor, Glossary Editor, Editor
Copy All Tags (Segment) ~P Editor

Copy selected text to target ~F12 Editor

Copy Source F4 Editor

Copy Tag $F4 Editor

Copy Term E N Editor




Commands Shortcut View

Copy TM #0C Project

Create Blacklist ~\B Project

Create Glossary ~oN Project

Create TM BTN Project

Current Segment Leverage ~Q Editor

Cut #»X Blacklist Editor, TM Editor, Glossary Editor, Editor
Export Blacklist oK Project

Export Glossary ~E Project

Export Package BE Home

Export Report as PDF format ~oU Project

Export TM $OE Project

Go To Segment 8L Editor

Help $~\H Blacklist Editor, TM Editor, Glossary Editor, Quick

Tools, Editor, Project, Home

Import Blacklist ~J Project

Import Glossary ~ Project

Import TM F#0l Project

Insert en dash - Editor

Insert non-breaking space ¥ ¢ Space Editor

Italic | Editor

Key Assist Panel BOL Blacklist Editor, TM Editor, Glossary Editor, Quick

Tools, Editor, Project, Home

Last Modified Segment ©F5 Editor

Machine Translate ¥0F8 Editor

Merge Segments 8J Editor

Modify ~M Project

Modify Project HTM Home

Modify TM BT Project

Move the cursor between the T Editor

source and the target

Next Segment (Committo TM)  «# Editor
Next Segment (No Commit) 8 Editor
Next Tag E: N TM Editor

Next Update ~o! Blacklist Editor




Commands Shortcut View

Next View W Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blacklist ~H Project

Open Glossary G Project

Open Project $oP Home

Open Reference Files 22 Project

Open TM ®BG Project

Paste 4V Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blacklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Tag E AN Editor

Previous Update ot Blacklist Editor

Pseudo Translate ®UY Quick Tools

Redo BY Blacklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary ~R Project

Remove Project #\R Home

Remove Reference Files ~20 Project

Remove Report Z Project

Remove TM #OR Project

Save ¥#S Editor

Save File As Translated S Editor

Show White Space Characters 108 Editor

Simple Project Creator ®P Home

Source TM Lookup ®OF Editor

Spell Check F6 Editor

Split Segment oS Editor

Strikethrough 8K Editor

Subscript 8= Editor

Superscript ®O= Editor

Term Info T Editor

Terminology Highlight 8F5 Editor

TM Concordance F7 Editor

Translate All HTA Editor




Commands Shortcut View

Translate File #0 Project

Unconfirm All Segments RN Editor

Underline U Editor

Undo ®Z Blacklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment vV Editor

How do | obtain a Wordfast Pro License and install the application?

Wordfast products are try-before-you-buy. You can download a free 30-day Demo mode of Wordfast
Pro from wordfast.com. Demo mode has limited functionality until you enter the activation key. When
you purchase a Wordfast license, you can generate an activation key at wordfast.net by logging in
with your login email and password. Copy and save the activation key.

To activate Wordfast Pro, click
Registration and follow the instructions to activate your product using the activation key. Once
activated, Wordfast Pro changes from Demo mode to the full unlocked version.

on the Sidebar. Click either Online Registration or Manual

What does Wordfast Pro Demo mode mean?

When in Demo mode, you are limited to creating bilingual projects and storing up to 500 translation
units in your Translation Memory. To get a full version, you must upload a license. Refer to

Activation.

Why is my completed project now showing as less than 100% complete in my Projects List?

The latest version of Wordfast Pro contains a new segment state feature and an improved Progress
Bar. As a result, projects from legacy versions of Wordfast Pro might register as less than 100%
complete or N/A in the Projects List. To resolve the issue, open the project, then open the
translation file. If you have multiple translation files, chain them together. In the TXLF Editor view,
click Mark All Translated. Save and close the project. In the Project List view, click Recalculate
Progress. The project should now register as 100% complete.

What happens if | upload a corrupt file for translation when creating a project?

If one of the files is corrupt or invalid, you can still create a project with clean files. The corrupt or
invalid file will not upload and you receive a warning message.

How do | chain individual files?

Instead of opening files one-by-one to display in individual tabs, you can chain files to open in a
single tab as long as these files are in the same batch. You cannot chain files across batches.
Chaining files has the following main advantages:

e Open hundreds of files within seconds.

e Filter or search and replace in one pass as opposed to once per individual file.

Why is the Analyze button inactive when | open a chained file for translation?
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The Analyze action you can normally access in TXLF Editor view is inactive when you open a
chained file because the translation memory cannot provide the best results.

What are the different ways to analyze files?

The analysis process converts source files into TXLF, leverages the content against existing
translation memories, and generates a report listing matches, non-matches, word count, character
count, and segment count. You can analyze source files in the following ways:

¢ Analyze files within a project in the Current Projects view.

e Analyze any files outside of the project files on the Analysis tab in the Quick Tools view.

e Analyze a file open for translation in TXLF Editor view by clicking the Analyze button on the

Translation tab.

Refer to Analysis

How do | use Skip 100% and 100%+ Segments when using TXLF Editor view?

To skip 100% and 100%+ segments when moving to a segment that requires linguistic changes, you
have two options:
o (Preferred) Set preferences to Skip 100% and 100%+ segments. This allows you to view the
100% and 100%+ segments for context while editing adjacent No Match and Fuzzy match or
MT pre-translations.
e Filter for All except 100% and Context match segments.

How do | update a TM with my translations?

To update a TM after you finish translating or editing a segment in TXLF Editor view, you must
commit it to the TM. Committing a segment will turn the color highlight from pink to purple. You can
commit a segment to the TM as follows:
e Move to the next segment clicking the Next Segment button, or by using Alt + Down Arrow.
e While your cursor is in a segment, click Commit on the Translation tab.
e Click Commit All on the Translation tab to add all the segments in the file to the TM.
If a segment does not require any changes, for example, if the 99% match or the MT match is
linguistically correct, you can change the Translation Memory settings in Preferences to add these
items to the TM. To change the TM settings:
o e
Click -I I:
e Click Translation Memory in the Current Project Preferences section.
e Select the items you would like to have committed to the TM when working in your project:
o Write 'exact’ matches to TM
o Write 'unedited MT' to TM
o Write 'unedited fuzzy' to TM

How do | keep translations from updating the master TM?




To prevent a segment from updating the TM:

1. Open the file for translation and click on the segment that you do not want to write to the TM.

2. In the TXLF Editor view, click Do Not Write To TM on the Translation tab. The Status
column displays “%, and does not update the TM.

3. To write the segment to the TM, select the segment and click Do Not Write To TM again. The

% is removed from the Status column, and the segment may then be updated to the TM.

How do | correctly apply inline formatting?

You can apply inline formatting to the target segment in two ways:

1. You can enter tag(s) from the source language segment for basic styles such as bold and italic
using the buttons on the Formatting tab. However, these formatting buttons could introduce
tags in the target that do not match the source. Unless the linguist identifies these mismatched
tags using Transcheck and corrects them, they will prevent affected TXLF files from converting
into monolingual files at the align stage.

2. To avoid the mismatched tags, after opening a file for translation, go to Preferences > Tags
and select Show Formatting as Tags.

Since this preference persists from one WFP session to another, you only have to set it once.
This preference enables you to reuse tags from the source using the Copy button under the
Translation tab. If the tag preference is set to Show Text Formatting (when supported), you
must apply formatting using the buttons in the Formatting tab, unless you toggled segment-
by-segment from Tag Formatting to Tag Non-Formatting.

Why is the Whole Words Only check box inactive on the Find/Replace dialog?

In the Find and Replace dialog, the Whole Words Only check box is inactive if you added multiple
words or punctuation to the Find field.

What are Preferences and how do | access them?

You can customize all user interface options and features in the preferences section.
L
To access preferences, on the Sidebar click = ==,
e Configure preferences that will apply to all projects in the General Preferences section.

e Configure preferences that apply only to the currently active project in the Current Project
Preferences section.

e Configure advanced settings in the User Preferences section.
Refer to Configure Preferences.

How can | preview a file during translation?

In TXLF Editor, on the File tab, click Preview, then select Live Preview, Office Preview, or Html
Preview from the drop-down menu. Live Preview only works with Word or PowerPoint files. It opens
a preview of the target content for comparison to your source content. If you click on a line of text in
the preview document, your cursor will move to that segment in the TXLF file. Office Preview will
open a PDF preview of the current translation file. Html Preview will open a preview as an HTML
file, only if the source file was HTML.

Another option is to click Preview File, and a translated file will open if the source is available.
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